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Preface
HansaWorld FirstOffice Professional is a powerful accounting system for the
Windows, Macintosh and Linux platforms. The program is practically
identical in the three environments, and is designed to make administration
and accounting as easy and fast as possible. In the specific areas where there
are significant differences, these are described and illustrated in full. In all
other cases, illustrations are taken from the Windows XP version.

Text in square brackets - [Save], [Cancel] - refers to buttons on screen.

Information in this document is subject to change without notice and does not
represent a commitment on the part of HansaWorld. The Software described
in this document is a sophisticated information management system. Features
are liable to alteration without notice. This documentation is not intended as a
de facto  representation of the system, but as an overview of its facilities. It
cannot be exhaustive in all respects. Whilst effort is made to ensure the
accuracy of the information published concerning the features and use of
HansaWorld FirstOffice Professional software, it is still possible that certain
functions mentioned may not be fully implemented, may not be available
under certain circumstances, or may possibly relate to a future release of the
software. Errors and omissions excepted. HansaWorld accepts no contingent
liabilities. All HansaWorld FirstOffice Professional software related
transactions are subject to HansaWorld's Conditions of Sale and Software
Licence Agreement. All rights reserved.



How these manuals are organised
Volume 1: Introduction

Introduction Installing FirstOffice, the basic ideas
Work Area Basic elements of FirstOffice: modules, registers, windows,

menus, functions, buttons
Accounting Principles

About the place of FirstOffice in your business, integration
between ledgers

Starting Work Entering opening balances
Customers Customers, customer categories and reports
Items Products and services, pricing
System Module Settings and parameters. System-wide usage

Volume 2: Accounting Package
Sales Ledger Invoices, receipts, debtors
Purchase Ledger Purchase invoices, payments and creditors
Nominal Ledger The basic accounting module. Transactions and budgets

Volume 3: Logistics and Personal Registers
Sales Support Orders and deliveries. Invoices from orders
Stock Deliveries, goods receipts and stocktaking
Activities, Calendar and Task Manager

Contact and time management. Activities, the task manager
and the calendar: registering and reviewing appointments in
daily or monthly calendar format

Volume 4: Value Packs
Bar Code Used in Finland, where Purchase Invoices are bar coded
CRM Customer letters and mailshots
Currencies, Languages and Advanced Pricing

International transactions in any currency and translation.
Automated calculation of prices. Quantity pricing and
discounts

Dual Base Currencies
Express all values in one of two currencies. Used in countries
in the EMU, and by companies with branches in two countries
or in countries where there are two currencies in common use

Group Invoicing Create invoices for orders in batches
Mail Mail, conferences, chat
Purchase Orders Purchase orders, goods receipts and purchase pricing
Quotations Sending quotations, call backs, reports
Stock Locations Maintain stock in several locations. Stock movements between

locations
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Chapter 1: Introduction and Installation
HansaWorld FirstOffice Professional is an integrated accounts and office
administration tool for Macintosh, Windows and Linux. It includes Sales,
Purchase and Nominal Ledgers, Stock Control, a Calendar and Task Manager
that you can use for contact management, and a Sales Support module for
tracking Sales Orders. The abbreviated term “FirstOffice” is used throughout
these manuals when referring to HansaWorld FirstOffice Professional.

You can add extra features to the basic FirstOffice program using Value
Packs. For example, the CRM and Mail Value Pack allows you to send
mailshots and also contains full internal mail and conferencing facilities.
These features mean that users can be online from anywhere at anytime, so
employees can always be in touch with each other. Other Value Packs allow
you to create and administer Quotations and Purchase Orders, manage stock
in several Locations, create Invoices from Sales Orders in batches, and add
multi-currency and multi-language capabilities to the program. These Value
Packs integrate fully with each other and with the main core of the program.
For example, the Quotations Value Pack uses the Customer and Item
registers and Price List feature in the main program to ensure the correct
prices are quoted to each Customer. If you have both the CRM and Mail and
the Quotations Value Packs, you can record a Make Contact date for each
Quotation and create an Activity to remind you to call on that date. Value
Packs add a great deal of flexibility, and different users will adapt them to
their own requirements.

In this introductory chapter, we will describe the steps you need to follow to
get started with FirstOffice. Topics covered include installation (both single-
and multi-user) and the creation of a new database. Subsequent chapters
cover FirstOffice’s working environment, its structure and the way data is
handled, and beginning work. The remaining chapters describe the Customer
and Item registers which are used throughout the system, the System module,
where preferences and look-up information are stored, and the individual
modules in detail.

Structure of FirstOffice
The FirstOffice system consists of several modules which interact with each
other in many ways. Each module uses a number of registers, or files, in
which information of a particular type is stored. For example, all information
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about Customers is stored in a Customer register, all information about Items
is stored in an Item register and so on.

The following illustration shows the registers available in each FirstOffice
module—

Registers in FirstOfficeProfessional

System

Nominal 
Ledger

Purchase 
Ledger

Sales 
Ledger

Sales 
Support

Stock

The integration between modules is quite straightforward. Some registers are
available in more than one module, allowing you to enter information from
different parts of the program. Where a register is only present in a single
module, other modules can access the information stored within it. For
example, the Sales, Purchase and Nominal Ledgers can all access the Chart
of Accounts, stored in the Account register in the System module.

In addition to the registers, each module has several smaller files known as
‘Settings’. The difference between a setting and a register lies in the
frequency and nature of use. The information with which you will be working
daily, such as Customers, Suppliers, Sales Orders and Invoices, tends to be
stored in registers, while information stored in settings tends to be used in
‘look-up’ tables or used to determine the manner in which a particular
function operates.
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Work Flow

The administration of a company is always associated with a certain flow of
tasks and work. In a typical trading company, items are purchased from a
group of suppliers, goods are received and put into stock, sales orders are
processed, stock levels are checked, goods are shipped and invoices issued,
and payments are made and received. All transactions are logged and
recorded, and financial events are recorded in the accounting subsystem.

A modern financial system like FirstOffice is designed to automate as many
administrative tasks as possible. If information is entered in one part of the
system, there should be no need to enter it again elsewhere. Information
should be recorded for re-use, and it should be available throughout the
system.

The Administrative Workflow in a Business

Operative Flow (of Goods)

N/L

P/L S/L

SUPPLIER RECEIVING STOCK SHIPPING CUSTOMER

Goods Rec Delivery Del Note

Order

Invoice

Receipt

N/L TransN/L Trans

Payment

Invoice

The above illustration shows a simplified description of the interaction of
functions and information (messages) in a traditional trading business. The
basic physical flow is shown at the bottom, with “operative” functions
handling the goods as they are received, stocked and shipped. The rectangles
above the operative flow are “administrative” functions that handle the flow
of information in the business. The smaller rectangles are messages
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containing information that is passed around in the business. The dashed
frame is the boundary of the business: although Suppliers and Customers are
on the outside, there is a continuous exchange of information with them.

One of the tasks of the administration is to keep the organisation’s
“memory”. This is done with the help of files and registers, where
information about business events is kept. The following picture shows the
same structure as above, but the messages have been removed and are
replaced by the registers kept by the business.

SALES
SUPPORT

Customers

Orders
STOCK

Goods Receipts
Deliveries
Items

P/L
Invoices
Payments
P/L

S/L
Invoices
Receipts
S/L

N/L
Accounts
Balances
Transactions

SUPPLIER RECEIVING STOCK DELIVERY CUSTOMER

Basic Registers in a Trading Business

Operative Flow (of Goods)

Items

FirstOffice’s modular design provides a number of standardised tasks for
each functional area in a business. The design is very flexible, so that many
different types of business can use the software. In FirstOffice it is always
possible to access information immediately from another module. If for
example the person involved with the Purchase Invoices needs some
information about a Sales Invoice, then it is immediately available to them
without any need to leave the system (subject to the person having the
necessary access rights)

FirstOffice is an integrated accounting system. The different parts of the
system interact with each other. The Sales Ledger is for example integrated
with the Nominal Ledger so that as soon as an Invoice has been approved, all
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ledgers in the company’s accounts are automatically updated. This interaction
is immediate, and covers the entire accounting system. All registers, ledgers
and reports are updated for all users.

In many cases, this integration means that you, the user, will not notice the
actual creation of Nominal Ledger Transactions from the Sales and Purchase
Ledgers. These Transactions constitute about 80% of the Nominal Ledger
transactions in a manual system - you simply can forget them, together with
all the hassle of reconciling the ledgers with each other. FirstOffice does all
this automatically. The picture below illustrates the integration process.

FirstOffice Professional
Integration

Invoice

N/L Transactions 
are generated 
automatically

Nominal Ledger

N/L Transactions 
entered manually

Transactions

Receipt

Purchase Invoice

Payment

Multi-year Database

FirstOffice uses a multi-year database. This means that Transactions,
Invoices etc. from several years are stored in the same database. Closing
balances for all accounts at the end of one financial year are automatically
converted into opening balances for the beginning of the next. The multi-year
database thus simplifies your end-of-year procedures.

FirstOffice’s database is continuous. Transactions are stored continuously,
with no periods fixed in advance. It is possible to extract reports for
completely arbitrary periods. When you finally reconcile a particular period,
you can close it for further entries. However, you can have as many periods
open as you wish.

Each set of transactions has its own Number Series. There is no limit to the
number of series, which can be set up in each module using the ‘Settings’
function.
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Preparing for Installation
FirstOffice is designed with a modern graphical user interface - for Windows,
Linux and Macintosh. It uses many different “windows” on the screen, one
for each task. The basic idea is to create a working environment that as
closely as possible relates to the way you handle papers, files and documents
on your desk.

Accounting tasks normally require that you work with several documents at
the same time. This fact is reflected in the design of FirstOffice, and
documents and reports are handled in a slightly different manner to what you
may be used to in word processors or spreadsheet programs. FirstOffice
therefore contains a number of features that you may not be familiar with.

If this is the first program you will be using in a Windows, Linux or
Macintosh environment, you should first of all take the time to learn as much
as possible about the computer and how to use it. And you must of course be
sure that the correct version of the computer’s operating system is installed.
Talk to your computer dealer or consultant if you are uncertain.

In the ‘Accounting Principles’ chapter later in this manual you can read more
about the basic accounting tasks in a business. Please ensure you read it if
this is your first attempt with computerised accounting.

Even if you are an experienced computer user, you should read this
Introduction, because FirstOffice contains a large number of features
designed to facilitate your work and to make it faster. If you are the ‘I-never-
read-manuals’ type of person, you will of course be able to use FirstOffice
anyway - it is very simple. But there are some not so obvious shortcuts that
can save you a lot of time. They are all in the manual.

Efficient Management
FirstOffice is easy to use. By following the instructions in the installation
section of this manual, you can set up your order and invoicing system in a
very short time. You will quickly be able to get the benefits from efficient
order processing and a well-functioning system for your Sales Ledger and
debtors.

The basic idea with automatic administration is to make the computer do
most of the routine work. In the beginning it may seem a lot of work to enter
all the necessary information about Items and Customers, but that is really all
the preparation you have to do. It is not necessary to use all the many features
of FirstOffice. Remember, however, that the more basic information you can
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enter into the various files and registers, the more the program will be able to
assist you in your work.

Planning and Setting up
If this is the first time that you will be using a computerised accounting
system to manage your sales, purchase and nominal ledgers, or if you are
changing from another system, why not take a good look at the overall
operations? Maybe you can do things in your present operation more
efficiently.

A good idea is to sit down with pen and paper for a while, and go through
your Items (products and services you buy and sell), Item Groups, Customer
Categories, Accounts, Payment Modes and Terms, etc. If some of the
concepts of FirstOffice are new to you, it is always a good idea to think first.

The setting up of a FirstOffice system in your business requires some
planning and forethought. You will have to make a number of decisions
about number series for Customers, Items, statistical classifications, invoice
procedures and so on. FirstOffice allows a great deal of flexibility, and you
can create almost any work environment you want. But remember that you
are in charge. If you find that the standard Chart of Accounts is not suitable
for your business, only you can make the decision to use another chart.
FirstOffice allows almost anything.

If you will be using FirstOffice as a multi-user system, its installation, as is
the case for any advanced multi-user system, will mean a great change in the
day-to-day operations of the business. Before you install, you should
therefore consider very carefully how you want the business to work, now
and in the future.

• What tasks are to be performed, and just how do you want them done?

• Who should enter e.g. Orders, Invoices, Payments, and how?

• What business documentation is needed, and how should you identify
and file the documents?

• What reports do you want, and how do you want Orders, stocks, sales
etc. to be reflected in your accounts?

FirstOffice gives you great flexibility, but it is important that you know what
you want beforehand. We strongly advise against installing a multi-user
installation without the assistance of a qualified FirstOffice consultant. Please
contact your FirstOffice representative for advice and training.

Most people think that the beginning of the year is the only time when you
should change the accounting procedures in a business. Quite to the contrary,
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it is better to change systems during the year. You can then select a calm
period of the year, enter all data from the beginning of the year and check the
outcome against reports produced from the previous system.

Remember that once the installation process has been completed, FirstOffice
does require some maintenance. At the very least, you should establish a
regular routine for backing up. A financial system is very different from a
word processor, which handles individual documents. FirstOffice works - like
all financial systems - with a database, in which all your data about
customers, invoices, nominal ledger etc. is stored in a single file. If you lose
that file, you have lost not just a single document, but all your accounting and
customer information.
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Installation
The installation of a FirstOffice financial system is technically simple. If you
are used to computers and have some experience of installing software, you
will find the installation of FirstOffice very straightforward.

System Requirements

All Platforms
FirstOffice requires at least 20 Mb of free hard disk space at the time of
installation, but more will be required as the database grows with regular use.

In multi-user systems, you must reserve at least one computer in the network
as your FirstOffice server. All servers should be dedicated (i.e. they should
not be used for any other purpose such as print spooling or running separate
applications). FirstOffice communicates using TCP/IP: this must be installed
on all servers and clients. FirstOffice is suitable for use on mixed networks
(e.g. networks with Linux, Macintosh and Windows clients), provided all
machines have TCP/IP installed.

If you will be connecting to your FirstOffice server using GSM devices (e.g.
mobile phone) or a dial-up modem connection, the minimum recommended
modem speed on the server is 64 kbps. If there will be more than 10 users, or
if you will use the Attachments feature to attach files to records or mails, at
least 128 kbps is preferable. The server should have a fixed line connection
and a static IP address. The Attachments feature is described in Chapter 2 of
this manual (page 129).

10 Mb/s Ethernet Cards are sufficient for the clients and for the server in
small networks. In large networks with more simultaneous connections, a 100
Mb/s card is recommended for the server.

Any employee can work with FirstOffice simultaneously in a local area
network or a wide area network. As FirstOffice supports firewall technology
independent of the type of internet connection (ADSL, ISDN or dial-up
modem), it is recommended that firewall software be installed on the server
machine.

Concerning security, it is important to mention that the data flow between the
FirstOffice server and its clients is encrypted. Back-up files created using
FirstOffice’s built-in feature are also encrypted. Every user will use a unique
user name and password to log in. For increased security, it is recommended
that you switch off Windows or Macintosh file sharing on all machines.
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Windows

Hardware
For a single-user installation, you will need a Windows computer with a hard
disk drive and a printer. The minimum processor is a 450 MHz Pentium II
(600 MHz PIII or P4 recommended). The minimum memory requirement is
256 Mb. These specifications also apply to the client machines in a multi-user
system, where memory requirements are more dependent on the version of
Windows than on FirstOffice. FirstOffice has a minimal hard disk
requirement on the clients (usually under 20 Mb). The server should be
selected with the transaction load of the installation in mind. The minimum
server is a 600 MHz Pentium III with at least 256 Mb memory (2 GHz
Pentium 4 with 512 Mb memory recommended).

Software
FirstOffice single-user needs Windows 98SE/2000/XP (Windows 98 is not
supported). In client/server installations, Windows 2000 or XP are the
recommended operating systems for the server, while the clients can use
98SE/2000/XP. The server should not use Windows NT, while the clients can
use NT but it is not recommended. FirstOffice can be installed in file-sharing
networks (Novell) but the FirstOffice installation will not use any of the file-
sharing facilities. TCP/IP and Winsock2 (WS2_32.DLL) must be installed on
the server and all clients. GdiPlus.dll must be present in the same directory as
the application if you are using Windows 98 Second Edition (SE) or
Windows NT 4 Service Pack 6, and Unicows.dll should also be in that
directory if you are using Windows 98SE.

Macintosh

Hardware
In a single-user system, you will need a Macintosh with a hard disk drive, a
printer and at least 64 Mb (OS 9) or 128 Mb (OS X) of internal memory. The
minimum recommended machine is an iMac or a Macintosh G3 (G4 if you
are using OS X). These specifications also apply to the client machines in a
multi-user system. The minimum server is a Macintosh G4 with at least 128
Mb of memory (a G5 with 256 Mb is recommended). Hard disk speed is
more important than processor speed. iMacs should not be used as servers.

Software
FirstOffice requires Macintosh System 9.2.1 (or later). Users of OS X should
use 10.2.7 or later on clients and 10.3 or later on servers. Macintosh servers
should use OS X. Multi-user versions of FirstOffice use TCP/IP and Open
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Transport: these must be installed on the server and on all clients. OS 9
support will be discontinued in FirstOffice version 5.0.

Linux

Hardware
Please refer to the Windows or Macintosh sections above for details of
hardware requirements.

Software
Recommended distributions are Red Hat 7.1, SuSE 7.0, Slackware 7.2 or
similar/later. The X Window System should be installed in single-user
installations and on client machines. The Linux server version of FirstOffice
does not have a graphical interface: it can be used with any distribution that
has Linux Kernel 2.4 or later and GNU C Library 2.2 or later.

Installation

Single-user
FirstOffice is supplied on a CD-ROM, and you can always obtain the latest
version from the Downloads area of our website, www.hansaworld.com.

The CD-ROM contains an installer program for installing FirstOffice on a
Windows machine. Self-expanding archives are provided for other platforms
(Linux, and Macintosh OS 9 and OS X). The files available for downloading
from our website are all self-expanding archives.

In this section we first describe installing from a self-expanding archive (in
which case the basic procedure is the same for all platforms). This is
followed by a description of the Windows installer program that can be found
on the CD-ROM.

1. To install from a self-expanding archive, first create a new folder on your
hard disk.

2. Copy the archive that is correct for your machine and operating system
from the CD-ROM into this folder, or move the file that you have
downloaded into this folder.

http://www.hansaworld.com
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3. Make sure you have at least 20 Mb available for the FirstOffice
application, the associated files and for the data file which will be created
the first time you launch FirstOffice. Then, double-click the file to
expand it.

4. In some operating systems (e.g. Windows), you will now be asked where
you would like the FirstOffice application and associated files to be
saved.

Specify where you would like the application to be saved, using the
[Browse] button if necessary to locate the correct folder. Click [OK].

In other operating systems (e.g. Macintosh OS 9 and OS X), the
FirstOffice application and associated files will be saved in the folder
containing the self-expanding archive.

5. A thermometer bar will show you how the installation is progressing.
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To install FirstOffice from the CD-ROM using the Windows installer
program, follow these steps—

1. Start Windows.

2. Insert the FirstOffice CD-ROM into your CD drive.

3. If you have Windows NT, go to the Main window and open the File
Manager by double-clicking. Select the CD drive (usually D:) by
clicking the appropriate button in the top left-hand corner of the window.
If you have Windows 98SE/2000/XP, go into the Explorer or “My
Computer” window and double-click the icon representing your CD-
ROM drive. The following window opens—

Double-click the “FOPro43ENGSetup” file (“FOPro43ENGSetup.exe” if
you have chosen to show extensions in the Explorer).

Alternatively, select the ‘Run’ command from the Start menu (Windows
98SE/2000/XP) or from the File menu in the File Manager (Windows
NT). The illustration below is from Windows XP—

4. In the Command line field, type “D:\FOPro43ENGSetup.exe” (where
“D” represents your CD or DVD drive, and where
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FOPro43ENGSetup.exe is the name of the installer program on the CD-
ROM) and press [OK].

The following window will be opened—

5. Click [Next]. The following window appears—
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The empty space on the hard disk is shown at the bottom. Check that you
have at least 20 Mb free: the installation will require 12.2 Mb, and a data
file will be created as soon as you run FirstOffice for the first time.

By default, FirstOffice will be installed in a directory named
“HansaWorld FirstOffice Professional” in the “Program Files” directory.
You can choose another destination if necessary. When you have decided
where FirstOffice is to be saved, click [Next].

6. The following window appears—

Use this window to name the Shortcut Folder that the installer will add to
your Start menu.

Click [Next] and follow the on-screen instructions to begin the
installation process. A thermometer bar will show you how the
installation is progressing.
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Under Windows NT, the installation process will create a Program
Group and some icons in the Windows Program Manager. A message
will tell you that the installation was successful. If anything went wrong,
you will be informed.

Under Windows 98SE/2000/XP, the FirstOffice application will be
installed in a new FirstOffice directory. The installer will also create a
shortcut, allowing you to launch FirstOffice from the Start menu.

Whether you install using a self-expanding archive or the Windows installer
program, the resulting FirstOffice folder or directory will also include some
files containing a Chart of Accounts, report definitions, a help file, standard
settings, document definitions and a sample database. These are described in
the section entitled ‘After Installation’ below on page 32.

Multi-user
For a multi-user installation you need to proceed as follows—

1. Create a network including all the computers and other equipment you
are going to use. Use the Windows, Macintosh or Linux System
installation tools to install TCP/IP on each machine. Ensure all Windows
machines have Winsock 2 (WS2_32.DLL) installed and that all
Macintoshes have Open Transport installed.

2. Select one computer as the server computer.
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3. If your server is a Linux or Macintosh OS X machine, the FirstOffice
server application will not have a graphical interface. Proceed as
described in the next section. Otherwise, install FirstOffice on the server
computer, as described in the single-user section above.

4. Install FirstOffice on each of the client machines, again as described
above.

Linux and Macintosh OS X Server Installation
The FirstOffice server applications for Linux and Macintosh OS X can only
be run with the machine in “Terminal” mode. However, you can install them
either using the usual graphical interface or using the “Terminal” mode.

To install the FirstOffice server application on a Linux or Macintosh OS X
machine using the graphical interface, follow the instructions in the ‘Single-
user’ section above.

Otherwise, to install the FirstOffice server application using the “Terminal”
mode, follow these steps—

1. Download the latest version of FirstOffice that is correct for your
platform and operating system. Create a new folder on your hard disk,
and move the file that you have downloaded into this folder.

2. Put the machine into “Terminal” mode.

On a Macintosh OS X machine, double-click the Terminal application
that will usually be found in the Utilities folder in the Applications
folder, or use the Terminal icon in the Dock—

On a Linux machine, use the Terminal icon in the Dock or Panel. The
appearance of these icons will vary depending on your interface: shown
below are typical icons for KDE and GNOME—

3. Type the following, remembering that the Terminal environment on
Linux is case-sensitive—

cd /Applications/FirstOffice changes to the directory where you have
placed the installer file, in this case the
“FirstOffice” directory inside the
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“Applications” directory at the root
level.

tar -xvzf FirstOfficeProAdv43Serv.tar.gz (Linux), or
tar -xvzf FirstOfficePro43ServOSX.tar.gz (OS X)

where FirstOfficePro43ServOSX.tar.gz
is the name of the installer file that you
have downloaded

When you press the Return key, the installer will create a new directory in
your FirstOffice directory. This new directory will be named
1OfficeProAdv43Serv (Linux) or 1OfficePro43ServOSX (Macintosh OS X).
This will contain the application and the necessary auxiliary files.

http://FirstOfficeProAdv43Serv.tar.gz
http://FirstOfficePro43ServOSX.tar.gz
http://FirstOfficePro43ServOSX.tar.gz
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After Installation

The FirstOffice directory or folder contains a number of files—

Shown is the Windows XP folder: its appearance on your computer and the
number of files and folders may differ slightly according to the type of
machine you are using, its operating system and certain other settings. In the
illustration, for example, all file extensions are shown. Some or all of the
following files should be present—

1. The FirstOffice application, consisting of the program file “1Office.exe”
or “1Office” (Windows), “1OfficeOS9” (Macintosh OS 9) or
1OfficeOSX (Macintosh OS X).

2. The “Hob” folder, containing language and other files. This must be
present in the same folder or directory as the FirstOffice application.

3. The file “DBDef.txt”, which is used by FirstOffice to import some basic
settings data whenever a new database is created. This file must be
present in the same directory as the program when a new database is
created.

4. The file “Default.txt”, which is used by FirstOffice to import some basic
settings data whenever a new Company is created. This file must be
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present in the same directory as the program when a new Company is
created. Companies and databases are described in the next section of
this chapter (page 34).

5. The file “FOUKStd.txt” which contains sample set-up data,
“UKAccs1.txt”, which contains a sample Chart of Accounts, and
“UKForms.txt”, which contains templates for Invoices and other forms.
If you wish to use these, follow the instructions in the section entitled
‘Creating a New Company’ below on page 37 first to create a new
database and then import these settings. The name and precise make-up
of this file will vary according to the country of use. In some
installations, these files will be placed in a folder named “Setup”.

6. A back-up of an example database for training purposes
(“FirstOfficeProDemoDateAugust2005.txt”). It includes the Chart of
Accounts and other settings that are also in the files described in the
previous paragraph. To use the example database, follow the instructions
in the section entitled ‘Restoring from a Back-up’ below on page 69
covering the creation of a new database and the importing of a back-up
file. In some installations, this file will be placed in a folder named
“Setup”.

7. An “Attach” folder, which must be present if you want to attach files to
records. Such Attachments are fully described on page 129 in the next
chapter, ‘Work Area’. In multi-user installations, this folder should be on
the server machine. In some installations, this folder will not be created
until you run FirstOffice for the first time.

8. A “Backup” folder to be used for storing daily back-up files. In some
installations, this folder will not be created until you run FirstOffice for
the first time.

9. Two extra folders, “PS” and “Scripts”, will be present in Linux
installations.

10. The “Tmp” folder should be present if you will be using the FirstOffice
Mail facility to send and receive external mail (i.e. to communicate with
standard email programs outside your FirstOffice network). The External
Gateway uses it to store mail attachments downloaded from the POP3
server before they are transferred to the “Attach” folder and attachments
that are to be uploaded to the SMTP server. This folder need not be
present if you are not using the FirstOffice Mail facility (i.e. if you do
not have the CRM and Mail Value Pack). In some installations, this
folder will not be created until you run FirstOffice for the first time.
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Starting FirstOffice

Companies and Databases

The key components of a FirstOffice system are the application and the
database. The application, or program, has the following symbol in the
directory window (Windows) or in the Finder (Macintosh)—

The database is the file used by FirstOffice to store its data. This file must be
called “1Office.hdb”. In many cases, that data will pertain to a single
company. However, where there are separate departments or subsidiary
companies that keep separate accounts, their data can also be stored in a
single database, in separate ‘Companies’. If you set up more than one
Company in FirstOffice, each will be completely separate: there will be no
common information, although it is possible to copy from one to another
using the export and import functions. Separate account balances will be
maintained, and each Company within a database can be backed up
separately or together.

You should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

The database file must have the name
“1Office.HDB” and be present in the
same folder or directory as the
FirstOffice application. If you move
the database file or rename it, a new
database will be created the next time
you start FirstOffice.

!



Chapter 1: Introduction and Installation - Starting FirstOffice

35

Loading an Existing Database and Company

Single-user
Start FirstOffice just like any other Windows, Linux or Macintosh
application, by double-clicking the program icon. FirstOffice will load the
database named “1Office.HDB”. If this is not present in the folder or
directory, a new database will be created automatically.

If you have a single Company in your database, that will be loaded by default
and you will be ready to start work.

If you have more than one Company in your database, you will be asked to
select one before work can begin.

Double-click the appropriate Company in the list, or highlight it and press the
Enter key on your keyboard. The database is now ready to use.

Multi-user
In a multi-user installation, launch FirstOffice on the server first. If your
server has a graphical interface, follow the procedure described in the
previous section: choose any Company when the ‘Select Company’ window
appears. Users will then be able to log on to work with any of the Companies
stored within that database.

Depending on how you shut the server down on the previous occasion it was
used, FirstOffice should select the Server module automatically. The ‘Server
Status’ window appears. You can use this window to monitor network
activity. For details about shutting down the server, please refer to the section
entitled ‘Shutting Down’ below on page 62.
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If the ‘Server Status’ screen does not appear automatically, click the [Select
Module] button in the Master Control panel. Then, double-click ‘Server’ in
the resulting list. The ‘Server Status’ window will now appear.

The server can now be left alone.

Servers with no Graphical Interface
If your server is a Linux or Macintosh OS X machine, you must first put it
into “Terminal” mode before you can launch the FirstOffice server
application. Instructions can be found in the ‘Linux and Macintosh OS X
Server Installation’ section above on page 30.

When the Terminal window opens, and assuming you have retained the
default directory structure, type—

cd /Applications/FirstOffice/1OfficeProAdv43Serv (Linux), or
cd /Applications/FirstOffice/1OfficePro43ServOSX (OS X)

./1office-server & (Linux), or

./1office-macosx & (OS X) starts the FirstOffice server application.
The & is optional: it allows you to run
the program in the background and to
use the Terminal window for other
tasks.

This assumes the application is named
“1office-server” or “1office-macosx”. If
this is not the case, type the application
name after “./”

Creating a New Database - Single-user

In the event that you need to create a new database, simply ensure there is no
database file with the name “1Office.HDB” in the same folder as the
FirstOffice application when launching. A new database will be created
automatically.

The “DBDef.txt” and “Default.txt” text files must be present in the same
folder as the application when a new database is created. FirstOffice will use
these files to set some initial preferences in the new database.
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The installation will not be correct if
the “DBDef.txt” file is missing.

Creating a New Company
When creating a new database, the first task is to enter a new Company.
FirstOffice automatically opens the ‘Companies: Inspect’ window so that you
can carry out this task.

If the ‘Companies: Inspect’ window is not opened at this point, this is
because your example of the “DBDef.txt” file has instructed FirstOffice to
create a new Company automatically. In this case, turn now to the next
section, ‘Importing from a Back-up’ and continue with the set-up sequence
from there. When you reach the section entitled ‘Changing the Company
Name’, follow its instructions to change the Company’s name to something
more suitable.

Click on the first field in the column headed “Code” and enter information as
described below. Use the Tab or Return key to move from field to field.

The following fields are present in this window—

Code Enter a unique code. This can be a numeric code greater
than 0 or an alpha code of up to five characters.

Name Enter a name by which this company or department will
be identified in the ‘Select Company’ window
(illustrated at the end of this section). This window will
allow you to choose the Company you want to work
with each time you log in to FirstOffice.

Short If you have more than one Company in your database,
you can switch between Companies in a work session,
leaving windows from each Company open. This Short
Code appears as part of every window title to indicate

!
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the Company to which the information in the window
belongs.

TCP/IP This field is described in the next section, ‘Creating a
New Database - Multi-user’. You should leave it empty
in a single-user system.

Port This field is described in the next section, ‘Creating a
New Database - Multi-user’. You should leave it empty
in a single-user system.

You can only enter one Company now: if you need more than one, you will
be able to add them later in the set-up process (described in the ‘Value Packs,
Users and Companies’ and ‘Changing and Adding Companies’ sections
below on pages 44 and 46 respectively). You can have up to four Companies.

If you are creating a new Company, the “Default.txt” text file must be present
in the same folder as the FirstOffice application. FirstOffice will use this file
to import some basic settings to the new Company. When the entry is
complete and you have made certain that the “Default.txt” file is in the right
place, click the [Save] button in the top right-hand corner of the Company
screen.
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You should now inform FirstOffice that you wish to use the Company you
have just created. The ‘Select Company’ list window will appear
automatically—

Select the single Company to work with and press the Enter key.

Importing from a Back-up
FirstOffice will now open a window listing back-up files that can be
imported. FirstOffice looks in the folder or directory as the application for
folders named “Backup” and “Setup”. Any files in these folders in the correct
format are listed in this window.

Proceed down one of the following routes, depending on your
circumstances—

1. If you are launching FirstOffice for the first time, you will not have any
back-up files to be imported. If you do not wish to import the example
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database or the sample Chart of Accounts, close the window using the
close box and refer to the section immediately below entitled ‘The Work
Area’.

2. If you are launching FirstOffice for the first time and wish to import the
example database or the sample Chart of Accounts, double-click the file
to be imported, or highlight it and press the Enter key. If you choose to
import the example database, FirstOffice will quit when it has finished
importing the file. Restart FirstOffice and log in as SJ with no password.

3. If you are creating a new FirstOffice database which is to be based on
your existing data (perhaps you are restoring from a back-up because
your previous database has become damaged or because you are
updating to a new version), double-click the back-up file to be imported,
or highlight it and press the Enter key. For full details of this process,
please refer to the ‘Restoring from a Back-up’ section below on page 69.

The Work Area
Whether you imported a back-up file or not, the FirstOffice work area will
now appear. This will be the basis for all your work in FirstOffice and is fully
described in the next chapter, ‘Work Area’. It is illustrated below to enable
you to identify the various parts of the screen mentioned in the following
sections.
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Personal
Desktop

Registers

Menu Commands

Menu Bar

Master
Control
Panel

HansaWorld.com

Settings
Each module contains a number of settings that you can use to control how
that module operates. You can access them by selecting ‘Settings’ from the
File menu or by clicking the [Settings] button in the Master Control panel.
Before you start working with each module, you should consider its settings,
since its functions depend on the settings being correct.

Many settings take the form of options or preferences. Others, such as
Company Info that will be considered next, require information or a number
of records to be entered.

Changing the Company Name
The System module is where settings used throughout the FirstOffice system
are determined. You will now use it to enter your company name, address
and other information to be used in reports and documents such as Invoices.

http://www.HansaWorld.com
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Click the [Select Module] button in the Master Control panel. This list of
modules appears—

Choose the System module by double-clicking. Then, select ‘Settings’ from
the File menu or click the [Settings] button in the Master Control panel to
bring up the ‘Settings’ list window—
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In the list, select ‘Company Info’ by double-clicking. The ‘Company Info:
Inspect’ window appears.

Enter the name, address and other information as shown in the example
illustration.

Click the button marked “Reg” towards the top centre of the window to see
the other fields in this setting.

The Bank Customer ID is an ID number used for automatic (modem)
communication with certain credit institutions in some countries. The Edit
and Report Font fields allow you to select different fonts for use on screen
and in reports respectively. If you leave these fields empty, FirstOffice’s
default fonts will be used. These are selected for maximum readability, and
you should only change them if you have good reasons to do so. In non-
English versions of FirstOffice, use these fields to select fonts with special
character sets.
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VAT Law and Character Set ensure the behaviour of FirstOffice conforms to
certain local conventions of the country in which it is being used. To choose
the correct VAT Law and Character Set for your location, place the cursor in
one of these fields and then press the Ctrl-Enter (Windows and Linux) or -
Enter (Macintosh) key combination. A selection list will appear in which you
can choose an option by double-clicking. In the case of the VAT Law field, if
your country is not listed in the ‘Paste Special’ list, choose the “Default”
option.

Details of the other fields can be found on page 314 in the ‘System Module’
chapter elsewhere in this manual. When you have completed the window,
click the [Save] button in the top right-hand corner to save the changes and
close the window.

Value Packs, Users and Companies
The next task is to ensure that you have been granted access to the
appropriate Value Packs and that the correct numbers of users and
Companies have been registered. If you no longer have the ‘Settings’ list on
screen, select ‘Settings’ from the File menu or click the [Settings] button in
the Master Control panel once again. Select ‘Configuration’ by double-
clicking.
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The ‘Configuration: Inspect’ window appears—

If you need more than one Company, enter the correct number in the
Companies field, up to a maximum of four. Ensure that the numbers of Users
is correct (and in any case is at least 1).

You should only change the number of Companies if your business is one
where there are separate departments or subsidiary companies that keep
separate accounts. You can set these up as separate accounting entities in
FirstOffice. Each department or subsidiary is termed a ‘Company’. If you set
up more than one Company in FirstOffice, each will be completely separate:
usually, there will be no common information, although you can copy from
one to another using the export and import functions. Separate account
balances will be maintained, and each Company within a database can be
backed up separately or together.

You should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

In the remaining sections of the window, select the Value Packs that you
require by clicking the check box next to each one so that a tick appears.
Choose the options that describe your hardware most accurately in the Server
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Hardware and Server OS fields (in a single-user system, choose the options
that apply to the machine on which you will be using FirstOffice). To choose
an option, place the cursor in one of these fields and press the Ctrl-Enter
(Windows and Linux) or -Enter (Macintosh) key combination. A selection
list will appear in which you can choose an option by double-clicking.
Finally, click [Save]. If you have selected any Value Packs, they will be
made available the next time you start FirstOffice.

If you intend applying for an Enabler Key using the ‘Automatic Internet
Enabler’ method, you should at least make sure you have specified your
Server Hardware and Server OS and numbers of Mailboxes and Conferences
in the Configuration setting before doing so. The other information will be
downloaded from the HansaWorld server together with the Enabler. You can
select the modules that you require before applying for an Enabler if you
want to carry out set-up work in the meantime. If you will use one of the
other methods to apply for an Enabler Key, you must make sure the
Configuration setting is complete and correct before applying. Details about
applying for an Enabler Key are below on page 47.

Changing and Adding Companies
If you want to change the company identifier that appears in the title bar of
each window, and/or you need more than one Company, you can do this now.
Click [Companies], the first button in the ‘Registers’ section of the Master
Control panel—

Then, select ‘Open Company Register’ from the Operations menu. The
‘Companies: Inspect’ window that you saw earlier is opened, showing the
Company that you created—

To create more Companies, click in the Code field in the first blank row and
enter information as described in the section above on page 37 entitled
‘Creating a New Company’. Remember, this should only be done for parts of
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your business that are completely separate accounting entities to the first
Company.

If you are creating a new Company, the “Default.txt” text file must be present
in the same folder as the FirstOffice application. FirstOffice will use this file
to import some basic settings to the new Company.

It is advisable to enter as many Companies as you need now (up to a
maximum of four), so that you only need apply for an Enabler Key once. You
will be able to enter all set up information such as a Chart of Accounts to one
Company and then to export those settings to the other Companies.
Remember that each Company will maintain completely separate accounts,
so there is no need to create separate Companies for departments that are part
of the same accounting whole.

When the entry is complete, click the [Save] button in the top right-hand
corner of the Company screen.

For security reasons, FirstOffice will shut down after any changes or
additions have been made in the Company register. Restart the program to
continue working.

For each Company added, you should now repeat the process described
above on pages 41 and 44 respectively in the ‘Changing the Company Name’
and ‘Value Packs, Users and Companies’ sections, entering the correct
company name and address, and ensuring that access has been granted to the
correct Value Packs. To change Companies, select ‘Companies’ from the File
menu and choose another Company in the list that appears. Depending on the
method you will use to apply for an Enabler Key, this work should be
completed before doing so.

The Enabler Key
The next stage is to inform FirstOffice that you have a full licence for its use.

A FirstOffice licence normally gives you the right to use the program for a
single database. Each database will normally require its own Enabler Key
provided to you on application by your local FirstOffice distributor. When
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you purchase FirstOffice, this Key is absent but FirstOffice will be fully
operational for 30 days after installation, allowing time for the set-up work
described in the previous sections. After 30 days, if you have not applied for
your Key, FirstOffice will change to demonstration mode: it will remain fully
functional, but printing will be disabled. You can apply for the Key at any
time (before or after the 30 day point), but before doing so you should ensure
you have entered all required Companies in the Company register and named
them all in the Company Info setting, and, depending on the method you will
use to apply for an Enabler Key, given yourself access to the required Value
Packs and entered the correct number of users in the Configuration setting in
the System module (all as described above).

When you close the Configuration window, FirstOffice calculates a Control
String based on the Value Packs selected and the number of users and
Companies entered. It also calculates a Control Code, an eight-digit number.
Both will be visible in the Configuration setting.

At this point, where a Control String and Control Code are known to
FirstOffice, the database will enter its demonstration mode 30 days from
installation. To gain full use of the program, you need to obtain an Enabler
Key. You can do this using one of three methods, described below.

Once you have obtained a Key, if you change the Valid Until Date or the
number of users, mailboxes or conferences in the Configuration setting, or
give yourself access to different Value Packs, FirstOffice will go into
demonstration mode. You can regain full use of FirstOffice by reverting the
Configuration setting to its original state.

If you add a new Company to the database or change the Company Name in
the Company Info setting in any existing Company, this will also cause
FirstOffice to go into demonstration mode. In this case, however, you can
only regain full use of FirstOffice by applying for a new Key.

Set up your Companies and define
the Configuration and Company Info
settings in each one before applying
for an Enabler Key.

If you need to call HansaWorld support for help obtaining an enabler, you
can find your local telephone number by clicking the “Countries” link at
www.hansaworld.com.

Automatic Internet Enablers
If you use the Automatic Internet method to apply for an Enabler Key, you
will instruct your copy of FirstOffice to connect to the connect to the
customer database on the HansaWorld server, which contains details of your

!
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contract (Value Packs and number of users purchased, etc). A Key will then
be downloaded from the HansaWorld server, as will the number of users,
Value Pack access and other information to the Configuration setting.
Everything previously in the Configuration setting will be overwritten.
Unlike the other methods, therefore, you do not need to ensure the
Configuration setting is complete or accurate before applying for a Key using
this method. All you need do is make sure you have specified your Server
Hardware and Server OS and numbers of Mailboxes and Conferences in the
Configuration setting. You should also make sure you have recorded your
company name in the Company Info setting. Follow these steps—

1. If you no longer have the ‘Settings’ list on screen, select ‘Settings’ from
the File menu or click the [Settings] button in the Master Control panel
once again. Select ‘Internet Enablers’ by double-clicking.

2. Fill in the fields as follows—

Registered in Enter the country where your company is registered. To
choose an option, place the cursor in this field and press
the Ctrl-Enter (Windows and Linux) or -Enter
(Macintosh) key combination. A selection list will
appear in which you can choose an option by double-
clicking.
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Customer Code at HansaWorld

Enter the Customer Number allocated to your company
by HansaWorld. This can be found on your HansaWorld
invoice.

Contract Number at HansaWorld

Enter the Customer Number allocated to your company
by HansaWorld. This can be found on your HansaWorld
invoice.

Contract Daughter No.

In most cases, this field can be left blank. If appropriate,
enter here the contract number of your parent company
here, or your sub-contract number if, for example, you
have two contracts.

3. If you do not have enough information to fill in these fields (e.g. you do
not know your Customer Code at HansaWorld), click the [Automatically
Fill These Settings] button. Assuming you are connected to the internet,
your copy of FirstOffice will connect to the customer database on the
HansaWorld server. It will then search the customer database for your
company name as entered in the Company Info setting. The two names
must match exactly: an extra space, for example, will mean that a match
will not be found. If it does not find a match, it will search for your VAT
Number, telephone number and company registration number. If any of
those match, it will download information to these fields from the
customer database.

4. Click the [Save] button in the Button Bar to save the Internet Enablers
setting.

5. The setting will close: re-open it and click the [Register for Automatic
Internet Enablers] button. Assuming you are connected to the internet,
the Registration No. field in the Internet Enablers setting and the Valid
Until and Enabler Key fields in the Configuration setting will be filled in
automatically.

The Valid Until date will be set to three months from the current date or to
the end date of your contract, whichever is the nearer. Once a month your
copy of FirstOffice will connect to the HansaWorld server automatically to
get a new Enabler Key. The new key will add an extra month to the Valid
Until date. If for some reason this automatic process fails and your copy of
FirstOffice is unable to obtain a new key, it will attempt to connect once a
day for the next two months. If it is still unable to obtain a new key, your
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copy of FirstOffice will go into demonstration mode. If you want to activate
the monthly connection yourself, open the Configuration setting and select
‘Connect to get your Enabler’ from the Operations menu. The next automatic
connection will occur one month later.

In multi-user systems, it will be your FirstOffice server that attempts to
connect on a monthly basis. If your server is not connected to the internet,
you will need to use the ‘Connect to get your Enabler’ function.

As mentioned above, everything previously in the Configuration setting will
be overwritten when you apply for an Enabler Key using this method. It is
therefore recommended that you check the Configuration setting once you
have obtained your Key. Call HansaWorld support if you think the new
settings are wrong.

If your application for an Enabler Key is unsuccessful, the probable reasons
are—

i. You did not save the Internet Enablers setting in step 5 before clicking
the [Register for Automatic Internet Enablers] button.

ii A “server not responding” message is usually caused by your firewall. It
is recommended that you re-configure it to allow communication with
www.hansaworld.com.

HansaWorld.com Website Enablers
If you have an internet connection but your copy of FirstOffice is not on a
computer that is connected to the internet, you can obtain an Enabler Key
through the www.hansaworld.com website. This method uses the Control
String and Control Code to determine the Enabler Key. So, if you are using
this method, you must make sure you have created all the Companies that
you need and that you have defined the Configuration and Company Info
settings in each one before applying for an Enabler Key.

Follow these steps—

1. If you are using Internet Explorer 6, you will need to check your internet
security settings and add www.hansaworld.com as a trusted site.

2. Ensure you are the only person logged in to your FirstOffice system and
open the Configuration setting.

3. Enter the expiry date of your FirstOffice contract in the Key Valid Until
field. Make sure the setting is otherwise complete and accurate, and click
the [Save] button in the Button Bar to save and close it.

http://www.hansaworld.com
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4. Quit and restart your FirstOffice system. If you are working on a client
machine in a multi-user system, you only need restart the client, not the
server. This will force the Control String and Control Code to be
recalculated.

5. Produce a Company Info report: this is described on page 363 in the
‘System Module’ chapter later in this manual.

6. Go to www.hansaworld.com and click the “Enablers” link.

7. Click the appropriate link for the country where your company is
registered.

8. Enter your Customer Number and click the [Register] button to be given
a password. The password will be sent to you by fax or email. Your
Customer Number can be found on your HansaWorld invoice. You can
also use the [Register] button if you already have a password but have
forgotten it.

9. Enter your Customer Number and password and follow the instructions
on screen.

Contact HansaWorld support if you don’t know your Customer Number or if
the password email does not arrive.

If your application for an Enabler Key is unsuccessful, the probable reasons
are—

i. The “Unknown Log in”, “No valid contract” or “You are not properly
registered with us” messages mean you clicked the wrong customer link
(wrong country), you entered your Customer Number and/or password
incorrectly, or you have not signed and returned your maintenance
agreement.

ii. The “Enabler failed” message means that the information in your
Configuration setting does not match the information in the customer
database on the HansaWorld.com server. You will be sent an email
listing what should and what should not be included in your
Configuration setting according to your contract with HansaWorld.
Update your Configuration to match the email and follow the sequence
above from step 4, or call HansaWorld support if you think the email is
wrong.

Manual Enablers
If you do not have an internet connection at all, you can obtain an Enabler
Key by telephone or fax. This method uses the Control String and Control
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Code to determine the Enabler Key. So, if you are using this method, you
must make sure you have created all the Companies that you need and that
you have defined the Configuration and Company Info settings in each one
before applying for an Enabler Key.

Follow these steps—

1. Ensure you are the only person logged in to your FirstOffice system and
open the Configuration setting.

2. Enter the expiry date of your FirstOffice contract in the Valid Until Date
field. Make sure the setting is otherwise complete and accurate, and click
the [Save] button in the Button Bar to save and close it.

3. Quit and restart your FirstOffice system. If you are working on a client
machine in a multi-user system, you only need restart the client, not the
server. This will force the Control String and Control Code to be
recalculated.

4. Contact your local FirstOffice representative during normal working
hours and quote the Control String and Control Code. You may be asked
to produce a Company Info report: this is described on page 363 in the
‘System Module’ chapter later in this manual. You will then be given a
Key.

5. Open the Configuration setting, enter the Key in the Enabler Key field
and click [Save]. This will inform your copy of FirstOffice that you have
a full licence for its use.

If the “DBDef.txt” file is missing
If you attempt to create a new database as described above on page 36 in the
section entitled ‘Creating a New Database - Single User’ but without a
“DBDef.txt” file present in the same folder or directory as the FirstOffice
application, that database will be created successfully. However, the process
will deviate from the path previously described in three respects—

1. The window listing importable back-up files will not appear.

2. A new Company will not be created automatically for you. Instead, the
first window to be opened (with the title ‘Companies: Update’) will offer
you the opportunity of creating the first Company yourself.

3. You will only have access to the System and User Settings modules.
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You can either decide to start again or to proceed with the empty database.
The former route is recommended, as you will not have lost much time.
Follow these steps—

1. Close FirstOffice using the ‘Quit’ command on the File menu.

2. Delete the “1Office.HDB” file.

3. Locate the “DBDef.txt” file and move it to the folder or directory
containing the FirstOffice application. Also, ensure that the ‘Default.txt’
file is present.

4. Launch FirstOffice again and follow the procedure described in the
‘Creating a New Database - Single User’ section above on page 36.

If you decide to proceed with the empty database, follow these steps—

1. Ensure the “Default.txt” file is present in the same folder or directory as
the FirstOffice application and enter at least one Company to the
‘Companies: Update’ window. This window is described in the section
entitled ‘Creating a New Company’ above on page 37. Click the [Save]
button to save.

2. On closing this window, the ‘Select Company’ window will open.
Double-click the Company that you wish to work with.

3. The System and User Settings modules will be the only modules
available. The next step should be to remedy this. Click the [Select
Module] button in the Master Control panel, double-click ‘System’ in the
subsequent list and select ‘Imports’ from the File menu. Double-click
‘Automatic, manual file search’ in the subsequent list. Locate the
“DBDef.txt” file and import it. You will now have access to all modules.

4. Return to the ‘Creating a New Database’ section above and resume the
process at the ‘Settings’ sub-heading.

Setting up a Basic Accounts System
FirstOffice is supplied with a basic accounts template that you can use as a
basis for your own system if necessary. It includes VAT Codes, a Chart of
Accounts, report definitions and so on.
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If you did not import this template when creating your database (as described
in the ‘Creating a New Database - Single User’ section above on page 36),
you can do so at any time. To import this template, ensure you are in the
System module using the [Select Module] button in the Master Control panel
and select ‘Imports’ from the File menu. The ‘Imports’ window is shown—

Double-click ‘Automatic’, or click once and press the Enter key. FirstOffice
opens a window listing importable files in the “Backup” and “Setup” folders,
which are in the same folder as the FirstOffice application. Locate
“UKAccs1.txt” and click [Open] or [Select] (depending on the operating
system).

The file will be imported. A message window informs you about the progress
of the import.

When the import is finished, repeat the process, selecting “UKForms.TXT”
and then “FOUKStd.TXT” to import template forms and other settings. Then,
close the ‘Imports’ list window using the close box.

Your FirstOffice database is now ready to be used. You are free to change
any aspect of the model Chart of Accounts, but note that some of the default
settings in FirstOffice presume that the model chart is being used in an
unmodified form. If you alter the chart, you must also alter these defaults
wherever they occur. For example, if you change the Account Code of the
VAT Outputs Payable Account, remember to alter all the VAT Code records
accordingly as well.

If you do not wish to use the template supplied
You are also free to implement your own accounting set-up. If you choose to
do this, please first refer to Chapter 3, ‘Accounting Principles’, on page 150
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where some basic accounting principles are outlined. Then, referring to the
appropriate chapters in this manual, you will need to set up VAT Codes in the
Nominal Ledger (covered in Volume 2) before creating your Chart of
Accounts in the System module (page 341 below). Referring to the chapters
in Volumes 2 and 3 describing the Sales and Purchase Ledgers and the Stock
module, ensure the correct Accounts have been defined for use by various
functions using the Account Usage S/L, Account Usage P/L and Account
Usage Stock settings. You should also check the Item Groups and Payment
Modes settings. Finally, referring to the ‘Nominal Ledger’ chapter in Volume
2 of these manuals, define the Balance Sheet, the Key Financial Ratios report,
the Profit & Loss Report and the VAT Report.

Importing your own Chart of Accounts

If you are changing to FirstOffice from another computerised accounts
program, you may be able to import the accounts set-up from that program.
This will have three advantages: the import procedure is relatively fast
(compared to entering the accounts manually), the possibility of data entry
errors is reduced and you will be able to use a Chart of Accounts with which
you are already familiar.

If you wish to follow this procedure, please follow the import instructions
described above on page 54 in the section ‘Setting up a Basic Accounts
System’ to import your text file. For details of the composition of the text
file, please refer to your FirstOffice representative.

Entering Data and Opening Balances
Your FirstOffice database is now ready for the entry of data and of opening
balances. Please refer to the chapter entitled ‘Starting Work’ (page 200) for
full details of how to proceed. Before you do so, however, it is recommended
that you read the following sections of this chapter. ‘Work Area’ (page 76)
will enable you to familiarise yourself with FirstOffice’s tools, windows and
method of working, while ‘Accounting Principles’ (page 150) describes some
of the accounting concepts used by FirstOffice.

Creating a New Database - Multi-user

Server with Graphical Interface (Windows and Macintosh OS 9)
To create a new, multi-user, database, essentially the same steps as those
described above need be followed. Working on the server, simply ensure that
there is no database file with the name “1Office.HDB” in the same folder as
the FirstOffice application, and launch the application by double-clicking.
However, make sure that the “DBDef.txt” and “Default.txt” files are present.
A new database is created.
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As in a single-user system, you will need to create a Company as the next
step. To do this, use the Company register as described in the section entitled
‘Creating a New Company’ above on page 37. Make sure that the
“Default.txt” file is present if you are creating new Companies. Again, at this
stage you can leave the TCP/IP and Port fields empty. Create as many
Companies as necessary up to a maximum of four.

When the entry is complete, click the [Save] button. Again, as with the
single-user system, the next stage is to inform FirstOffice which Company
you wish to use. The ‘Companies’ list will appear: highlight the single
Company and press the Enter key.

Server with no Graphical Interface (Linux and Macintosh OS X)
To create a new database on a server that does not have a graphical interface,
first ensure that there is no database file with the name “1Office.HDB” in the
same folder as the FirstOffice application, and that the “DBDef.txt” and
“Default.txt” files are present. Then, put the server into “Terminal” mode as
described in the ‘Linux and Macintosh OS X Server Installation’ above on
page 30.

When the Terminal window opens, and assuming you have retained the
default directory structure, type—

cd /Applications/FirstOffice/1OfficeProAdv43Serv (Linux), or
cd /Applications/FirstOffice/1OfficePro43ServOSX (OS X)

./1office-server backup/TBXXXXXX.txt & (Linux), or

./1office-macosx backup/TBXXXXXX.txt & (OS X)
Starts the FirstOffice server application
and imports the back-up or example
data file TBXXXXXX.txt. In this
example, this file is in the “backup”
folder inside the folder containing the
FirstOffice server application.

The progress of the import will be shown in the Terminal window. When it
has finished, FirstOffice will quit. Restart it by typing—

./1office-server & (Linux), or

./1office-macosx & (OS X)
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If you do not want a back-up or example data file to be imported to the new
database, you need to ensure a Server Port (see below) will be open in the
new database so that clients will be able to log in. You can do this using one
of two methods—

1. Before starting the FirstOffice application, ensure the “DBDef.txt”
contains an instruction to set the Server Port to the required value. The
“DBDef.txt” file supplied with FirstOffice will set the Server Port to
1200. If you are using this method, you may need to start FirstOffice,
quit and restart to activate the port, thus enabling users to log on.

2. By typing the following command in to the Terminal—

./1office-server --port 1200 & (Linux), or

./1office-macosx --port 1200 & (OS X)

This starts the FirstOffice server application and sets the Server Port to
1200, for a single work session only. If you want to set it to 1200
permanently, do so from a client using the Program Mode register as
described below (or use method 1 above).

Since the server does not have a graphical interface, you will need to
configure the new database from a client. Refer to the section entitled
‘Logging on from a Client’ below on page 61 and follow its instructions to
log in to the server from a single client. Use the Port number that you
specified in the final command above. Working on that client machine, first
go to the System module and create a record in the Access Groups setting
explicitly granting full access to the Technics module. Then, create a record
in the Person register for yourself, assigning it to the Access Group you have
just created. Access Groups and Persons are described in full on pages 307
and 337 respectively in the ‘System Module’ chapter later in this manual.
Then, quit FirstOffice and restart. You should now follow the instructions in
the section immediately below (‘Setting up the Server module’) to configure
the new database.

Setting up the Server module
Please refer to the section entitled ‘The Enabler Key’ above on page 47 for
details about the various methods you can use to obtain an Enabler Key. If
you will obtain it through the www.hansaworld.com website or by telephone
or fax, you must first make all purchased Value Packs available on the server
machine. You should also register the number of users there. Even if you are
using the automatic internet method, you should register your Server
Hardware and Server OS and numbers of Mailboxes and Conferences. Use
the [Select Module] button in the Master Control panel to change to the
System module. Next, use the ‘Settings’ function on the File menu to bring

http://www.hansaworld.com
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up the ‘Settings’ list window. Select ‘Configuration’ by double-clicking (or
by clicking once and pressing the Enter key). The ‘Configuration: Inspect’
window appears.

Select the Server module by clicking the check box so that a tick appears.
Click the check boxes for the Value Packs you have purchased. Ensure that
the numbers of Users, Mailboxes, Conferences and Companies are all correct.
Click the [Save] button in the Button Bar to save and close. Mailboxes and
Conferences require the CRM and Mail Value Pack to be present and are
described in Volume 4 of these manuals.

You should now enter your company’s name, address and other details using
the Company Info setting. This task is fully described in the section entitled
‘Changing the Company Name’ above on page 41. If you need to create
additional Companies, you should do so now, following the instructions in
the ‘Changing and Adding Companies’ section above on page 46. You
should check the Company Info and Configuration settings for each
Company before the next stage: the application for an Enabler Key. Full
details of this step can be found in the section entitled ‘The Enabler Key’
above on page 47.

Once you have finished this process, it doesn't matter which Company you
end up in: all will be available to any client machines logging in.

Specify the number of users, set up
your Companies and define the
Configuration and Company Info
settings in each one before applying
for an Enabler Key.

If the server does not have a graphical interface, you will have carried out the
work described in this section from a client machine. If you need to create
additional Companies, you should change to “Admin Client” mode. To do
this, go to the Technics module using the Modules menu and open the
Program Mode register. Choose ‘Admin Client’ from the Operations menu. If
you are not in “Admin Client” mode, the new Companies will be saved on
your machine and not on the server. As described in the ‘Changing and
Adding Companies’ section on page 46, the server will shut down after any
changes or additions have been made in the Company register. So you will
need to close the client, restart the server and then restart the client after
adding Companies on the server.

!
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The Program Mode Register
The next stage is to make this database available to the network. Use the
[Select Module] button in the Master Control panel to change to the Technics
module. Click the [Program Mode] button in the Master Control panel.

Complete the fields in this window as follows—

Program Name If you are using FirstOffice under Windows, you can
specify the name of the window in which FirstOffice
appears and of the application’s button in the Taskbar
(Windows 98SE/2000/XP). Enter that name here.

Default Company If you would like a particular Company to be used by
default when you launch FirstOffice, specify that
Company here. The next time FirstOffice is used, the
Company specified here will be opened automatically
and the ‘Select Company’ window will not appear.

You can use this field in a single-user system to ensure
you always go into a particular Company when you
launch FirstOffice. This is the only field in this register
that you can use in a single-user system.

Server Port This field is for TCP/IP communication with FirstOffice
clients. Enter an arbitrary four-digit code to identify this
database. If you have more than one server machine
running FirstOffice, or more than one copy of
FirstOffice running different databases on the same
machine, each must feature a unique Server Port code.

If you change the Server Port or put one in for the first
time, you must quit FirstOffice and restart for the change
to take effect.

Server at Startup Switch this check box so that the Server module will be
selected by default when you launch FirstOffice.
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Usually, it will not be necessary to use this check box.
When the time comes to shut down the server, two
options are available on the File menu. If you choose
‘Quit’, FirstOffice will automatically go into server
mode the next time it is used, even if the Server at
Startup is not checked. If you choose ‘Quit, Remove
Autoserver’, it will not, allowing you to work on the
server machine itself.

Once complete, click the [Save] button in the Button Bar to save. If you have
entered a Server Port number for the first time (or changed the one that was
already there), quit FirstOffice and restart to allow the change to take effect.

Complete the Program Mode screen
before applying for an Enabler Key.

The final task is to select ‘Server’ using the [Select Module] button in the
Master Control panel. The ‘Server Status’ screen appears. This signifies that
you are in the Server module and can be used to monitor network activity.

The server can now be left alone.

Logging on from a Client
You should now create a new database on each client. Its sole task will be to
enable you to log on to the server: almost no information will be saved on the
client machines. Again, follow essentially the same steps as those described
previously in this chapter. Ensure that there is no database file with the name
“1Office.HDB” in the same folder as the FirstOffice application, and launch
the application by double-clicking. However, make sure that the “DBDef.txt”
and “Default.txt” files are present. A new database with the name
“1Office.HDB” will be created.

Once again, the first task is to ensure the correct Companies have been
entered. To do this, use the Company register as described in the section
entitled ‘Creating a New Company’ above on page 37. Make sure that the
“Default.txt” file is present if you need to create new Companies. All that it is
necessary to do here is to enter once again the Companies that you have
previously entered to the database on the server. This will enable you to log
in to them.

In the Code field (the left-hand field of the grid), enter the same Code(s) that
you entered on the server. The TCP/IP and Port fields now become relevant.
In the TCP/IP field, enter the TCP address of the server machine. This can be
obtained from the TCP/IP control software on the server and is used to enable
the client copy of FirstOffice to locate the correct server on the network. In

!
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the Port field, enter the value that you entered to the Server Port field on the
Program Mode screen on the server. This is used to enable the client
FirstOffice to locate the correct copy of FirstOffice on the server.  If the
server does not have a graphical interface, use the Port Number that you
typed as part of the command to start the server application.

When you have entered all relevant Companies, click [Save].

The ‘Companies’ list will now appear allowing you to inform FirstOffice
which Company you wish to use. Double-click the appropriate Company in
the list, or highlight it and press the Enter key.  If the result is that FirstOffice
displays an error message “User Limit on Server reached” and you are certain
this is not the case, the probable cause is that the Company Code of the
chosen Company (in the first column of the Company register) does not
match that of any of the Companies that were entered on the server.

In typical multi-user installations, the next task will be to enter details of each
member of your staff that will be using FirstOffice. You might wish to limit
each person to areas of FirstOffice relevant to their job and to give each one a
password, to prevent unauthorised access. To do this, you will be using the
Person register in the System module: please refer to the ‘System Module’
chapter below on page 337 for full details.

Once you have completed this task, please refer back to the section entitled
‘Setting up a Basic Accounts System’ above on page 54 for details covering
the setting up of a basic accounts system. It is recommended that you carry
out this set-up work either from a single client machine or from the server
itself. Until you have finished, no other users should be allowed to log on.

Shutting Down

Remember to make a back-up before shutting FirstOffice down. Back-ups are
described below on page 64.

Single-user
To shut FirstOffice down, select ‘Quit’ from the File menu. Macintosh OS X
users can find the ‘Quit’ command on the Hansa OS X menu. The keyboard
shortcut Alt-F4 (Windows and Linux) or -Q (Macintosh OS 9 and OS X)
can be used. All open windows will be closed, and you will be asked if you
want to keep any changes that have not yet been changed.

Multi-user
You can close FirstOffice clients in the same way as FirstOffice single-user:
by selecting ‘Quit’ from the File or Hansa OS X menu.
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You can shut the server down using one of two methods, if it has a graphical
interface—

1. If you use ‘Quit’ on the File menu, the server will automatically enter
server mode the next time you start it up.

2. If you use ‘Quit, Remove Autoserver’ on the File menu, the server will
not go into enter server mode the next time you start it up. You should
use this option if you want to do some work on the server.

If the server does not have a graphical interface and if you are not running the
server process in the background, bring the Terminal window to the front and
press the Ctrl-C key combination. Alternatively, open a new Terminal
window and type the following—

ps This displays the process IDs for each
Terminal process

kill pid (where pid is the process ID for the
server process)

If you are running the server process in the background, use the ps and kill
commands either in the relevant Terminal window or in a new one.
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Backing Up
When the day’s work with FirstOffice is done, we advise you to make a back-
up. It is a good idea to save a copy of the file and store it in a safe place. It
might seem unnecessary to make a back-up every day, but the short time this
takes is a good investment for the day something goes wrong with the hard
disk.

To back up your data is particularly important when, as in the case of a
FirstOffice database, the financial information of your company is involved.
If you should lose all your data, you will find yourself in a very awkward
situation, missing all invoices, receipts, reports etc. Make sure you make a
back-up each time you have been working with your accounts. Name your
copies systematically with dates so that you can easily restore the database,
should an accident occur.

If you get a virus on your computer, you must first try to establish the date
when your computer was infected. In this case you must restore your data
from a back-up created before the infection date. Otherwise you run the
obvious risk of re-infecting the computer again.

FirstOffice’s method of back-up is fast and economical. The data is saved as
a back-up file that takes up a minimal amount of space, and the back-up files
are independent of the program versions. Of course, it is also possible to copy
the database file as it appears on your hard disk, but this is not so economical
in terms of disk space, and a subsequent restoration may not be successful if
the version of your FirstOffice application has changed since the back-up was
made.

Use FirstOffice’s built-in text back-
up feature to guarantee a successful
restoration.

To create a back-up, follow these steps—

1. In a single-user system, click the [Backup] button in the Master Control
panel.

!
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The resulting back-up file will contain the data from the whole database;
clicking this button is a short cut to the ‘Database Text Backup’ function
described in step 2 below. If you want to back up a section of the
database, or have a multi-user installation of FirstOffice, follow step 2
below.

2. Use the [Select Module] button in the Master Control panel to go into the
System module and choose ‘Exports’ from the File menu. The Exports
window is shown—

Double-click ‘Company Text Backup’ (if you wish to back up the data in
the database relating to the single Company currently selected) or
‘Database Text Backup’ (if you wish to back up the whole database).

Usually you should use the ‘Database Text Back-up’ option, as this is the
only choice that backs up the entire database. You must use it regularly
for your safety and peace of mind. Some registers and settings (e.g. the
Configuration setting, Mailboxes and Conferences) are stored at database
level, not Company level. These will not be exported by the ‘Company
Text Back-up’ option, even if your database only contains a single
Company. The ‘Company Text Back-up’ option is intended for use in the
situation where you need to move all the information relating to a
specific Company from one database to another.

In a multi-user system, you cannot use the ‘Database Text Back-up’
option (and the [Backup] button in the Master Control panel) on a client
machine. You can only use it on the server machine, when no other user
is logged in. First, select ‘Quit, Remove Autoserver’ from the File menu
and restart FirstOffice. Then, choose the System module using the
[Select Module] button in the Master Control panel. If it is not
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convenient to work from the server, use the automatic timed back-up
feature described below on page 67.

If the server does not have a graphical interface, you can use the
automatic timed back-up feature, or you can create a back-up file by
typing into the Terminal—

./1office-server --backup (Linux)

./1office-macosx --backup (OS X)

This will launch the FirstOffice server application, which will then create
a back-up file and then quit.

3. Whether you followed step 1 or step 2 above, the ‘Specify Text Backup’
window appears. This offers you 40 characters with which to describe
the back-up file that you are about to create. If it becomes necessary to
restore from a back-up, this description will be shown in the list of
importable files to help you select the correct one.

Enter an appropriate description and click [Run].

4. If you have chosen to back up the whole database and you have more
than one Company, you will now be asked to log in to any that you have
not yet used in this work session. For reasons of security, if you are not
able to log in to all Companies, the back-up procedure will be halted.

5. FirstOffice opens a dialogue where you can name and place the export
file. Enter the name of the file in the filename area and locate it in the
appropriate directory in the usual way. The name of the back-up should
include the date the back-up was made. For ease of importing later, it is
recommended that you do not include spaces or other non-alphabetic
characters in the name of your back-up file, and that you give it a .txt
extension. Then, click [Save].

It is recommended that you save the back-up file in a folder or directory
named “Backup” which should be in the same folder or directory as the
FirstOffice application. All text back-up files in this folder will be shown
in a list of importable files if it becomes necessary to restore from a
back-up.
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A message window informs you about the progress of the export.

When the export is finished, you are brought back to the ‘Exports’ list. Close
it using the close box.

Under no circumstances should you
edit or change a text back-up file with
another program.

Automatic Timed Back-ups
The importance of establishing a regular routine for backing up cannot be
emphasised enough. Because FirstOffice works - like all financial systems -
with a single file database in which all your data about customers, invoices,
nominal ledger etc. is stored, if you lose that file, you have lost not just a
single document, but all your accounting and customer information.

To make this task easier, FirstOffice contains a timed back-up feature
whereby a database back-up file can be created automatically every day. To
specify when the back-up files are to be created, and where they are to be
stored, follow the steps outlined below.

1. Select ‘Technics’ using the [Select Module] button in the Master Control
panel. In multi-user systems, you can do this on the server machine,
when no other user is logged in. To gain access to the [Select Module]
button, select ‘Quit, Remove Autoserver’ from the File menu and restart
FirstOffice.

If it is inconvenient to work on the server (e.g. it does not have a
graphical interface, or it is in another building), you can work from a
client machine. Log in as a Person that has access to the Technics
module (this is described in the section describing the Access Groups
setting on page 307 in the ‘System Module’ chapter later in this
Volume).

If ‘Technics’ is not available in the list of modules in a single-user
system, this will probably be because you have not granted yourself
access to the Server module in the Configuration setting.

!
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2. Choose ‘Settings’ from the File menu. Double-click ‘Timed Operations’.
The following window appears—

3. Set the Operation Time (the time when the backup is to take place) to the
appropriate time, when it is likely that no-one will be using FirstOffice.
Use the 24-hour clock, and place a colon (:)between the hour and the
minute. The back-up file will be created at the specified time, even if
there are still users logged in to FirstOffice. However, such users will
find the speed of operation to be much reduced while the back-up is
being carried out. It is therefore highly recommended that you specify a
time that is outside working hours, to minimise such inconvenience.

4. Specify the Database Backup Path, which determines where on your hard
disk the back-up files are to be saved. If you leave this field blank, the
back-up files will be saved in the folder containing the FirstOffice
application.

The following examples show the correct syntax for the Database
Backup Path. You can use either \ or / as a separator between folder
names under Windows, Linux and Mac OS X while you should use : on
Mac OS 9. Note that the separator appears as the final character in the
path.

It is recommended that you save the back-up file in a folder or directory
named “Backup” which should be in the same folder or directory as the
FirstOffice application. All back-up files in this folder will be shown in a
list of importable files if it becomes necessary to restore from a back-up.
Under Windows XP, Linux and Mac OS X, you can do this using a
relative path—

backup/
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Under Mac OS 9, you can only use an absolute path—

hard disk:firstoffice:backup:

If you want to store the back-up file somewhere else, use absolute paths
with the following syntax—

Windows c:/samplefolder1/samplefolder2/backup/

Mac OS 9 hard disk:samplefolder1:samplefolder2:backup:

Mac OS X /samplefolder1/samplefolder2/backup/

Note that if you make a mistake (for example, you make a syntax error or
specify a non-existent folder) there is a risk that the back-up file will not
be created.

5. Click the [Save] button in the Button Bar to save the back-up
specifications.

Once you have set up the timed back-up feature as described above, a new
back-up file will be created automatically every day at the same time. It will
be given the name “TBYYMMDD.TXT” where “YYMMDD” represents the
current date. The file will contain a back-up comment stating that it was
created by timed back-up and showing the date and time this occurred.

Restoring from a Back-up

To restore from a back-up, you must first create a new database. Then import
the back-up file using the ‘Imports’ function on the File menu in the System
module.

The replacement of a safety back-up is a non-destructive process, i.e. the
back-up file is not affected by the reading process. This means that you can
use the same back-up file more than once.

For reasons of speed, it is recommended that you carry out the process of
restoring from a back-up on the server machine in multi-user systems. If this
is not possible, use a single client machine. If you have separate back-up files
for different Companies, they should be imported individually. Attempting to
import them simultaneously using different client machines could result in
data being lost.

Restoring from a back-up is done in the following way—

1. Move the old database (named “1Office.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.
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2. Delete the database file “1Office.HDB” from the folder or directory with
your FirstOffice application. Double-clicking the FirstOffice application
now will force it to create a new database, as described earlier in this
chapter.

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

     The “DBDef.txt” and “Default.txt” files should always be present in the
same directory/folder as the FirstOffice application.    They contain some
important data used when setting up the new database and creating new
Companies. If this file is missing, your FirstOffice application may not
work the way you expect it to do!

3. As part of the process of creating a new database, a list of text back-up
files is shown. To be included in this list, a text back-up file must be
stored in the “Backup” or “Setup” folder or directory, which should be in
the same folder or directory as the FirstOffice application.

In the list, the filename of each text back-up file is shown together with
the date it was saved and any description added when it was created (in
the ‘Specify Text Backup’ window).

4. Highlight the file you want to import (the back-up to which you wish to
revert) and press the Enter key (or double-click on the name of the file).
The back-up data will be imported. A message window informs you
about the progress of the import. For reasons of security, FirstOffice will
close when the import finishes if the back-up file contains at least one

!
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record in the Person register. Restart the program: you are now ready to
continue working.

Files whose name contains a space will be shown in the list of back-up files
available, but FirstOffice will not be able to import them successfully. If the
name of your back-up file contains a space or any other non-alphabetic
character (or it is not shown in the list of available files because it is not
stored in the “Backup” or “Setup” folder or directory, or because its name
does not have a .txt extension), continue with these steps—

5. If it is still open, close the list of available import files using the close
box.

6. In the System module, choose ‘Imports’ from the File menu. The
‘Imports’ window is shown—

7. Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).

FirstOffice opens a standard dialogue box with a list of the files in the
current folder of the current volume. To find the back-up file, scroll
through the list or select another folder or volume in the normal way.
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8. Once you have found the file you want to import (the back-up to which
you wish to revert) and click [Open] or [Select] (depending on the
operating system), or double-click on the name of the file.

A message window informs you about the progress of the import.

When the import has finished, FirstOffice will close, for reasons of security if
the back-up file contains at least one record in the Person register. Restart the
program: you are now ready to continue working.

Updating from Previous Versions of FirstOffice

The latest version of FirstOffice is always available at www.hansaworld.com,
from where updates should be obtained. If you are online, clicking the
[HansaWorld.com] button in the Master Control panel will take you to this
site.

Inevitably, new versions of FirstOffice will incorporate significant structural
changes. Because of this, it cannot be guaranteed that they will be able to
open databases created by previous versions unless you use the export and
import functions.

To update, follow these steps—

1. Before installing the new version, create a text back-up as usual and as
described above on page 64 using the old application.

http://www.hansaworld.com,
http://www.HansaWorld.com 
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2. Download the new version of FirstOffice in a new folder or directory.

3. Ensure that the new folder or directory contains the “DBDef.txt” and
“Default.txt” files, but not a “1Office.HDB” file. Ensure it also contains
a folder or directory named “Backup” which in turn contains the back-up
file created in step 1, and that the name of this file has a .txt extension
and does not contain any spaces or other non-alphabetic characters.

4. Copy the “Attach” and “Tmp” folders and their contents from the old
FirstOffice folder to the new one. You may not have all of these folders
in your installation: if so, copy the ones that you do have and don’t worry
about those that are missing. Do NOT copy the “Hob” folder.

5. Launch the new FirstOffice application. A new database is created.

6. Import the back-up created by the previous version of FirstOffice using
the procedure described above on page 69 in the section entitled
‘Restoring from a Back-up’.

For reasons of speed, it is recommended that you back up, restore and
update on the server machine in multi-user systems. If this is not
possible, use a single client machine. If you have separate back-up files
for different Companies, they should be imported individually.
Attempting to import them simultaneously using different client
machines could result in data being lost.

7. In multi-user systems, you should now install the new FirstOffice
application on all client machines. Repeat steps 2, 3, 4 and 5 above on
each machine. If you have any Client Text Backup files, import them to
the new databases on the relevant machines as per step 6 above.
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Chapter 2: Work Area
When you create a database or open an existing one, FirstOffice’s desktop
will appear, with the Master Control panel in the centre of the screen. You
can use the icons in this panel as shortcuts to different parts of the program.

You can carry out most operations in FirstOffice in three different ways—

• Selecting an option from a menu

• Clicking a button in the Master Control panel

• With a keyboard command

Use the method you feel most comfortable with. In the beginning you may
find it easiest to select from menus or from the Master Control panel, but
when you get more used to the program, you will find the keyboard
commands faster to work with.
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The Master Control Panel
FirstOffice’s work area contains a single movable, tool palette, the Master
Control panel, located by default in the centre of the screen. This contains the
Personal Desktop and four rows of buttons. The buttons in the first two rows
(entitled ‘Personal’ and ‘Company’) mostly control functions that cannot be
operated in any other way. Those in the third row (entitled ‘Routines’)
duplicate some of the functions on the File menu, while those in the fourth
row (entitled ‘Registers’) can also be activated at all times using the keyboard
shortcuts Ctrl-1-5 (Windows and Linux) or  -1-5 (Macintosh). These
registers vary with the selected module. Since the Master Control panel is
always visible, it is often simpler to use the buttons it contains than to select
functions from the menus.

You can bring the Master Control panel to the front at any time using the
‘Master Control’ item on the File menu. Windows and Linux users can use
the keyboard shortcut Ctrl-M, while Macintosh users can use -M. To close
the Master Control panel, click the close box or use the keyboard shortcuts
Ctrl-F4/-W.
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The panel contains four rows of buttons—

Personal These buttons allow you to communicate with other
users of your FirstOffice system and to organise your
diary. This provides a means of recording appointments
and other tasks. Some of these buttons have a keyboard
shortcut, as shown below, which you can use when the
Master Control panel is the active (front) window.

[Companies] Windows/Linux keyboard shortcut: Ctrl-O
Macintosh keyboard shortcut: -O

If you have more than one Company in your
database, use this button to move between
Companies. For more information about using a
multi-Company database, refer to the ‘Working
with Companies’ section below on page 125.

[Calendar] Click this button to open the Calendar: a graphic
representation of your completed Activities and
those of other users. Full details can be found in
Volume 3 of these manuals.

[Tasks] This button allows you to organise your diary,
providing a means of recording appointments and
other tasks. Full details can be found in Volume 3
of these manuals.

[Backup] In a single-user system, you can use this button to
back up your entire database. Please refer to page
64 above for details about backing up.

Company These buttons provide more tools to help you
communicate with other users of your FirstOffice
system. Some of these buttons have a keyboard shortcut,
as shown below, which you can use when the Master
Control panel is the active (front) window.

[Select Module] Windows/Linux keyboard shortcut: Ctrl-0
Macintosh keyboard shortcut: -0

Click this button if you need to work in a
different module or area of the program (e.g.
when you want to change from the Nominal
Ledger to the Sales Ledger). Each time you
change module, the Register buttons in the lower
part of the Master Control panel will be changed
to show the Registers in the new module.
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[Mailbox] Windows/Linux keyboard shortcut: Ctrl-Shift-M
Macintosh keyboard shortcut: -Shift-M

If you are using FirstOffice’s Mail facilities, click
this button to open your Mailbox. From here, you
can send mail to other users in your FirstOffice
system and read mail that has been sent to you.
Your Mailbox is also used to send and receive
external mail (i.e. to communicate with people
outside your FirstOffice system who use standard
email programs). Mailboxes require you to have
the CRM and Mail Value Pack and are described
in Volume 4 of these manuals.

[Conferences] If you are using FirstOffice’s Mail facilities,
Conferences are addresses to which mail can be
sent from where it can be read by all users
(subject to access restrictions). Click this button
to open a window showing the available
Conferences. These require you to have the CRM
and Mail Value Pack and are described in
Volume 4 of these manuals.

[Chat] Click this button to produce a list of users
currently logged in to your FirstOffice system.
Only those users that have Mailboxes will be
listed. Click on a user’s initials to chat with that
person.

Routines These buttons are equivalent to some of the commands
on the File menu. In each case, clicking the button
produces a list of options from which the required one
can be selected by double-clicking. These options will
vary depending on the current module. Each of these
buttons has a keyboard shortcut, as shown below, which
you can use at any time.

[Reports] Windows/Linux keyboard shortcut: Ctrl-R
Macintosh keyboard shortcut: -R

Click this button to produce reports. You can
define some of the reports and choose where they
are to be printed (e.g. to screen, to a printer or to a
text file). General details about producing reports
can be found in the ‘Report Window’ and the
‘File Menu’ sections later in this chapter (pages
94 and 108 respectively), while the reports
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themselves are described in detail in the chapters
covering the individual modules.

[Documents] Windows/Linux keyboard shortcut: Ctrl-D
Macintosh keyboard shortcut: -D

Use this button when you want to print
documents intended for external use (e.g.
Invoices or Sales Orders). Details about printing
documents can be found in the ‘File Menu’
section below on page 112, while the documents
themselves are described individually in the
appropriate chapter.

[Exports] Windows/Linux keyboard shortcut: Ctrl-E
Macintosh keyboard shortcut: -E

This is the button you use when you need to back
up your FirstOffice database and to export data
from FirstOffice. Exports are described
individually in the appropriate chapter, and
details about backing up can be found on page 64
in the previous chapter.

[Settings] Windows/Linux keyboard shortcut: Ctrl-S
Macintosh keyboard shortcut: -S

Settings allow you to set operating preferences
within FirstOffice, to tailor its operations to your
requirements. The settings available vary with the
different modules. Before you start working with
each module, you should consider its settings,
since its functions depend on the settings being
correct. Many settings take the form of options or
preferences. Others require information or a
number of records to be entered. Click the button
to open the ‘Settings’ list window where you will
find an alphabetical list of the settings that are
available in the current module. Double-click an
item in this list to add to or change a particular
setting. Settings are described individually in the
appropriate chapter.

Registers These buttons vary according to the current module: one
is provided for each register in that module. Separate
registers are used for the different types of information
stored in and used by the module. Click on a register
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button to open the browse window for the register. This
window lists all the records contained in the register.
Each register is explained in separate sections
throughout these manuals.

HansaWorld.com

In the top right-hand corner of the Master Control panel there is a
[HansaWorld.com] button—

Click this button to connect to the web and go the FirstOffice website
(www.hansaworld.com). The latest version of FirstOffice is always available
for downloading from this site.

Personal Desktop

The area on the right of the Master Control panel is known as the “Personal
Desktop”. If you have certain records, registers, reports or Maintenance
functions that you use all the time, you can move them to your Personal
Desktop for easy access. You can open a record or register or run a report or
Maintenance function from your Master Control panel at any time, without
first having to find them in their proper place in FirstOffice. The Personal
Desktop is therefore similar to a list of Bookmarks in a browser.

Please refer to the section describing the Personal Desktop below on page
137 for full details.

Passwords

You can set or change your password from the Master Control panel,
providing that a record for you already exists in the Person register (the
Person register is described on page 337 in the ‘System Module’ chapter later
in this manual). Select ‘Change Password’ from the Operations menu. Enter
the old password if there is one and then type in the new one twice to ensure
that it is correct. Click [Save] to close the window and save, or [Cancel] if
you do not want to save changes. The password is case-sensitive.

http://www.HansaWorld.com
http://www.HansaWorld.com 
http://www.hansaworld.com).
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Windows
FirstOffice allows you to work with several windows on the screen at the
same time. The window that is currently in use is known as the ‘active
window’. That is the uppermost window, where the title bar is not dimmed.

In the Windows version you can “Iconise” a window, i.e. shrink it to an icon
on the screen, using the  button in its top right hand corner. You can re-
open the window by clicking the button again.

You can move the active window by dragging the title bar, and change its
size by dragging the size box in the bottom right-hand corner. Close the
window by clicking the close box or by pressing the Esc key on your
keyboard. On the Macintosh, clicking the close box of a window while
holding down the Alt key will close all windows, while Windows and Linux
users can use the ‘Close All’ function on the Window menu. In addition, you
can save attributes such as size, sort order and position for a particular
window using the Window menu. If you have several windows open, you
can bring each one to the front in turn using the Ctrl-Tab or -Shift-N
keyboard shortcuts.

FirstOffice allows you to have up to
100 windows open at the same time.
It is however a good habit to close a
window when it is no longer needed.
Too many open windows may become
confusing.

There are six types of window.

Browse Window

Browse windows are used to display lists of records. Clicking a register
button in the Master Control panel will open a browse window listing every
record stored in that register. In a browse window, you can search for a
certain record and select a specific record for processing. You can have
several different browse windows open at any time.

For example, if you click the [Transactions] button in the Master Control
panel while working in the Nominal Ledger module (or use the Ctrl-1/-1
keyboard shortcut), the window that opens is a browse window, entitled

!
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‘Transactions: Browse’. This window lists all the Transactions in the
register—

You can scroll through the list using the scroll bar on the right. You can
scroll down or up a screen at a time by selecting ‘Next’ or ‘Previous’
respectively from the Record menu.

You can change the sort order of the list. Click the heading of the column
you want to sort by, and the list will re-sort immediately. The heading of the
column will be coloured blue to show the selected sort order. If you click on
the heading a second time, the sort order will be reversed.

At the top of each browse window there is an area known as the Button Bar.
This contains a set of buttons—

Operations This drop-down menu appears in certain browse
windows only. Highlight one or more records in the list
(hold down the Shift key while clicking) and then
choose a function from this menu. The function will be
applied to all highlighted records. The contents of the
Operations menu will vary depending on the browse
window. Full details of each function can be found in
the chapters covering each module elsewhere in this
manual.

[New] Windows/Linux keyboard shortcut: Ctrl-N
Macintosh keyboard shortcut: -N

Click this button to open a new blank record for data
entry.
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[Duplicate] Windows/Linux keyboard shortcut: Ctrl-K
Macintosh keyboard shortcut: -Y

If you need to create a new record that is a copy of one
that already exists, first find the earlier record in the list
and highlight it by clicking once. Then, click this button.
A new record is opened, a duplicate of that highlighted.
In many cases, the new record will contain the current
date, not the date of the copied record.

[Search] Use the Search field and button (on the right of the
Button Bar) to find a particular record in the list. First,
sort the list by the column that you want to use for the
search. In the illustration above, for example, the list is
sorted by Text allowing you to search for a Transaction
with a certain Number. Then, type a letter, word,
number, or date in the Search field (there is no need to
click in the field before typing). Then press Enter or
click [Search]. FirstOffice will search the column by
which the list is sorted for a match. The first row
beginning with an exact match (or, if there is no exact
match, with the nearest match) will be highlighted. If
you are not certain of the exact spelling, use the *
character as a wildcard. For example, in the illustration
shown above, to find Transactions relating to Mutual of
New York but do not know their Customer Number
(013), sort the list by the Text column, type “*Mutual”
in the Search field and press the Enter key. If the first
record found is not the one you want, press the Shift-
Enter key combination to search again.

If you want to view or modify an existing record, first find it using the
Search facility described above. Then, open it by double-clicking its line in
the window, or by first selecting the line and then pressing the Enter key.

It is not possible to delete a record
directly from the browse window.
You must open the record first.

Record Window

You will use record windows to enter, view and edit individual records. The
heading may read ‘New’, ‘Inspect’, ‘Update’ or ‘Deleting’, depending on the
circumstance. All data entry to FirstOffice is made in windows of this type.

!
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A record window is opened when you open a specific record from a browse
window by double-clicking, and when you create a new record. Below is the
window that is opened when you double-click a row in the ‘Invoices:
Browse’ window.

The record window is where you enter or edit information. Note that certain
fields will only accept numbers or uppercase letters, while others cannot be
changed at all. In some cases, all characters will be converted to uppercase
automatically.

Use the Return, Tab or arrow keys to move from field to field. The Return
key moves the cursor to the next editable field, while the arrow keys move to
the next field, whether it can be changed or not. You can also use the mouse
to click directly in a field to enter or change its data. When you click in a
field, its contents will be highlighted, and the contents will be replaced as
soon as you start typing. If you click twice in the same field, the insertion
point will be placed at the point where you click, allowing you to enter or
delete characters at that point.

Some record windows, such as that in the illustration, are divided into two
sections: the top half shows details of the parent record (in this case, an
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Invoice) and the lower half contains the individual items (or rows) that are
listed on that Invoice.

Sometimes a record window contains more information than can be shown
on screen at once. If this is the case, there will be a series of tabs (marked
‘Terms’, ‘Items’, etc in the example of the Invoice illustrated above) that you
can click to see more pages of information about the parent record. There
may also be a series of flips (marked ‘A’, ‘B’, ‘C’, etc) that you can click to
see more information for the rows.

Button Bar
At the top of each record window there is an area known as the Button Bar.
This contains a set of buttons—

 Windows/Linux keyboard shortcuts: PgUp and PgDn
Macintosh keyboard shortcuts: -- and -+

These are the [Previous Record] (on the left) and [Next
Record] buttons. Use them to go from record to record.
Once you have opened a record from a list in a browse
window, click the [Next Record] button to move to the
next record in that list. At the same time everything you
may have changed in the record you are leaving will be
saved. If you want to cancel the changes, close the
record window with the close box or press the [Cancel]
button on the right of the Button Bar. Similarly, clicking
the [Previous Record] button will open the previous
record in the list.   

These buttons have the same effect as selecting
‘Previous’ and ‘Next’ from the Record menu.

Operations In several record windows, such as those for Invoices
and Orders, there is an Operations drop-down menu
available. This contains different functions depending on
the window. For the Invoice record, the following menu
items are available—
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‘Item Status’ shows the stock position for the Item in the
current row on the Invoice, ‘Invoice Status’ opens a
window with a summary of the status of the invoice;
payments etc.

Full details of each function can be found in the chapters
covering each module elsewhere in this manual.

Windows/Linux keyboard shortcut: Ctrl-P
Macintosh keyboard shortcut: -P

Click this Printer icon to print the current record. The
Printer icon will only appear in the Button Bar when the
record window contains something that can be printed
directly, e.g. an Invoice or Purchase Order. The ‘Print’
command on the File menu has the same function.

When you start a printout, it will print directly on your
selected printer. Normally, no printer dialogue is shown.

 Windows/Linux keyboard shortcut: Ctrl-Shift-P
Macintosh keyboard shortcut: -Shift-P

Clicking the Preview icon will cause the current record
to be printed to screen in a new window. This will allow
you to see what it will look like when you print it on a
printer by clicking the Printer icon immediately to the
left.

If you are using Windows, in some record windows,
such as those for Invoices and Customers, there is a
[Communicate] button. If you need to contact the
company whose details you are viewing, click this
button. The window shown on the next page opens,
containing the company’s contact details.
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Subject to your computer or network having the suitable
connection software and hardware, click on a contact
method in the list on the left, and then click the
appropriate button on the right. The Skype application
will be started automatically, allowing you to call using
Skype or SkypeOut (if you clicked on a telephone
number). A new Activity window will also be opened,
allowing you to record the details of the call or contact
immediately.

[New] Windows/Linux keyboard shortcut: Ctrl-N
Macintosh keyboard shortcut: -N

Click this button to save the current record and to close
it. A new blank record is then opened for data entry.

[Duplicate] Windows/Linux keyboard shortcut: Ctrl-K
Macintosh keyboard shortcut: -Y

Click this button to save the current record and to create
a copy of it. The original record is closed and the new
copy is opened. In many cases, the new record will
contain the current date, not the date of the copied
record.

[Cancel] Macintosh keyboard shortcut: -B

If you have not saved the current record (i.e. the window
title is ‘New’), click this button to cancel the data entry
process and to close the record window. The record is
not saved. If you have previously saved the current
record (i.e. the window title is ‘Update’), click this



Chapter 2: Work Area - Windows - Record Window

89

button to discard all changes made since it was last
saved. In this case, the record window is not closed.

[Save] Windows/Linux keyboard shortcut: Shift-Enter
Macintosh keyboard shortcut: Shift-Enter

This button saves all changes to the current record but
does not close it.

Paste Special
When you enter information in FirstOffice, you frequently need to refer to
another register, or setting. For example, when you enter an Invoice,
specifying a Customer Number will bring information in from the Customer
register (e.g. the name and address of the Customer), while specifying a
Payment Term brings information in from the Payment Terms setting. Using
the ‘Paste Special’ command, you can find out the information you require
from a selection list quickly and easily (e.g. you can easily choose the correct
Customer or Payment Term). Pressing Ctrl-Return or Ctrl-Enter in a field
activates the ‘Paste Special’ feature. Macintosh users can press -Return or
-Enter. The following example shows pasting a Customer Number into an
Invoice—



HansaWorld FirstOffice Professional

90

With the cursor placed in the Customer field, press the Ctrl-Enter (Windows
and Linux) or -Enter (Macintosh) key combination. A new window will
open, showing the contents of the register or setting from which you can
select a record (in this case, the Customer register). This window is similar to
a browse window in its behaviour, so you can sort the list by any of the
columns by clicking the column heading and use the Search field to find the
record you are looking for (using the * wildcard if necessary).

Select the Customer you want by double-clicking or by highlighting and
pressing Enter. The Customer Number and other details are transferred to the
Invoice screen.

You can make the ‘Paste Special’ feature more powerful by saving the sort
order of the ‘Paste Special’ list. For example, whenever you need to choose a
Customer, you will probably know its Name but not its Number. The first
time you use the ‘Paste Special’ feature to choose a Customer, sort the list by
Name and then select ‘Save Normal Position’ (Windows and Linux)/‘Save’
(Macintosh) from the Window menu. From now on, the list will be sorted by
Name when it opens. Now you can type the first few characters of the
Customer Name in a Customer field and then press Ctrl-Enter or -Enter.
When the ‘Paste Special’ list opens, the highlighted Customer will be the
first one to match what was typed. If this is the correct one, all you need do is
press the Enter key and carry on typing without interruption. In the example
shown below, we typed “OSLO” into the Customer Number field of an
Invoice and then pressed Ctrl-Enter. The ‘Paste Special’ list opens, with the
first Customer whose name begins with “OSLO” highlighted—
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If the record you are looking for does not exist and so is not shown in the
‘Paste Special’ list, you can often enter it on the fly. In the ‘Paste Special’
window, press Ctrl-N or -N, or click the [New] or [Duplicate] buttons as
appropriate. A new Customer screen (in this example) is shown. Enter the
new Customer, click [Save] and the new record is entered. At the same time,
the Customer Number is entered in the Invoice.

If you are entering an Invoice and realise that your information about the
Customer is out of date (they might have changed their address or telephone
number, for example), highlight the Customer in the ‘Paste Special’ window
and press F2 (Windows and Linux) or -Shift-V (Macintosh). The Customer
record is opened, allowing you to make the necessary changes. You can also
do this if the Customer Number has already been entered to the Invoice. With
the cursor in the Customer Number field, press F2 or -Shift-V. This feature
is available from most fields with a ‘Paste Special’ link.

The availability to individual users of the F2/-Shift-V feature and of the
ability to create records on the fly can be controlled using the Access Groups
setting in the System module (described below on page 307).
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You can use ‘Paste Special’ when you are in a date field. When you press
Ctrl-Enter or -Enter, the ‘Paste Date’ window opens—

The current date is marked with a square. Press the Enter or Return key to
bring the current date into the date field. If you need a different date, use the
arrow keys to move the red square to the date you need—

The grey square marks the current date. Use the PgUp and PgDn keys to
change to a different month. Press Enter or Return to bring your chosen date
into the date field. If dashes appear instead of Week Numbers in the ‘Paste
Date’ window, the probable cause is that there is no record in the Weeks
setting in the System module, or the record that is there is incomplete. Please
refer to the description of the Weeks setting in the ‘System Module’ chapter
below on page 331 in this manual for details.

You can also use ‘Paste Special’ when you are in a time field. Simply press
Ctrl-Enter or -Enter and the current time will be entered straight away.

Drag and Drop
You can also link information in different registers or settings by dragging
and dropping. Information can be dragged from the browse window of one
register into the record window of another. For example, you can drag a
Customer Number from the ‘Customers: Browse’ or the ‘Paste Customer’
window into an Order or Invoice. With both the ‘Customers: Browse’ and
‘Invoice: New’ windows open, find the correct Customer in the list, click on
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the Customer Number and drag it to the Customer Number field of the
Invoice. Items and information from settings such as Payment Terms can be
added to Invoices, Orders and other transactions in the same manner. In the
case of Items, you can open the ‘Items: Browse’ or the ‘Paste Item’ window
and select a range of Items by clicking while holding down the Shift key.
Then drag them to the Item field in the first empty Invoice row.

In certain circumstances, it is also possible to create records by dragging and
dropping. For example, an Order can be dragged from the ‘Orders: Browse’
window to the ‘Deliveries: Browse’ window to create a Delivery for all the
`Items on the Order. Once that Delivery has been approved, the Order can
then be dragged from the ‘Orders: Browse’ window to the ‘Invoices:
Browse’ window to create an Invoice for all delivered Items.

You can also copy lists from spreadsheets or word processing documents.
For example, you can copy a list of Item Numbers from a spreadsheet and
paste them in the Item field in the first empty Invoice or Order row. All
appropriate Item Descriptions, Prices, etc will be brought it automatically.
Similarly you can copy a list of Invoice Numbers from a spreadsheet and
paste them in a Receipt or Payment.

If you have several Companies, you can transfer information from one
Company to another by dragging and dropping between browse windows.
For example, when you create a new Company, you can drag all the
Accounts from the ‘Accounts: Browse’ window of an existing Company to
that of the new Company. This makes it easy to transfer basic information to
the new Company. If you transfer approved accounting transactions of any
kind using this method, they will appear as unapproved transactions in the
new Company. An approved transaction is one from the Sales Ledger,
Purchase Ledger or Stock module that has been posted to the Nominal
Ledger.

Attachments
All record windows contain an [Attachments] button, which can take one of
two forms—

This button allows you to connect files, notes or other records to any record
in FirstOffice. These connected objects are known as “Attachments”. Please
refer to the section entitled ‘Attachments and Personal Desktop’ below on
page 129 for full details.
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Report Window

Report windows are used to display the reports you print to the screen.
Below we show an example of a report from the Nominal Ledger module.
You can scroll up and down in the window, and search for information in the
report.

Below the Button Bar there is a report header, which shows the name of the
report and the selection on which it is based. This is important information,
since every report can be produced using different selections.

Below this is the report itself, always shown to its full width in its own
window. You can change the window’s height and width, which may lead to
the report not fitting in the window. You can therefore scroll the window up
and down with the scroll bar to the right or using the Page Down, Page Up,
Home and End keys on the keyboard. If the window is too narrow, the report
is compressed sideways, which may make it hard to read. By increasing the
width of the window the report can be made to expand.
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Since each report is shown in its own window, several reports can be put on
the screen at the same time, totally independently. This gives FirstOffice an
unmatched reporting power. You can for example show two versions of a
Customer statement simultaneously, in two different windows. In one you
might show all open (unpaid) Invoices and restrict the other to show only
those Invoices that are due for payment (i.e. those that are older than their
payment terms). FirstOffice can easily give you information that can only be
obtained after some complicated manoeuvring in other accounting systems.

There is no limit to the number of reports that can be shown simultaneously
on the screen, and reports from the different modules may be mixed freely.
Since FirstOffice's windows are completely independent, report windows can
be mixed with data entry windows and lists from different parts of the
system.

In the following picture we show an example where four reports from the
Nominal Ledger and Sales Ledger are shown at the same time.
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Printouts
You can print any report to paper by clicking the Printer icon in the Button
Bar of the window containing the report. The page format is set in advance
for each report so that the report will fit in a portrait or landscape page.

Searching in Reports
Another useful function built in to all FirstOffice's reports when printed to
screen is the option to search for a text string in a report. The search string
may contain any combination of letters and digits occurring in the report.
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In this example you might want to search for the Nominal Ledger
Transaction resulting from Invoice 970017. Enter “970017” into the Search
field on the right of the Button Bar and press the Enter key. FirstOffice will
search for the first text string in the report that matches the search word,
scroll the report to the position where the text was found, and highlight the
text. Press the Enter key again to find the next match.

Recalculating Reports
All reports are shown in their own windows. You can leave a report on the
screen and go to other windows to do various additions and alterations. If
such alterations affect the contents of the report, there is a simple shortcut for
updating the report. With the report window active again - activate it by
clicking in it - the Operations menu is available in the menu bar. Select the
‘Recalculate’ command (or use the Ctrl-Shift-R/-Shift-R keyboard
shortcut) to produce an updated version of the report, using the same
specifications. If you want to produce an updated version of the report using
different specifications, select ‘Reopen Report Specification’ from the
Operations menu.
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Drill-down
FirstOffice has a unique drill-down feature in some reports when they are
printed to screen. For example, when you have a Profit & Loss statement on
the screen, you can click on any of the Account Numbers in the report. The
Nominal Ledger report for the same selection and period is then opened in a
separate window, showing all the Transactions that constitute the total
amount on the Profit & Loss statement. If you further click on one of the
Transaction numbers in the Nominal Ledger report, the Transaction record
will open, showing all the details recorded for the event. The following
picture shows the result of the above example.
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Text with the drill-down feature is shown underlined in a screen report.
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Attaching Reports to Records and the Personal Desktop
The Button Bar of the report window contains an [Attachments] button that
allows you to attach a report to a record or to the Personal Desktop. Please
refer to pages 133 and 142 respectively below for details.

List Window

The list window is used whenever you need to choose from a list of options,
usually after you select the ‘Imports’, ‘Settings’, ‘Maintenance’, ‘Reports’
and ‘Documents’ functions. Double-click your choice in the list, or click it
once with the mouse and then press the Enter key.

You can use the scroll bar to find the item that you want, or you can type the
first letter of its name. For example, referring to the example illustrated
below and assuming ‘Customer Status’ is the item you want, press the letter
“C” on your keyboard three times. After the first press, the highlight will
move down to the first item beginning with C, ‘Customer/Item Stats’. As you
press “C” on your keyboard again, the highlight will move down until
‘Customer List’ is highlighted. You can now press the Enter key to activate
the report.

When the list window shows a list of documents, it will be accompanied by
an Operations menu allowing you to assign a Form to each document (the
Form contains the design that will be printed). This is described below on
page 112.

The following example shows the list window from where you can choose a
report in the Sales Ledger module.
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Specification Window

Specification windows allow you to specify the contents of a report or
document, or how a Maintenance function is to operate. A specification
window will usually appear after you have selected an option in a list
window. Once you have entered the report criteria or specified how the
Maintenance function is to behave, click [Run]. The example below shows
the specification window for the Trial Balance report.
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File Dialogue Window

FirstOffice uses the standard Windows or Macintosh file dialogue window
when it requires you to select a file for import, or to give a file name to an
export file.
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Menus and Sub-menus

The Menu Bar

Select menus by pulling them down with the mouse in the normal way.
Where appropriate, keyboard shortcuts are shown to the right of the menu
items. Some commands are also available as icons in the Button Bar and
Master Control panel.

Not all menu items are available at all times. Disabled items are grey or
dimmed.

File Menu

The File menu contains commands for the handling of files, documents and
printouts. Instead of selecting an item from the menu, you can in some cases
click on the corresponding icon in the Master Control panel. The commands
on the File menu also all have a keyboard shortcut, shown to the right of each
command in the menu, e.g. Ctrl-P (Windows and Linux) or -P (Macintosh)
for ‘Print’. These shortcuts are shown in the illustrations above: the
Macintosh version is on the left, the Windows version on the right.
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Company
This command opens a list that allows you to select a Company to work with.
You will have entered the Companies listed in the window using the
Companies register in the System module.

Double-click a Company in the list, or click once and press the Enter key.

If you need to add a new Company to the list, select ‘Open Company
Register’ from the Operations menu while the list is open. Refer to the
‘Changing and Adding Companies’ section in the previous chapter (page 46)
for full details, but remember that adding a new Company will that mean you
will have to apply for a new Enabler Key. FirstOffice allows a maximum of
four Companies. For more information about using a multi-Company
database, refer to the ‘Working with Companies’ section below on page 125.

Master Control
This function brings the Master Control panel to the front. This will be
necessary if you wish to use FirstOffice’s Mail, Calendar and Task Manager
functions as the Master Control panel provides the only means of accessing
these.

Exports
Use this command to copy information from FirstOffice into a text file on
your hard disk. This data is then available for use in other programs, such as
word processors, spreadsheets, database programs etc. Selecting the
command is equivalent to pressing the [Exports] button in the Master Control
panel.

When you select this command, the ‘Exports’ list window is opened, where
you can choose the information to be exported by double-clicking. The
options available in the ‘Exports’ list vary according to the active module.
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One reason to use the ‘Exports’ function is to back up your FirstOffice
database. For full details of how to do this, please refer to the ‘Backing Up’
section in the ‘Introduction and Installation’ chapter (page 64). For security
reasons, the ‘Company Text Backup’ and ‘Database Text Backup’ exports do
not produce text files as mentioned above but encrypted files that can only be
read by another copy of FirstOffice.

Note that all FirstOffice reports can also be printed to disk as text files. This,
in combination with the ‘Exports’ function, makes it very easy to retrieve
information from FirstOffice for use with other applications.

Imports
This command imports a text file, previously saved in the proper format, into
the Company you are working with.

When you select this command, the ‘Imports’ list window is opened, where
you can specify what is to be imported. As with the ‘Exports’ list, the options
available in the ‘Imports’ list window vary according to the active module.

The function can import information from another FirstOffice database or
from a text file created by another computer program. In the latter instance,
you should ensure the text file is correctly formatted (contains the
information in the correct order) before importing. This format information is
available from your local FirstOffice representative, and can also be found in
the Export Format report in the System module.

The first lines in the text file should be—

format
1 46 1 0 1

The numbers in the second line should be separated by tabs. These numbers
(parameters) inform the import procedure about the contents of the import
file, as follows—

Date Order The first parameter tells the import procedure what date
format you have used in the text file. You can use the
following values—

0 Month/Day/Year

1 Day/Month/Year

2 Year/Month/Date
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Decimal Character

The second parameter uses ASCII codes to tell the
import procedure what decimal character you have used
in the text file. Typical values are—

44 comma

46 full stop

Machine Mode Use the third parameter to specify the platform on which
you created the text file, as follows—

0 Macintosh, AIX, iSeries

1 Windows, Linux

The import procedure will use this information for
string conversion if the last parameter (String Type) is
0.

Replace This parameter tells the import procedure what to do if
information in the text file duplicates what is already in
the database.

0 Any duplicate information in the text file will not
be imported. Records in the database will not be
replaced.

1 Duplicate information in the text file will be
imported, overwriting existing records in the
database. This applies to entire records. For
example, there is an existing Customer 001 in the
database with the name Customer A and Payment
Terms 30 days, and in the import file Customer
001 has the name Customer AA and no Payment
Terms. The import procedure will overwrite the
entire record for Customer 001, so the result will
be that it has the name Customer AA and no
Payment Terms. Records in the database with no
duplicate in the text file will not be touched.

Note that blocks will always be overwritten with
duplicate information from a text file, irrespective of
whether this parameter is 0 or 1. There are two types of
block: the setting that is a set of fields and check boxes
(e.g. Account Usage S/L, Account Usage P/L, Locking);
and the setting that is a series of rows (e.g. Payment
Modes, VAT Codes).



Chapter 2: Work Area - Menus - File Menu

107

String Type Use the final parameter to specify the character set used
in the text file—

0 The text file contains characters belonging to a
single character set (e.g. ASCII, KOI-8R
[Russian Cyrillic], ISO-8859-1 [Western
European]).

1 The text file contains Unicode characters.

Text files exported from a FirstOffice database will
contain Unicode characters.

You should use the ‘Imports’ function to restore your FirstOffice database
from a back-up, and to import your information into a new version of
FirstOffice. For full details of how to do this, please refer to the ‘Restoring
from a Back-up’ section in the ‘Introduction and Installation’ chapter of this
manual (page 69).

Maintenance
You can use the ‘Maintenance’ option on the File menu to carry out certain
updating tasks, such as the updating of Items’ prices or creating Invoices for
interest on late payment. When you select the function, a list window will
appear, from where you can choose the required option by double-clicking.
The options available vary according to the active module. See the chapters
covering each module for details of the specific functions.
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Reports
FirstOffice can print reports or documents. Reports are used mostly in
relation to your internal accounting and management.

Reporting in FirstOffice is non-destructive, i.e. you can make and print a
report as many times as you wish. Some accounting programs are designed in
such a way as to allow journal printing only directly in connection with the
data entry. FirstOffice does not have this limitation.

When you select ‘Reports’ from the File menu or from the Master Control
panel, a window is opened, containing a list of all available reports. The
contents of this window vary with the selected module: the illustration below
shows the reports in the Nominal Ledger module—

Choose a report by clicking an item in the list once. If you need to set the
page size, number of copies and other printer options for the report, choose
‘Page Setup’ from the File menu. These settings will be used whenever the
particular report is printed until you choose ‘Page Setup’ once again.
Windows users can also use this function to choose the printer on which the
report is to be printed.

Once you have done this, double-click the report name in the list. A
specification window will open, where you can choose the information that
you want to be shown in the report. For example, when producing a Balance
Sheet, you can use its specification window (illustrated below) to choose the
period that is to be covered by the report.
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While the specification window is open, you can choose the destination of
the printout by selecting one of the Media options at the bottom of the
window. The available options are Screen, Printer, File, Clipboard and Excel.
The last option is only available to Windows users. If you print to screen (the
default setting), the report will be shown in a new window. You can
subsequently send the report to a printer by clicking the Printer icon in the
Button Bar of this window or by selecting ‘Print’ from the File menu.

If you are sending the report to a printer and you want a print dialogue to
appear, check the Printer Dialog box (last of the Media options). You might
do this if you want to print several copies of a report.

Once you have entered the reporting criteria and have chosen a print
destination, click [Run] to produce the report.

Page Setup
‘Page Setup’ on the File menu allows you to set the page size, number of
copies and other printer options for the report. These settings will be used
whenever the report is printed. Windows users can also use this function to
choose the printer on which the report is to be printed.

Updating Reports
While a report is on screen, it may be that you change some of the
information it contains. If so, there is no need to close and recreate the report.
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Instead, simply select ‘Recalculate’ from the Operations menu (or use the
Ctrl-Shift-R/-Shift-R keyboard shortcut) to update the report. If you want
to change the report criteria before recreating the report (e.g. you want to
change the report period), choose ‘Reopen Report Specification’ instead.

Defining Reports
For some reports in the Nominal Ledger module, you can redefine the
contents and layout of the report. To do this, use the Report Settings setting
in the Nominal Ledger. Full details can be found in the ‘Nominal Ledger’
chapter in Volume 2 of this manual.

Export to other applications
It is very easy to export the contents of any report to another application
program, e.g. Excel or Word. The specification window for each report
contains a set of Media options, one of which is ‘File’. If you select this
option, the report is saved as a tab-separated text file on your hard disk. This
can be used directly in Excel, for further calculations etc. On Windows only,
another Media option is ‘Excel’. This option opens the Excel application and
creates a new workbook containing the report.
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The following example shows a Customer Statistics report opened in
Excel—
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Documents
Documents are more formal printouts, usually printed using forms, such as
invoices or delivery notes. They are often directed to third parties. FirstOffice
offers several documents in each module. Documents cannot be printed to
file. The documents available vary with the selected module: the illustration
below shows those in the Sales Ledger module—

Defining Documents
You must assign a Form to each document before you print it for the first
time. The Form is the design or layout of the document. You can have a
single Form for each document, or you may have several versions of a
particular type of document, to be used on different occasions. To assign a
Form or Forms to a document, use the ‘Define Document’ function on the
Operations menu.

This is how you specify when each Form is to be used, using the Invoice as
an example.

1. Select the Sales Ledger module using the [Select Module] button in the
Master Control panel.

2. Click the [Documents] button in the Master Control panel. The
‘Documents’ list window is opened showing a list of available
documents. Highlight ‘Invoices’.
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3. Select ‘Define Document’ from the Operations menu. Specify INVOICE
as the Form on the first row—

Seq Use this column if you want to print two (or more)
different documents from a single command. For
example, you might want to print a Delivery Note and
an Invoice immediately when an Invoice is approved. In
this case, you would enter the Delivery Note with Seq.
no. 1 on the first row of the grid, and the Invoice with
Seq. no 2 on the second row.

Form Enter the Form Code of the relevant Form in this field.
This field is case sensitive: you should only use upper
case characters. Use ‘Paste Special’ to select from a list
of Forms as set up in the System module.

4. Click [Save] to save the Invoice definition. When you print Invoices
from now on, the correct Form will be selected automatically, without
further user intervention.

You can repeat this process for almost all documents as required.
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Settings
This command opens the ‘Settings’ list window where you will find an
alphabetical list of the settings that are available in the current module.
Settings are used to tailor certain aspects of the program’s operation to your
requirements, and to supply information to be used throughout the program.

The contents of the ‘Settings’ list window vary according to the module
selected. The illustration below shows the different settings in the System (on
the left) and Nominal Ledger modules.

Choose an entry in the list by double-clicking it, or by selecting it and
pressing the Enter key. Settings are described in detail in the chapters
covering the individual modules.

Page Setup
This function is available when the active (top) window on the screen
contains a list of reports or documents.

When you print a report or document, one copy is usually produced, using a
standard page size. If you need to print more than one copy, or to use a non-
standard page size or magnification, highlight the desired report or document
in the list and then select ‘Page Setup’ from the File menu to make these
changes. Once this has been done, double-click the item in the list to carry on
with the printing process.
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The number of copies, page size and/or magnification can be set individually
in this way for each document or report. These settings will remain in place
until ‘Page Setup’ is chosen once again.

Windows users can also use this function to choose the printer on which the
report or document is to be printed.

Print
This function is available when the active (top) window on the screen
contains something that can be printed (a screen report, a transaction in the
transaction window).

When you select ‘Print’, the transaction or the report is printed directly to the
selected printer, normally without the Print dialogue box being shown.

This menu item duplicates the functions of the Printer icon in the Button Bar
of the active window.

Quit
Quits FirstOffice. Remember to take a safety back-up of your work before
you quit!

Macintosh OS X users can find the ‘Quit’ command on the Hansa OSX
menu.

Edit Menu

You will usually use the commands on this menu when you are working with
the contents of individual fields. If you wish to copy or delete entire records,
you should instead use the commands in the Record menu, or the [New] or
[Duplicate] buttons in the Button Bar. If the active window contains nothing
editable, the commands will be dimmed. For each command in the Edit menu
there is a keyboard shortcut, e.g. Ctrl-Z (Windows and Linux) or  -Z
(Macintosh) for ‘Undo’. These shortcuts are shown in the illustrations above:
the Macintosh version is on the left, the Windows version on the right.
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Undo
Select ‘Undo’ to undo your last action.

There are a few actions in FirstOffice that cannot be undone, e.g. deleting a
record with the ‘Delete’ command on the Record menu. Anything removed
using the ‘Clear’ command in the Edit menu also cannot be undone.

Cut
‘Cut’ removes the data you have selected (highlighted) and puts a copy in the
Clipboard. The Clipboard is a special part of the computer's memory, used to
store a single piece of data temporarily. This data can then be inserted
(Pasted) into another place, once or several times, until you ‘Cut’ or ‘Copy’
something else. That will replace the old contents in the Clipboard.

In certain fields, e.g. the Account Number fields in a Transaction that has
already been saved, you may not remove the data, and thus not use ‘Cut’. If
you want to make a copy of the field’s contents, use the ‘Copy’ command
instead.

Copy
Use ‘Copy’ to copy text or numbers from one field to another without
removing the data from the original field. The copy is put in the Clipboard.
Then you can ‘Paste’ the copy in as many other locations as required. The
copy remains in the Clipboard until you ‘Cut’ or ‘Copy’ something else.

Note that ‘Copy’ (and ‘Cut’) can only be used to copy text from a single field
at a time. If you want to copy a whole record in a file, use the ‘Duplicate’
command in the Record menu (or the [Duplicate] button in the Button Bar).

Paste
With this command you can insert text or a value that has been cut or copied
to the Clipboard. The clipping is inserted at the insertion mark. If you select
several characters in the destination field, ‘Paste’ will replace the selected
text with the contents of the Clipboard.

Clear
‘Clear’ removes the characters you have selected (highlighted) without
copying them to the Clipboard.

The ‘Clear’ command removes text or values within a single field. If you
wish to remove an entire record, use the ‘Delete’ command on the Record
menu.
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Select All
Use this command to select the entire contents of a field. You can use it
when you are editing a field and want to replace the whole contents with new
data.

Select Row
This command is used in screens that contain rows of information, divided
into separate columns (or ‘fields’), for example the Invoice and Transaction
screens. It allows you to select a whole row. When you choose ‘Select Row’,
the row in which the cursor is placed is selected. Clicking the number
identifier of the row (on the left) has the same effect.

Record Menu

The Record menu contains the necessary commands to open, enter, change
and delete the records in the different registers.

Almost all these commands can also be executed using the buttons in the
Button Bar. In addition, there are keyboard shortcuts available for most of
them. Commands that cannot be used at a certain point are dimmed in the
menu.

The Record menu commands cannot
be undone with ‘Undo’.

Next
• When you work in a record window, showing an individual record in a

register, ‘Next’ will take you forward to the next record in that register.

It will also save all changes you have made in the record you have just
left.

In this situation, the ‘Next’ command has the same effect as clicking the
[Next Record] button in the Button Bar.

!
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• When you work in a browse window, ‘Next’ will move forward to the
next group (page) of records.

• When you work with a Report, ‘Next’ will scroll to the next page of the
report.

Previous
The command works in the same way as ‘Next’, but moves backwards
instead of forwards. As with ‘Next’, when working in a record window,
‘Previous’ saves all changes you have made in the record you are leaving.

In record windows, the ‘Previous’ command has the same effect as clicking
the [Previous Record] button in the Button Bar

OK
This command is equivalent to pressing the [Save] and [Run] buttons in the
Button Bar (depending on context). When you use this command in a record
window, it closes the record on screen and saves all changes. When you use
it in a browse window, it opens the selected (highlighted) record for editing.
In a specification window, it prints the report or document or activates the
Maintenance function.

Cancel
Closes the record on screen without saving any changes. It is equivalent to
the [Cancel] button in the Button Bar.

Windows of all types can also be closed using the close box or Ctrl-F4
(Windows and Linux) or -W (Macintosh). When using these methods, you
will be asked if you wish to save changes.

New
Use this command when you need to create a new record. You can only use
it after you have opened a register by double-clicking one of the buttons in
the bottom row of the Master Control panel.

This function opens a blank window into which you can enter the new
record. If you click [Save], the record will be saved into the register
concerned. If you click [New] again, the record will be saved and a new
blank window opened, enabling you to enter another new record in the same
register. If you click [Cancel], the record will be closed but not saved.
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Duplicate
This function creates a new record by duplicating an existing one. The
duplicate is opened in a window marked ‘New’. In many cases, dates in the
new record will be changed to show the current date.

You can duplicate a record either from a record window, showing the record
to be duplicated, or from the browse window, in which you have highlighted
the record to be duplicated by clicking with the mouse.

Delete
Use this command to delete, i.e. remove, an existing record. The record must
be of a type that can be removed - records such as Invoices and Nominal
Ledger Transactions cannot be removed once completed. You must open a
record in the record window to be able to delete it. The only exception to this
rule is that Mails must be deleted from the browse window.

When you delete a record, the next record in the register is displayed.

Remember that you cannot undo the
deletion of a record.

When you use the ‘Delete’ command, you are usually not asked if you are
sure you want to go ahead with the deletion. If you would like such a
warning to appear, switch on the Prompt When Deleting option in the Local
Machine setting in the User Settings module. This option is specific to each
client machine.

Window Menu

Use this menu to manage your windows, including closing them and
arranging them on screen. ‘Save Normal Position’ (Windows and
Linux)/‘Save’ (Macintosh) and ‘Restore Normal Position’ (Windows and
Linux)/‘Restore’ (Macintosh) allow you to save a particular setting for an
individual window. ‘Save Normal Position’ will save the position and size of
the window and, in browse and ‘Paste Special’ windows, the sort order you

!
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have selected in Browse or Paste windows, while ‘Restore Normal Position’
will return the setting of the window to standard.

Although the ‘Close All’ function is not available to Macintosh users,
clicking the close box of a window while holding down the Alt key will have
the same effect.

In multi-user systems, each user can use the ‘Save Normal Position’/‘Save’
functions to save their own window positions, sizes and sort orders. This
information is stored on the client machine, so it will not be included in the
normal daily back-up file made from the server. To back up this information,
use the ‘Client Text Backup’ option: please refer to page 375 in the ‘System
Module’ chapter later in this manual for full details.

About FirstOffice

This command on the ? menu (Windows and Linux), the Apple menu
(Macintosh OS 9) and the Hansa OS X menu (Macintosh OS X) shows the
copyright information for FirstOffice. The version of the program and
information about the owner of the program license are also shown here. You
return to the program by clicking [OK].

If you need to contact your local FirstOffice representative with a technical
query, you should first find out the precise version number from this
window.

This window also shows the size of your FirstOffice database and the amount
of disk space available on the hard disk on which it is stored. In multi-user
systems, these figures refer to the server.
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Modules and Registers

Modules

FirstOffice is divided into several different areas, or modules. Each module
corresponds to a different department in a normal company. Each one
contains the tools that the equivalent company department requires to carry
out its daily tasks. For example, the Sales Ledger module contains the tools
to raise Invoices, receive money and manage debt-chasing campaigns.

To change to a different module, click the [Select Module] button in the
Master Control panel, or use the Ctrl-0 (Windows and Linux) or  -0
(Macintosh) keyboard shortcuts. The following list window appears—

Choose a module by double-clicking. If you prefer to use the keyboard, type
the first letter of the module that you want and then press the Enter key. As
there are several modules beginning with S, you can choose the one you want
using the arrow keys, or you can type the letter S the appropriate number of
times. For example, to select the Stock module, type the letter S three times.

As soon as you change module, the register buttons in the lower part of the
Master Control panel will change to represent the registers in the new
module. If you have any list windows open (e.g. lists of settings, documents
or reports), their contents will change as well.
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Registers

Each module contains a number of Registers or Files, in which your data is
stored. The registers can be opened using the buttons in the bottom section of
the Master Control panel. The following illustration shows the registers
available in each module. The exact contents and the use of each register is
explained in the chapters of this manual covering the individual modules.

To work with a register (for example, if you need to enter a new Sales
Order), first go into the appropriate module using the [Select Module] button
in the Master Control panel. Click the relevant register button in the bottom
section of the Master Control panel. A browse window will open, listing all
the existing records in the register (in this example, all Sales Orders). Then,
click [New] in the Button Bar and a blank record window will appear in
which you can enter a new record.

Registers in FirstOfficeProfessional

System

Nominal 
Ledger

Purchase 
Ledger

Sales 
Ledger

Sales 
Support

Stock
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Working with Records

Current Record

When you wish to work with a particular record, you can open its record
window using one of the following methods. All methods give the same
result.

• Double-click the record in a browse window.

• Select the record in a Browse Window and press Enter.

With the record opened in a record window, you can edit all fields in the
usual way. Some fields may be locked due to relations to other functions in
the program. If this is the case, FirstOffice will tell you.

New Record

You can create a new record from a browse window or a record window. To
create a new record do one of the following—

• Click [New] on the Button Bar.

• Select ‘New’ from the Record menu.

A blank record is opened in a record window.

Duplicate Record

You can copy a record from a browse window or a record window. Select the
record you want to copy and—

• Click [Duplicate] in the Button Bar, or

• Select ‘Duplicate’ from the Record menu.

A new record is created. Relevant data from the original record is transferred,
and you only need to enter some of the fields. In many cases, date fields will
not be copied, but instead will be given new values.
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Delete Record

1. Open the record window for the record you want to delete.

2. Select ‘Delete’ in the Record menu.

You cannot delete a record that is used by other transactions, such as an
Account.

You cannot undo the deletion of a
record.

In most cases, you cannot delete a record directly from a browse window.
You must open the record first. The exception is a Mail, which you can only
delete from the browse window.

You can prevent a particular user or group of users from deleting records
using Access Groups. For full details about Access Groups, please refer to
page 307 in the ‘System Module’ chapter later in this manual.

!
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Working with Companies
A FirstOffice database can contain more than one Company. This feature can
be useful if your business is one where there are separate departments or
subsidiary companies that keep separate accounts. These can be set up as
separate accounting entities in FirstOffice. Each department or subsidiary is
termed a ‘Company’.

Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

Companies are stored in the Company register in the System module. You
can add new Companies at any time: this process is described in the
‘Changing and Adding Companies’ section in the previous chapter (page 46)
If you have more than one Company in your Company register, it is
recommended that you specify a Short Code for each one—

Each time you log in to FirstOffice, you will be asked to choose a Company
to work with—
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The names in this list are taken from the Name field in the Company register.

Once you have logged in, the Short Code of the Company (“H” in the
example illustrated) will be included in the title of every window—
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If you need to change Companies, there is no need to quit FirstOffice and
restart. Instead, you can click the [Companies] button in the Master Control
panel or select ‘Company’ from the File menu and then select the new
Company. Once you have done this, the Short Code in the window title
identifies the Company to which the information in each window belongs—

In this illustration, the ‘Transactions: Browse’ window lists Transactions
belonging to Company H, while the ‘Accounts: Browse’ window lists
Accounts belonging to Company S. Only one Master Control panel can be
open at any time, so the Short Code in its title (“S” in the illustration) is
always that of the current Company. This is the Company whose information
will be shown in any new windows that you open, and the Company in which
any new records that you create will be saved. If you want to return to work
in Company H, use the ‘Company’ function on the File menu once again.

If you need to make a change to a record in a particular Company, that
Company must be your current Company. For example, you have a Customer
record from Company H open in a record window. If Company S is your
current Company, you will not be able to make changes to the Customer
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record. You must change to Company H first, using the ‘Company’ function
on the File menu.

Usually, each Company will be completely separate: there will be no
common information. If you want to copy information from one Company to
another, you can do so using one of two methods—

1. by dragging and dropping. For example, to copy a Customer record from
one Company to another, open the ‘Customers: Browse’ window in the
first Company, change to the second Company using the ‘Company’
function on the File menu, and open the ‘Customers: Browse’ window in
that Company as well. Then click on the relevant Customer record and
drag it from one browse window to the other. This method is suitable for
copying individual records. The Payment Terms used in the copied
Customer must exist in both Companies.

2. using the export and import functions in the System module. This
method is suitable for transferring the entire contents of a register or
setting from one Company to another.
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Attachments and Personal Desktop

Attachments

You can connect files, notes or other records to any record in FirstOffice.
These connected objects are known as “Attachments”.

All record windows contain an [Attachments] button—

If a record already has an Attachment, the button has a different icon—

Click this button to work with Attachments. A list of objects currently
attached to the record is opened—

This list has its own Operations menu, which contains the functions
necessary to attach, view and remove Attachments—
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You must save a record at least once before you can add any Attachments.

Attaching Files to Records
To attach a file to a record, open the record in question and click the
[Attachments] button. Select ‘Attach File’ from the Operations menu. An
‘Open File’ dialogue box will open, allowing you to locate the file to be
attached. Find the file and click [Open]. The file will be attached to the
record. Its filename will appear in the list of Attachments with the prefix
“File:”. You can attach as many files as you like to a single record.

The ‘Attach File’ function attaches a file to a record by copying the file into a
folder called “Attach” that is in the same folder as your FirstOffice
application. In multi-user systems, the “Attach” folder should be on the
server. This means that you will still be able to download and read the
attached file, even after the original has been deleted. If you want to attach a
large file to a record, make sure (using the disk space indicator in the ‘About
FirstOffice’ window) that the hard disk containing your FirstOffice
application has sufficient space. As the file is uploaded to the server, a
progress indicator appears so that you can monitor its progress.

The “Attach” folder must be present
in the folder containing your
FirstOffice application if you want to
attach files to records. Do not rename
any of the files in the “Attach” folder.

Reading Files
You can read a file that has been attached to a record in one of two ways.
Whichever method you use, a ‘Save File’ dialogue box will be opened,
asking you where the file is to be saved.

1. By double-clicking on the file in the list of Attachments. When the file
has been saved to your hard disk, your default browser will be opened so
that the file can be opened using the appropriate helper application (not
Macintosh).

2. By clicking on the file in the list of Attachments and selecting
‘Download File’ from the Operations menu. The file is saved to your
hard disk, but no attempt is made to open it using a helper application.

!
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Attaching Notes or Comments to Records
You can attach notes or comments to records. To do this, open the record in
question and click the [Attachments] button. Select ‘Create Note’ from the
Operations menu. A window will open, where you can type in your comment.

Click [Save] to save. The note will appear in the list of Attachments with the
prefix “Note:”. If you want to identify the note with a name, refer to the
section entitled ‘Changing the Names of Attachments’ below on page 132.
You can attach as many notes as you like to a single record.

Reading and Changing Notes
You can read a note or comment that has been attached to a record in one of
two ways—

1. By clicking on the note in the list of Attachments and selecting ‘OK’
from the Record menu; and

2. By double-clicking on the note in the list of Attachments.

Whichever method you use, the note will be opened in its own window where
you can read or edit it.

Printing Notes
A note or comment that has been attached to a record can be printed when the
record is printed. For example, a note that has been attached to an Invoice can
be printed on the Invoice document. If more than one note has been attached
to a record, only the first note will be printed.

If you want notes and comments to be printed in this way, you should include
the “Note” field in each of your Form designs. Form design in fully described
on page 346 in the ‘System Module’ chapter later in this manual.
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Changing the Names of Attachments
When you attach a file to a record, its file name will be shown in the list of
attachments. When you attach a note to a record, it is not immediately given
its own name in the list.

If you want to rename a file or note, highlight it in the list of Attachments and
select ‘Edit Link Comment’ from the Operations menu. A window opens
where you can type in a new name.

Click [Save] to save and close the window, or [Cancel] if you don't want to
save changes. You may have to close and re-open the list of Attachments for
the change to take effect.

Attaching Records to Other Records
You can attach records to other records by dragging and dropping from the
browse window of one register onto the [Attachments] button of another. For
example, to attach a Customer record to an Invoice, open the Invoice in a
record window and then open the ‘Customers: Browse’ window. Find the
correct Customer in the list, click on the Customer Number and drag it to the
[Attachments] button of the Invoice. The Customer record will then appear in
the Invoice’s list of attachments. Alternatively, if the Customer record is
already open, you can drag its [Attachments] button onto that of the Invoice.
You can also select a range of Customer records in the browse window by
clicking while holding down the Shift key, and then drag them all to the
[Attachments] button.

Later, when viewing the Customer record in the example above, you might
wish to see which other records it has been attached to. Open the list of
Attachments and select ‘Show To Links’ from the Operations menu. The
records the Customer has been attached to will be listed below a dotted line.
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Viewing Attached Records
You can read a record that has been attached to another record in one of three
ways—

1. By clicking on the record in the list of Attachments and selecting ‘Open
Record’ from the Operations menu;

2. By clicking on the record in the list of Attachments and selecting ‘OK’
from the Record menu (or pressing the Enter key); and

3. By double-clicking on the record in the list of Attachments.

Whichever method you use, the linked record is opened in its own window
where you can read or edit it in the usual manner.

Attaching Reports to Records
To attach a report to a record, first print the report to screen, and open the
record in question. The Button Bar of the report window contains an
[Attachments] button—

Drag this button to the [Attachments] button of the record. The report will be
attached to the record. It will appear in the list of Attachments with the name
“File: report”. Please refer to the ‘Changing the Names of Attachments’
section above on page 132 for details about changing this name.

When you attach a report to a record, the report is first printed to file and that
file is then attached to the record. The report file is stored in the “Attach”
folder that is in the same folder as your FirstOffice application. In multi-user
systems, the “Attach” folder should be on the server. If you need to read the
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report later, you will effectively be reading the file, not producing the report
again. The information it contains will be correct for the moment when it was
originally produced, not for the moment when you are reading it. This may be
useful if you have attached the report to a Mail for discussion with another
member of staff. When you read the report later, it will be opened in a
standard report window, so you can select ‘Recalculate’ from the Operations
menu if you need to update the report to include the latest information in the
database.

The “Attach” folder must be present
in the folder containing your
FirstOffice application if you want to
attach reports to records. Do not
rename any of the files in the
“Attach” folder.

Reading Reports
You can read a report that has been attached to a record in one of two ways.
Whichever method you use, the report will be opened in a standard report
window.

1. By double-clicking on the report in the list of Attachments.

2. By clicking on the file in the list of Attachments and selecting ‘Open
Record’ from the Operations menu.

Removing Attachments
To remove an attachment of any kind from a record, highlight it in the list of
Attachments and select ‘Clear’ from the Edit menu.

Attaching Records to Mails
You can attach records to Mails in one of two ways—

1. Where the Mail already exists, you can drag the record from its browse
window to the [Attachments] button of the Mail, as described in the
‘Attaching Records to Other Records’ section above on page 132.

2. Where the Mail does not exist, open the record and click its
[Attachments] button. Select ‘Create Mail’ from the Operations menu. A
new Mail is opened. Complete the Mail in the usual way and save. The
new Mail will be attached to the record automatically, and the recipient
of the Mail will be able to open the record using the ‘Show To Links’
Operations menu function.

!
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Remember that Mails themselves are records. Therefore Mails can be
attached to other Mails or to other records. Every feature described in this
section applies to Mails as much as to other records.

If you want to use Mails, you must have the CRM and Mail Value Pack. This
is fully described in Volume 4 of these manuals.

Copying Attachments from one Record to Another
You can copy an Attachment of any kind from one record to another as
follows—

1. Open the record with the Attachment (the ‘source’ record) and click its
[Attachments] button.

2. Open the record that is to receive the Attachment (the ‘destination’
record).

3. Drag the Attachment from the list of Attachments to the [Attachments]
button of the ‘destination’ record (or to its list of Attachments).

4. Hold down the Shift key while dragging if you do not want to remove the
Attachment from the ‘source’ record.

Organising Attachments: Archives
When a record has many Attachments, you can organise them into Archives.
An Archive is a folder that can contain Attachments of all kinds, including
other Archives.

1. Open the list of Attachments.

2. Select ‘Create Archive’ from the Operations menu. A new Archive will
appear at the top of the list of Attachments, named “Archive: New”.
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3. Move the Attachments into the Archive by dragging and dropping onto
“Archive: New”.

4. If you want to work with an Attachment that is in an Archive, double-
click the Archive. A new window is opened, listing the Attachments that
are in the Archive. This window has the same properties, features and
functions as the main list of Attachments, so you can work with it in the
manner described in the preceding sections.

5. If you want to rename the Archive, first open it as described in step 4
above and then select ‘Rename Archive’ from the Operations menu.

Enter the new Name of the Archive and click [Save]. The new name will
replace the text “New,” both in the title bar of the Archive and in the
main list of Attachments—
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6. You can remove an Attachment from an Archive in one of two ways. If
you want the Attachment to remain attached to the record, drag it to the
main list of Attachments or to another Archive. To remove the
Attachment altogether, click on it and select ‘Clear’ from the Edit menu.

7. To remove an Archive, click on it in the main list of Attachments and
select ‘Clear’ from the Edit menu. You can only remove empty Archives.
To empty an Archive, you must remove its contents item by item as
described in step 6 above.

Personal Desktop

As well as being able to connect files, notes or records to any record in
FirstOffice (as described above), you can also attach them to your Master
Control panel. They will be listed in the area on the right of the Master
Control panel, known as the “Personal Desktop”. You can also list important
reports, documents, Maintenance functions, settings and registers in the
Personal Desktop. You can therefore configure your Personal Desktop so that
it gives you immediate access to the areas of FirstOffice that are most
important to you (i.e. removing the need to change modules, find records in
browse windows and find reports in list windows). The Personal Desktop is
therefore similar to a list of Bookmarks in a browser.

If you want to use the Personal Desktop, you must first set up a Mailbox for
yourself. To do this, open the Persons register in the System module,
highlight your record in the ‘Persons: Browse’ window and choose ‘Create
Mailbox’ from the Operations menu. This process is described in full in the
‘Mail’ chapter in Volume 4 of these manuals. In a multi-user system, each
user that will be using the Personal Desktop should have their own Mailbox.
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You must have a Mailbox if you want
to use the Personal Desktop.

Once you have a Mailbox, your name will be shown in the title bar of the
Master Control panel, and the contents of your Personal Desktop will be
listed in the area on the right—

Company identifier and
name of current user

Archives: used to ensure there is a managable
number of objects in the Personal Desktop.

Double-click to view contents

Double-click to
open individual

Invoice

Double-click to
open Invoice

register

Links to two reports, one
Maintenance function and one

document. Double-click to activate

The contents of your Personal Desktop cannot be viewed by another user. So,
if someone else logs in to FirstOffice on your machine, they will see their
Personal Desktop, not yours.

!
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Records in your Personal Desktop
You can place records in your Personal Desktop using the following
methods—

1. By dragging the record from its browse window and dropping it on the
Personal Desktop. For example, to place a Customer record in the
Personal Desktop, open the ‘Customers: Browse’ window and find the
correct Customer in the list. Click on the Customer Number and drag it
to the Personal Desktop. You can also select a range of Customer records
in the browse window by clicking while holding down the Shift key, and
then drag them all to the Personal Desktop.

2. By opening the record and dragging its [Attachments] button onto the
Personal Desktop.

Records are shown in the Personal Desktop with the name of the register
followed by the record identifier. In the illustration above, the penultimate
item (“Invoice: 970116”) is an example (970116 is the Invoice Number).

The illustration also shows that the Personal Desktop can contain records
from different Companies. In the illustration, the current Company is
Company H (shown in the title bar of the Master Control panel, next to the
name of the current user). “H” is short for Holding Company in the example
database. The last item in the Personal Desktop in the illustration (“S:
Invoice: 912”) is an Invoice that belongs to Company S (a Subsidiary
Company). Any record that does not belong to the current Company will be
shown in the Personal Desktop with its Company Short Code before the
name of the register. So, in this example, if the current user were to quit
FirstOffice and restart, selecting Company S, then Invoice 970116 would
appear in the Personal Desktop as “H: Invoice: 970116” and Invoice 912
would appear simply as “Invoice: 912”.

You can open a record in the Personal Desktop in one of three ways—

1. By clicking on the record in the Personal Desktop and selecting ‘Open
Record’ from the Operations menu;

2. By clicking on the record in the Personal Desktop and selecting ‘OK’
from the Record menu (or pressing the Enter key); and

3. By double-clicking on the record in the Personal Desktop.

Whichever method you use, the record is opened in its own window where
you can read or edit it in the usual manner. If you choose to open a record
that is not in the current Company, you will be asked to log in to the relevant
Company before the record is opened.
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Settings, Reports, Documents and Maintenance functions in your
Personal Desktop
To place a setting, report, document or Maintenance function in your
Personal Desktop, simply open the appropriate list window and then drag an
item from the list to the Personal Desktop. This method can also be used for
import and export functions.

For example, to place the Open Inv Customer Statement in your Personal
Desktop (as shown in the example illustration above), first use the [Select
Module] button in the Master Control panel to enter the Sales Ledger and
then select ‘Reports’ from the File menu (or click [Reports] in the Master
Control panel). Click on ‘Open Inv Customer Statement’ in the list and drag
this text to your Personal Desktop.

To work with a setting, report, document or Maintenance function, use one of
these methods—

1. Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2. Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3. Double-click on the item in the Personal Desktop.

Whichever method you use, the setting or the specification window for the
report, document or Maintenance function will open. You can also attach a
report itself to your Personal Desktop: please refer to the ‘Reports in your
Personal Desktop’ section below on page 142.

Registers in your Personal Desktop
To place a register in your Personal Desktop, simply drag it from the Master
Control panel to the Personal Desktop. For example, to place the Invoice
register in your Personal Desktop (as shown in the example illustration
above), first use the [Select Module] button in the Master Control panel to
enter the Sales Ledger. Click on the [Invoices] button in the Master Control
panel and drag it to your Personal Desktop.

To work with a register, use one of these methods—

1. Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2. Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3. Double-click on the item in the Personal Desktop.
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Whichever method you use, the normal browse window for the register in
question will be opened. If, as in the example illustrated above, the database
contains more than one Company, the browse window will list the records in
the register in the current Company.

Notes and Comments in your Personal Desktop
You can place notes or comments in your Personal Desktop. To do this, bring
the Master Control panel to the front and select ‘Create Note’ from the
Operations menu. A window will open, where you can type in your comment.

Click [Save] to save. The note will appear in your Personal Desktop with the
prefix “Note:”. If you want to identify the note with a name, refer to the
section entitled ‘Changing the Names of Items in your Personal Desktop’
immediately below. You can place as many notes as you like in your
Personal Desktop.

You can read a note or comment in your Personal Desktop in one of two
ways—

1. By clicking on the note in the Personal Desktop and selecting ‘OK’ from
the Record menu; and

2. By double-clicking on the note in the Personal Desktop.

Whichever method you use, the note is opened in its own window where you
can read or edit it.

Changing the Names of Items in your Personal Desktop
When you place a file in your Personal Desktop, its file name will be shown
in the list of attachments. When you place a note in your Personal Desktop, it
will not immediately be given its own name in the list.
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If you want to rename a file or note, highlight it in your Personal Desktop and
select ‘Edit Link Comment’ from the Operations menu. A window opens
where you can type in a new name.

Click [Save] to save and close the window, or [Cancel] if you don't want to
save changes.

Reports in your Personal Desktop
To place a report in your Personal Desktop, first print the report to screen.
The Button Bar of the report window contains an [Attachments] button:
simply drag this button to the Personal Desktop.

To work with a report, use one of these methods—

1. Click on the item in the Personal Desktop and select ‘Open Record’ from
the Operations menu;

2. Click on the item in the Personal Desktop and select ‘OK’ from the
Record menu (or press the Enter key); and

3. Double-click on the item in the Personal Desktop.

Whichever method you use, the report will be opened in a standard report
window.

When you attach a report to your Personal Desktop, it will appear in the
Personal Desktop with the name “File: report”. Please refer to the ‘Changing
the Names of Items in your Personal Desktop’ section above on page 141 for
details about changing this name.

When you attach a report to the Personal Desktop, the report is first printed to
file and that file is then attached to the Personal Desktop. The report file is
stored in the “Attach” folder that is in the same folder as your FirstOffice
application. In multi-user systems, the “Attach” folder should be on the
server. If you need to read the report later, you will effectively be reading the
file, not producing the report again. The information it contains will be
correct for the moment when it was originally produced, not for the moment
when you are reading it. The report will be opened in a standard report
window, so you can select ‘Recalculate’ from the Operations menu if you
need to update the report to include the latest information in the database.
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The “Attach” folder must be present
in the folder containing your
FirstOffice application if you want to
attach reports to your Personal
Desktop. Do not rename any of the
files in the “Attach” folder.

Removing Items from your Personal Desktop
To remove an item of any kind from your Personal Desktop, highlight it and
select ‘Clear’ from the Edit menu.

Organising Items from your Personal Desktop: Archives
When you have many items in your Personal Desktop, you can organise them
into Archives. An Archive is a folder that can contain Attachments of all
kinds, including other Archives.

1. Bring the Master Control Panel to the front by clicking on it, by using the
Ctrl-M/-M keyboard shortcut or by selecting ‘Master Control’ from the
File menu.

2. Select ‘Create Archive’ from the Operations menu. A new Archive will
appear towards the top of the Personal Desktop, named “Archive: New”.

!
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3. Move the relevant items into the Archive by dragging and dropping onto
“Archive: New”.

4. If you want to work with an item that is in an Archive, double-click the
Archive. A new window is opened, listing the items that are in the
Archive. This window has the same properties, features and functions as
a list of Attachments, so you can work with it in the manner described in
the ‘Attachments’ section above on page 135.
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5. If you want to rename the Archive, first open it as described in step 4
above and then select ‘Rename Archive’ from the Operations menu.
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Enter the new Name of the Archive and click [Save]. The new name will
replace the text “New,” both in the title bar of the Archive and in the
Personal Desktop—

6. You can remove an item from an Archive in one of two ways. First, you
can drag it to the Personal Desktop or to another Archive. Otherwise, to
remove the item altogether, click on it and select ‘Clear’ from the Edit
menu.

7. To remove an Archive, click on it in the Personal Desktop and select
‘Clear’ from the Edit menu. You can only remove empty Archives. To
empty an Archive, you must remove its contents item by item as
described in step 6 above.
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Keyboard Shortcuts
Menu Function Windows/Linux Macintosh
File Menu Company Ctrl-O -O

Master Control Ctrl-M -M
Exports Ctrl-E -E
Imports -Shift-I
Reports Ctrl-R -R
Documents Ctrl-D -D
Settings Ctrl-S -S
Print (Printer Icon) Ctrl-P -P
Quit Alt-F4 -Q

Edit Menu Undo Ctrl-Z -Z
Cut Ctrl-X -X
Copy Ctrl-C -C
Paste Ctrl-V -V
Select All -A

Record Menu Next ([] button) PgDn -+
Prev ([] button) PgUp --
OK ([Save], [Run] buttons) Shift-Enter Shift-Enter
Cancel ([Cancel] button) -B
New ([New] button) Ctrl-N -N
Duplicate ([Duplicate] button) Ctrl-K -Y
Delete -Shift-D

Registers Ctrl-1 to 5 -1 to 5
Window Menu Save Normal Position -Shift-S

Restore Normal Position -Shift-T
Browse Window Sort Column Ctrl-Shift-

highlighted letter
Record Window OK check box on/off Ctrl-Shift-O -Alt-O

Change Tabs Ctrl-Shift- -Alt-
-highlighted letter

Change Flips Ctrl-Shift-A to E -Alt-A to E
Paste Special Ctrl-Return -Return

Other Modify Linked Record F2 -Shift-V
Close Window Ctrl-F4 or Esc -W or Esc
Close All Windows Use Window menu Alt-Close Box
Change Window Ctrl-Tab -Shift-N
Change Module Ctrl-0 (zero) -0 (zero)
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Chapter 3: Accounting Principles
Managing your own business is often a rewarding undertaking, but with it
come a number of obligations. One is the requirement to keep your accounts
up to a certain standard. The legal requirements differ with the type of
business and the country of operation, but regardless of these there can be
great advantages in having your books in order. In this chapter some of the
basic concepts used in accounting, and their integration into FirstOffice, are
described.

Internal and External Documents
There are two basic types of documents produced by an accounting system:
external and internal documents. External documents, such as invoices,
payment vouchers, VAT reports and tax returns, are produced because
someone outside the business needs them. These are termed ‘Documents’ in
FirstOffice. Internal documents are used inside your company to make
decisions about different things. Examples are price information, sales
statistics, credit limits, payment forecasts etc. These are termed ‘Reports’ in
FirstOffice.

Accounting material should be handled with care. You need the information
it provides to control and to develop your business, and you are also required
by law to keep it up to date and archived in a certain way.

Both the reports handed in to authorities, banks etc. and those you make for
your own use are based on a basic series of transactions. The records of these
basic transactions (sales invoices, cash ledger vouchers, purchase invoices,
bank statements, personnel records and loans) are found among the
documents of any business.
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Transaction Records
A transaction record is the proof of a transaction, e.g. a receipt for something
you have bought, or a bank statement showing that an invoice has been paid
by one of your customers. Every event in the business that involves its
finances should be supported by a transaction record.

All financial events should be recorded in date order as they occur. When
each event is recorded in the accounts, a transaction is created. The
transaction classifies the event according to certain accounting rules,
allowing the production of reports and the later recollection of the event.
Transactions are recorded in a daily journal and each is distinguished by a
unique sequence number. Their supporting documents (the hard copies of the
transactions) are kept in a file, marked with the same sequence numbers (and
with the date on which the transaction occurred). The transaction should also
contain a code, or account, classifying its nature. This is where your Chart of
Accounts comes in as a tool for the systematic recording of financial events.

Transactions in FirstOffice

FirstOffice features a high level of integration between the different modules
and the Nominal Ledger, where all transactions are recorded.

Whenever you process a transaction in FirstOffice’s Sales or Purchase
Ledger, an equivalent Nominal Ledger Transaction is normally created
automatically. For example, when you approve an Invoice and send it to a
Customer, a Nominal Ledger Transaction is created automatically to post
amounts to the Sales, Debtor and VAT Accounts. Simultaneously, the Sales
Ledger and all reports are updated. Similarly, when you receive a payment,
you will update the Sales Ledger, and an automatic Nominal Ledger
Transaction will update the Debtor Account and the Bank or Cash Account
as appropriate. In general terms, a record that causes a Nominal Ledger
Transaction to be created (e.g. an Invoice or stock movement of some kind)
is usually referred to as a “sub system record” or “sub system transaction” in
FirstOffice and in these manuals.
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FirstOffice Professional
Integration

Nominal Ledger

Sales Ledger Purchase Ledger

Stock

Through a large number of settings and parameters, you can set up the
accounting environment so that the correct Sales Accounts, Cost Accounts
etc. are updated when necessary. The level of automation available is
extensive, but FirstOffice also allows full manual control over the accounting
environment. By default, when FirstOffice is installed, full integration is
made available, but you can partially or wholly switch this off as required.

Below are described some of the more common sub system transactions.

Sales Invoices
Invoices are demands for payment sent to Customers. They are created
(‘raised’) in the Sales Ledger, which is also used to keep a record of how
much is owed to your business by whom. The raising of an Invoice causes a
Nominal Ledger Transaction to be created which debits the Debtor Account
(which keeps a tally of how much your company is owed), credits a Sales
Account (it is normal practice to maintain more than one Sales Account to
keep a record of the sales of different types of product) and, in most cases,
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credits a VAT Account. Once Invoices have been raised in the Sales Ledger,
the creation of the Nominal Ledger Transaction is handled automatically in
FirstOffice. Below is shown a typical such Transaction.

FirstOffice has a number of methods whereby the Accounts used in this
Transaction can be chosen to reflect the accounting needs of different
situations. The Debtor Account can be set according to the Customer or
Customer Category, different Sales Accounts can be used for the various
Item Groups or individual Items, and the VAT Account can be controlled
through the VAT Code. In addition, FirstOffice can post to the Stock and
Cost Accounts. The number of options is great, and they are described in
detail in this section.

Each individual Invoice, when approved, determines how the consequent
Nominal Ledger Transaction is to be structured. The Accounts used are
chosen as follows—

Sales Account
The Sales Accounts in the Nominal Ledger are used to record the levels of
sales of different types of Items. To determine which Account is to be used,
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click flip B when you enter an Invoice. This reveals that you can specify a
Sales Account for each row (in the column marked ‘A/C’). Different Invoice
rows can have different Sales Accounts.

When you add rows to an Invoice, FirstOffice places a default Sales Account
in the A/C field. You can overwrite this default if necessary. It is chosen as
follows—

1. When you enter an Item Code, if there is a Price List applying to the
Invoice and there is a record in the Price register for that Item/Price List
combination, FirstOffice takes the Sales Account from there. If this
Sales Account is blank, or there is no appropriate record in the Price
register—

2. FirstOffice uses the Sales Account for the relevant Item (taken from the
Item register). If this is blank—

3. FirstOffice uses the Sales Account from the Item Group specified for the
Item. If this is blank, or if no Item Group has been specified for the Item,
or if no Item Code has been entered to the Invoice row—

4. FirstOffice uses the Sales Account entered in the Account Usage S/L
setting for the zone to which the Customer belongs. There are three
zones (Domestic, EU and Export), and each can have a different Sales
Account.

If the selected Account is missing from the Chart of Accounts, FirstOffice
will display the error message: “Sales Account missing, check Account
Usage S/L”.

VAT Account
When you enter an Invoice, you must specify a VAT Code in each row. This
code refers to a specific VAT Code record, which will determine the Output
VAT Account in the subsequent Nominal Ledger Transaction and the rate at
which VAT will be charged. VAT Code records are set up using the VAT
Codes setting in the Nominal Ledger.
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When you enter Invoice rows, you cannot leave the VAT Code field (marked
‘V-Cd’, visible on flip B) blank. FirstOffice places a default in the field,
chosen as follows—

1. The VAT Code is taken from the Sales VAT Code field in the Customer
register. Usually, you should only specify a VAT Code for an individual
Customer if for some reason your usual VAT accounting method does
not apply to them. If this is blank—

2. When you enter an Item Code, FirstOffice uses the VAT Code entered
for the relevant Item in the Item register. If this is blank—

3. FirstOffice uses the VAT Code from the Item Group specified for the
Item. If this is blank, or if no Item Group has been specified for the Item,
or if no Item Code has been entered to the Invoice row—

4. FirstOffice uses the VAT Code entered in the Account Usage S/L setting
for the zone to which the Customer belongs.

If the selected VAT Code is missing from the VAT Codes setting, or if the
VAT Code record refers to a non-existent Account, FirstOffice will display
the error message: “Code not registered”.

Debtor Control Account
When a Nominal Ledger Transaction is generated from an Invoice, the
Debtor Account is not determined from the Invoice itself (unlike the Sales
and VAT Accounts described above). Instead, it is determined as follows—

1. You can specify a Debtor Account for the Customer Category to which
the Customer belongs. If this is blank, or if no Customer Category has
been specified—

2. FirstOffice uses the Debtor (or, if the Invoice is a cash Invoice, the Cash)
Account entered in the Account Usage S/L setting.

3. If the Customer is marked as an “On Account” Customer and the Invoice
has been allocated to an “On Account” Receipt, the On Account A/C
entered in the Account Usage S/L setting will be used.

If any of the Account Numbers refers to a non-existing Account, FirstOffice
will display the error message: “Debtor Account missing, check Account
Usage S/L”.

Stock Account and Cost Account
When goods are sold from stock, FirstOffice can generate Nominal Ledger
postings for the cost of goods, and for the stock outtake (‘Cost Accounting’).
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This can be determined to occur when Invoices are approved or when
Delivery Notes are approved.

For cost accounting transactions to take place, the Items concerned must be
Stocked Items. If cost accounting transactions are set to be created when
Invoices are approved, this will mean that, in addition to posting to the Sales,
VAT and Debtor Accounts, Nominal Ledger Transactions generated from
Invoices will debit the specified Cost Account and credit the specified Stock
Account. Further settings controlling the operation of cost accounting are
discussed in the ‘Stock Module’ chapter in Volume 3 of these manuals.

The Cost of Goods Account debited by such transactions is determined as
follows—

1. If you are using the Use Item Groups for Cost Accounts option in the
Cost Accounting setting in the Stock module, the Cost Account specified
on the ‘A/C’ card of the Item Group to which the Item belongs is used. If
this is blank, you are not using the Use Item Groups for Cost Accounts
option or the Item does not belong to an Item Group—

2. The Stock Cost Account specified in the Account Usage Stock setting is
used.

The Stock Account credited by such transactions is determined as follows—

1. If you are using the Use Item Groups for Cost Accounts option, the
Stock Account specified on the ‘A/C’ card of the Item Group record is
used.

2. In all other circumstances, the Stock Account specified in the Account
Usage Stock setting is used.

Various models are available by which the value of the cost accounting
transaction can be calculated (for example, cost price, FIFO price, weighted
average cost price). You can use a different cost model for each Item Group,
or you can use a single default cost model. Full details can be found in the
section describing the Cost Model setting in the ‘Sales Ledger’ chapter in
Volume 2 of these manuals.

If any of the Account Numbers refers to a non-existent Account, FirstOffice,
in attempting to generate the Nominal Ledger Transaction, will display the
error message: “Transaction could not be generated. Check settings”.

Round-off Account
If you are using FirstOffice’s option for rounding the Invoice amount to the
nearest monetary unit (Euro, Pounds etc.), you must specify a Round-off
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Account in the Account Usage S/L setting. To switch this option on, use the
Round Off setting in the System module.

Receipts
When a Customer makes a payment against an Invoice, the transaction is
known as a Receipt. In the Nominal Ledger, the raising of a Receipt credits
the Debtor Account and debits the Bank or Cash Account. As with Invoices,
you will usually enter Receipts in the Sales Ledger, where you will allocate
them to the appropriate Invoice(s), and the consequences in the Nominal
Ledger will be handled automatically. Normally, a Receipt will generate a
Nominal Ledger Transaction like this—

When Nominal Ledger Transactions are generated from Receipts, the
Accounts used are selected as follows.

Debtor Control Account
The Debtor Control Account for the Invoice being paid will be transferred to
the Receipt. For details of how this is calculated, please refer to the ‘Debtor
Control Account’ section under ‘Sales Invoices’ above on page 155.



HansaWorld FirstOffice Professional

158

If the Receipt is not allocated against a specific Invoice (i.e. it is an ‘On
Account’ Receipt), the On Account A/C entered in the Account Usage S/L
setting will be credited.

Bank or Cash Account
The Bank or Cash Account posting will be determined from the Payment
Modes setting, available in the Sales and Purchase Ledgers. This is used to
store different payment methods, such as cheque, cash, credit card. Each
payment method can be attached to a different Account, perhaps reflecting
the usage of different bank accounts for each type of payment.

If any of the Account Numbers refers to a non-existent Account, FirstOffice,
in attempting to generate the Nominal Ledger Transaction, will display the
error message: “Transaction could not be generated. Check settings”.

Purchase Invoices
Purchase Invoices are demands for your company to make payments. You
will usually record them in the Purchase Ledger, which you will use to
monitor these invoices and to record payments against them. The Purchase
Ledger allows you to find out how much money you owe to your creditors,
and you can use it to make a forecast of future payments.

Most transactions in the Purchase Ledger mirror similar transactions in the
Sales Ledger. Therefore, as with a Sales Invoice, a Nominal Ledger
Transaction created from a Purchase Invoice will normally affect three
Accounts: the Creditor Account will be credited, a Purchase Account will be
debited and, in most cases, the VAT Account will also be debited. Defaults
for the Accounts affected are taken from the Account Usage P/L setting, and
they are selected according to the priority rules described below.
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Purchase/Cost Account
The Purchase Accounts (also known as Cost Accounts) in the Nominal
Ledger are used to record the levels of purchases of different types of Items.
When you enter Purchase Invoices, you should enter a Purchase Account in
each row (in the column marked ‘Account’). Different rows can have
different Purchase Accounts.

FirstOffice can in some instances offer a default Purchase Account for the
Account field in the first row of a Purchase Invoice. This will be taken from
the Cost Account specified on the ‘Terms’ card of the Customer record for
the Supplier. You might specify such a default for Suppliers of services (such
as electricity or telephone services), whose Purchase Invoices are always
posted to the same Account.

VAT Account
When you enter a Purchase Invoice, you must specify a VAT Code in each
row. This code refers to a specific VAT Code record, which will determine
the Input VAT Account in the subsequent Nominal Ledger Transaction and
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the rate at which VAT will be charged. VAT Code records are set up using
the VAT Codes setting in the Nominal Ledger.

When you enter Purchase Invoice rows, you cannot leave the VAT Code
field (marked ‘V-Cd’) may not be left blank. The default is placed in this
field as follows—

1. FirstOffice uses the Purchase VAT Code specified for the Supplier in the
Customer register. If this is blank—

2. FirstOffice uses the VAT Code specified for the Account. If this is
blank—

3. The VAT Code specified in the Account Usage P/L setting is used.

Although VAT Codes can be specified for both Suppliers and Accounts (as
described in points 1 and 2 above), it is important you do not mix these
methods of setting default VAT Accounts.

If the selected VAT Code is missing from the VAT Codes setting, FirstOffice
will display the error message: “Code not registered”.

Creditor Control Account
When a Nominal Ledger Transaction is generated from a Purchase Invoice,
the Creditor Account is determined as follows—

1. FirstOffice uses the Creditor Account specified in the Customer record
for the Supplier. If this is blank—

2. You can specify a Creditor Account for the Supplier Category to which
the Supplier belongs. If this is blank, or if no Supplier Category has been
specified—

3. FirstOffice will use the default Creditor (or, if the Invoice is a cash
Invoice, the Cash) Account entered in the Account Usage P/L setting.

4. If the Supplier is marked as an “On Account” Supplier and the Invoice
has been allocated to an “On Account” Payment, the On Account A/C
entered on the ‘Exchange Rate’ card of the Account Usage P/L setting
will be used.

5. If you have switched on the Prel. Book check box in the Purchase
Invoice, a preliminary creditors account will be used, taken from the
Account Usage P/L setting. When you finally approve the Purchase
Invoice, this preliminary transaction will be replaced with a final
transaction, using the correct Creditor Account determined as above.
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If any of the selected Accounts is missing from the Chart of Accounts,
FirstOffice will display the error message: “Creditor Account missing. Check
Account Usage P/L” or, if step 5 above applies, “Preliminary Account not
found, check Account Usage P/L”.

Payments
A Payment is the Purchase Ledger equivalent of a Receipt: it is the
transaction that occurs when you pay a supplier’s Purchase Invoice. In the
Nominal Ledger, the raising of a Payment debits the Creditor Account and
credits the Bank or Cash Account. You will usually record Payments in the
Purchase Ledger, where you will allocate them to the appropriate Invoice(s),
and the consequences in the Nominal Ledger will be handled automatically.
Normally, a Payment will generate a Nominal Ledger Transaction like this—
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When Nominal Ledger Transactions are generated from Payments, the
Accounts used are selected as follows.

Creditor Control Account
The Creditor Control Account for the Purchase Invoice being paid will be
transferred to the Payment. For details of how this is calculated, please refer
to the ‘Creditor Control Account’ section under ‘Purchase Invoices’ above
on page 160.

If the Payment is not made against a specific Purchase Invoice (i.e. it is an
‘On Account’ Payment), the On Account A/C entered in the Account Usage
P/L setting will be debited.

Bank or Cash Account
The Bank or Cash Account posting will be determined from the Payment
Modes setting, available in both the Sales and Purchase Ledgers. This is used
to store different payment methods, such as cheque, cash, credit card. Each
payment method can be attached to a different Account, perhaps reflecting
the use of different bank accounts.

If any of the Account Numbers refers to a non-existent Account, FirstOffice,
in attempting to generate the Nominal Ledger Transaction, will display the
error message: “Transaction could not be generated. Check settings”.

Stock
In every business where stocks are kept, there are by necessity differences
between recorded stocks, physical stocks and stock values, for the simple
reasons that things break or disappear or that mistakes are made in shipping,
recording etc. In FirstOffice, stock values are kept both in the Stock module
and as Account balances in the Nominal Ledger. It is very difficult to have an
absolute agreement between FIFO stock levels and Nominal Ledger Stock
Account balances, and every business must decide for itself how important it
is to minimise differences. There is a price to be paid for precision. The
smaller the tolerance for errors, the greater the control apparatus will be, and
the greater the cost. There is a trade-off of control costs against precision that
every company must decide for itself.

The Stock module contains separate registers for Goods Received, Deliveries
and Stock Depreciations. Whenever you enter and approve a new record in
any of these registers, the physical stock levels of the Items involved and the
stock valuation in the Nominal Ledger are both updated automatically. In the
second case, each stock record causes a Nominal Ledger Transaction to be
generated, thus updating the stock valuation in the Nominal Ledger. Stock
levels and valuations can also be updated automatically from Invoices.
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FirstOffice’s Stock module basically uses the FIFO (‘First In First Out’)
principle for stock calculations. Illustrated below is an example Goods
Receipt, recording the arrival of three units of Item 10127 into stock at a
price of 4.00 each—
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This is the Nominal Ledger Transaction generated by the Goods Receipt,
which updates the stock valuation in the Nominal Ledger with the value of
the goods received into stock—

When goods are received, the Stock Account is debited with the cost of
goods, and a Creditor Suspense Account (usually given the term “Purchase
Control Account” in these manuals) is credited until the Purchase Invoice
arrives. The Stock Account used is the Stock Account specified in the
Account Usage Stock setting.
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Depending on local accounting conventions, you can add purchase costs,
VAT, freight and customs costs to the stock value in the Goods Receipt
record, or leave them out until the Purchase Invoice arrives. If you add them
at the time of receipt into stock, their values will be added to the Stock
Account, and credited against the Freight and Customs Cost Accounts
specified in the Account Usage Stock setting—
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The FIFO value of each Item is the value entered in the relevant Goods
Receipt, and you can decide which valuation method (e.g. FIFO, Cost Price,
Weighted Average) you want to use. After receiving two further shipments
of Item 10127 into stock, the Stock List report illustrated below provides a
stock valuation using the individual FIFO values from the relevant Goods
Receipts—

When goods are sold, stock balances are reduced and the Stock Account is
credited. Normally FirstOffice will use the FIFO value for crediting stock
and for debiting a Cost of Goods Account, although you can choose a
different Cost Model (e.g. Cost Price or Weighted Average). Full details can
be found in the section describing the Cost Model setting in the ‘Sales
Ledger’ chapter in Volume 2 of these manuals.
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In the following example, we will sell and ship all 26 units of Item 10127.
This is the Delivery record that records the shipment—
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The total FIFO value of the 26 units will be credited to the Stock Account
and debited to the Cost of Goods Account in the Nominal Ledger
Transaction created when the Delivery is approved—
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The Item History report in the Stock module shows that this total FIFO value
is calculated using the average FIFO value per unit of the Items sold—

In this case, because we sold our entire stock, there is no difference between
the stock value and the Stock Account value.
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In the following example, we have received into stock twenty units of Item
10128 using two separate Goods Receipt records. The first Goods Receipt
records that ten units were purchased at a price of 8.00 per unit, and the
second records that ten were purchased at a price of 9.00 per unit—
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We will deliver 12 units of Item 10128. In the Nominal Ledger Transaction
created when the Delivery record is approved, their total FIFO value is
shown to be 98.00 (i.e. 8.1667 per unit). This total FIFO value will be
credited to the Stock Account and debited to the Cost of Goods Account—

The price per unit in the Nominal Ledger Transaction in this example is
calculated on a strict FIFO basis. This dictates that the units shipped were all
ten of those purchased at the earlier price (8.00 per unit) and two of those
purchased at the later price (9.00), as follows—

   (10 x 8) + (2 x 9)    = 8.1667
12
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This is shown when the Item History report is recalculated after the Delivery
has been made—  
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The Stock List now values the remaining eight units at 9.00 each, the
purchase price per unit in the second Goods Receipt record—
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In FirstOffice, you will always create Deliveries from Orders. Included in
each Order row (on flip C) is a Gross Profit figure. This is calculated using
the standard Cost Price of the Item on the Order, not its FIFO value. In this
example, the standard Cost Price per unit of Item 10128 is 10.00—
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This Cost Price is also used in the GP, Orders report in the Sales Support
module (the sales price is 25)—

You can have the standard Cost Price of each Item updated to be the last
actual purchase price (the one used in the most recent Goods Receipt record).
You can do this using two methods—

1. The Stock module contains an ‘Update Item Cost Price’ Maintenance
function. This is not an automatic function: it is your decision whether
and when to use it. Each time you run this function, it will transfer the
last purchase price to the Cost Price field of the Item record.

2. If you would like the Cost Price of an Item to be updated automatically
with the latest purchase price each time a Goods Receipt is entered and
approved, use one of the Update Cost Price At Purchase options in each
Item record (‘Costs’ card).

In the example above, the Gross Profit of the Order would have been reduced
by 12 if the Cost Price of Item 10128 had been updated using either method
before the Order was record was created.
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Chart of Accounts
Accounts are the Nominal Ledger headings that you use to classify all
financial transactions: each Nominal Ledger Transaction described above
posts to two or more Accounts. In fact each Nominal Ledger Transaction can
be defined by which Accounts these are. The organisation of these Accounts
is known as a ‘Chart of Accounts’: a systematic list of how assets, liabilities,
income and expenses are to be classified and thus the basis for your
accounting reports. The logic used in the classification determines the
usefulness of your reports, and the drawing up of a satisfactory Chart of
Accounts requires careful consideration.

In designing a Chart of Accounts, it is usual practice to group Accounts
together according to type. For example, all Sales Accounts should have
similar codes, different Bank Accounts should have similar codes and so on.
This will ensure that they appear together in reports. Room should be left so
that new Accounts, the need for which is currently unforeseen, can be
inserted in the right place. If your business develops into new products, for
example, you should be able to create Sales Accounts for those new products
with similar codes to the existing Sales Accounts.

In traditional accounting systems, the Chart is divided into account classes,
following a decimal classification. Two or three classes are reserved for
Balance Sheet Accounts, one class is normally reserved for internal
accounting and year-end operations, and the remaining five or six classes are
used for revenue and cost classification.

Typical Charts of Accounts, including that supplied as a template with
FirstOffice, follow the model illustrated below. The Accounts are usually
divided into two groups, named after the report in which they appear.

Profit & Loss This report shows the trading profit or loss of your
business, usually at the end of a month or year.

Balance Sheet This report shows the assets, liabilities and capital of
your business at the moment of printing.
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Balance Sheet

Profit & Loss (P & L)

Account
Type

Account
Number
Range

Description

Income100-199Sales

Expense200-299Cost of Sales

Gross Profit = Sales - Cost of Sales

Expense300-599Overheads

Net Profit = Gross Profit - Overheads

Asset600-699Fixed Assets

Asset700-799Current Assets

Liability800-899Current Liabilities

Liability900-949Long Term Liabilities

Net Current Assets = Current Assets  - Current Liabilities

Total Net Assets = Fixed Assets  + Net Current Assets - Long Term Liabilties

FirstOfficeProfessional

Sample Structure of Chart of Accounts

Equity950-999Equity

IncomeNet Profit
from P & L

Profit/Loss Year To Date

Total Net Assets = Equity + Profit/Loss Year To Date

Your Chart of Accounts should be
drawn up in consultation with your
accountant or financial adviser.

Objects

In traditional cost accounting, the classification of expenditure and the
allocation of different expenses to departments, products, regions etc. is a
well-known problem area. In essence, there is a need to present management

!
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reports in several different views or dimensions. Normally, there are three
basic dimensions used in the accounting of any business—

• The KIND of income or expense - material, labour, transport, telephone
etc.

• The COST CENTRE, i.e. the department or organisational unit that
carries the responsibility for incurring the expense or realising the
revenue.

• The COST BEARER, normally the output, product or service produced.

In some businesses, there is a requirement to add further dimensions that are
not subdivisions of the above, such as geographical areas.

Conceptually, the accounting situation can be described as a three-
dimensional table—

Products

Unit B

   

  

 
 

 

 

  -
    

Revenue
Sales 100
less Discounts -10
Net Sales 90
Costs
Material -12
Labour -13
GP 65
Sales & Distribution -18
Marketing -8
GP2 49

 
 

   

 
 

Unit C Unit D TotalUnit A

Cost Centres
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Other
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Revenue

Sales 100
less Discounts -10
Net Sales 90

Costs
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Labour -13
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Sales & Distribution -18
Marketing -8

GP2 49

In traditional accounting systems, the classification is done with the help of
the Chart of Accounts. A Chart of Accounts is a    list    of Accounts. By
definition it is one-dimensional. Through various means, the Accounts are
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divided into sub-classes down one or more levels, and the result is a
hierarchical tree structure of classifications.

Revenues

Sales Rev.

Unit A

Unit B

Equipment

Radios

CD PlayersOther Rev.

Sales of Assets

Capital Rev.

Costs

Manuf. Costs

Unit A

Unit B

Equip. Costs

Material

Labour
Sales Costs

Unit A

Unit B
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A result of the hierarchical tree structure classification is inevitably that cost
type, profit centre and cost bearer classifications are scattered all over the
Chart of Accounts. This makes the description of reports complicated and
cumbersome, since data will have to be picked up individually from many
different Accounts, in order to produce different types of “Functional” result
reports.

To simplify the structure many accounting systems subdivide the “account
string” into different parts, each indicating cost type, department, project,
product etc. This is only a half-way solution. The only logically viable
solution to truly multi-dimensional accounting is to use an “Object”
classification in each accounting transaction. With this method, the Chart of
Accounts contains account specifications for the     kind     of revenue,
expenditure, asset, liability or equity. Each accounting transaction consists of
an Account Number, an amount, a date, and one or more Object
classifications. In the example above, a wages payment for selling radios in
Unit C would contain the following information—

Number 970001

Date 010105

Account 5102 Wages

Text “Any written description”

Amount Debit 15420.25

Objects Unit C, Radio

With this classification, it will be simple to show all transactions entered for
a separate product, unit and cost type, or to show a profit and loss statement
for a particular section of the business.

In the following section we will show how FirstOffice deals with this task.

Objects in FirstOffice
FirstOffice supports the use of Objects, to allow your accounts to be
classified and reported in several different categories or dimensions. You can
assign up to 30 Objects to a row in a transaction: the Object field can contain
up to 60 characters. When you enter Objects in an Object field, separate each
Object Code using commas. It is recommended that you use Object Codes
with at least two characters, placing a more usual limit of 20 Objects on each
transaction row.

You can assign default Objects to Customers, and to individual Invoices and
Nominal Ledger entries. When you assign an Object to a Customer, for
example, FirstOffice will automatically assign that Object to all Nominal
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Ledger Transactions generated by Invoices made out to that Customer. This
gives you excellent possibilities to report for example sales per Object. In
general, Objects are tools to improve the internal cost accounting capabilities
in your business.

You can use Objects as selection criteria in many reports. For example, if
you have several profit centres in your business, and use Objects to separate
income and expenditure for each one, you can produce separate profit and
loss statements for each profit centre. You can also print a Nominal Ledger
report that is restricted to a particular Object. The report will only list the
transactions for each Account that have been classified with the selected
Object.

All Objects in FirstOffice can span several years. This is a consequence of
FirstOffice’s continuous database, where the end of year is simply a user-
defined reporting interval. The Object balances are thus automatically
transferred from one fiscal year to the next. This gives you the ability to keep
track of the budget and results of an Object (e.g. a building project) for
several years.

You can close an Object, to prevent further postings to it. Working in the
Object register (in the Nominal Ledger), switch on the Closed check box to
close it. If you want to open the Object again later, you simply click in the
box again to remove the check.

It is a good idea to experiment with the Objects and the various reports.
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Examples
Illustrated below is a Sales Invoice, where the Customer belongs to the “Unit
A” Object, and the Invoice rows have been assigned the “Radio” and “Cass”
Objects respectively (on flip D of the ‘Items’ card). Each Item and Customer
have thus been assigned an Object reflecting their position in the table
illustrated at the beginning of this section.
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This is the Nominal Ledger Transaction that is created when the Invoice is
approved—
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The following two Profit & Loss reports show the Income Statement for two
of the journal postings: those with the Objects “Radio” and “Cass”,
respectively. Some cost transactions have been added to make the example
more complete.

With a careful use of Object and Account definitions, FirstOffice allows you
to allocate revenues and expenses in a logical way, in order to reveal the
profitability pattern in the business.



Chapter 3: Accounting Principles - Who needs to know

185

Who needs to know about your business
There are several parties who have an interest in your accounts: you, other
owners, creditors and banks, employees and not least the tax authorities.
Your auditor’s job is to certify your accounts on behalf of all the interested
parties. He or she will check your books to certify that they give a “true and
fair” representation of the state of affairs.

Sometimes it feels as if all this apparatus of reports and accounts is just too
much trouble. Used in the right way, however, a good accounting system
improves the control of the business. There are, indeed, more examples of
companies that have failed because of bad accounting than of too good…

Practical use of accounting information

Accounting information is useful in many situations. You can use it as a
foundation for your budgeting, when you want to find out if a certain deal is
profitable or not or to monitor the performance of a department, a market
segment etc.

Getting capital

From time to time you need to persuade banks or other financiers that your
business is solid and profitable, e.g. when you need to borrow money for an
investment. A good accounting system allows you to find the information
they require quickly, and to make a credible presentation.

Tax returns

Your accounts provide all the information needed to produce the different
types of tax returns.

VAT declaration

All VAT registered companies must produce a number of periodical reports,
of which the VAT return is the most important. If you are above the
threshold amount for trade within EU, there are some other reports that need
to be made.
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The VAT return comes from your accounts. It follows a prescribed format,
and your accounts should reflect the VAT requirements, to make it easy to
produce the report.
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The End of a Financial Year
At the end of the financial year, the books are closed and a new year is
started. The final accounts are produced, the auditors will produce their
report, and management will produce their report to the owners’ annual
meeting. After approval, in the case of limited companies, the annual report
is filed with the registrar of companies.

To end a financial year and start a new one in FirstOffice, follow these steps.
Companies will have their own methods for recording profit/loss at the end
of a financial year. A typical method is described in steps 4-9 below: this
method may not be suitable for every company in every country. Please refer
to your financial adviser for more advice on this subject.

1. If you are registered for VAT, the first step should be to print a VAT
Report for the final quarter of the year (and separately for earlier
quarters if this has not already been done).
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2. For each quarter, you should then enter a Transaction in the Transaction
register transferring the VAT amount payable/receivable into the VAT
Payments Account (835 in the Chart of Accounts supplied with
FirstOffice). This Transaction would debit the VAT Outputs Payable
Account (830) and credit the VAT Inputs Receivable Account (831),
with a balancing posting to the VAT Payments Account. You must enter
this Transaction in the quarter to which it belongs, preferably as the last
Transaction of the period.

You can transfer the amount payable/receivable from/to your bank
account using a further Transaction when payment is made/received.

3. Print out the following Nominal Ledger reports, using the whole year as
the report period in each case. These will provide both a hard copy
record of the year’s business and the basis for the end-of-year work that
will now be carried out by your auditors.

Nominal Ledger The Nominal Ledger report is an important part of the
final accounts of a business. It is a list of every



Chapter 3: Accounting Principles - The End of a Financial Year

189

Transaction, classified by Account and listed in the
order in which they were entered.

Transaction Journal

The Transaction Journal is a list of every Transaction, in
transaction number order.

Profit & Loss The Profit and Loss report summarises the income and
expenditure (and therefore the operating profit or loss)
of the business during the fiscal year. The result shown
on the Profit & Loss report should agree with (‘balance’)
the result on the Balance Sheet.

Balance Sheet The Balance Sheet shows the financial status - at a
particular point in time - of the company showing
Assets, Liabilities and Equity capital.

System Documentation

The System Documentation report in the System module
describes the accounting system being used. This
includes descriptions of the Chart of Accounts,
accounting rules etc. This allows an outsider to
understand how you have arrived at the final accounts.
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4. Ensure your Chart of Accounts (i.e. Account register) includes Accounts
defined as shown in the illustration—

5. The Accounts defined in step 4 above should not appear in the
Definitions for your Profit & Loss report, but should be part of the profit
calculation in the Balance Sheet. In the sample Chart of Accounts
supplied with FirstOffice, these are lines 90, 100 and 105 of the Balance
Sheet Definition. To check this, first select ‘Settings’ from the File menu



Chapter 3: Accounting Principles - The End of a Financial Year

191

and double-click ‘Report Settings’ in the subsequent list. Then, highlight
‘Balance Sheet’ in the list on the left-hand side of the ‘Report Settings’
window and click the [Definition] button. The following window
opens—
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Double-click in turn on lines 90, 100 and 105 (or the equivalents if you
are not using the sample Chart of Accounts and/or Balance Sheet report
definition supplied with FirstOffice) and ensure they are defined as
shown—
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Line 90 in the sample Balance Sheet Definition is the equity calculation,
it causes the balances of all Accounts between 950 and 970 to be shown
in the Balance Sheet, together with a total figure for equity.

Line 100 in the sample Balance Sheet Definition is the profit calculation.
This line does not have any Text and therefore it will not be printed in
the report.

Line 105 prints the result of the calculation in line 100.

6. Once your auditors have concluded their work and any consequent
Transactions have been entered, refer to step 3 above and print out the
reports again, as final records of the year just ended. These will be the
basis for the end-of-year accounts presented to the owners or directors.
The Net Profit in the Profit & Loss Report should be the same as the
Profit/Loss this YTD shown in the Balance Sheet. Make a note of this
figure.
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7. You should now post the profit or loss for the year just ended to the
Result of Current Fiscal Year Account (Account 960 in the sample Chart
of Accounts and in step 4 above). Do this by entering a new record to the
Transaction register dated the last day of the year just ended. If your
company made a profit, this Transaction should debit the Special
Account for Y/E profit Postings (Account 99999 in step 4 above) and
credit the Result of Current Fiscal Year Account with the value noted in
step 6. If your company made a loss, the debits and credits should be
reversed.

8. Save the Transaction and print the Balance Sheet and Trial Balance to
screen. You should now find that the YTD Profit figure on the Balance
Sheet is zero, and the Balance Sheet should balance. Finally, check that
your Trial Balance report for the last year still balances.

9. You should now bring the profit/loss figure forward to the next year. Do
this by entering a new record to the Transaction register dated the first
day of the new year (you will need to update the Fiscal Years setting as
described in step 10 below before you can do this). If your company
made a profit, this Transaction should debit the Result of Current Fiscal
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Year Account and credit the Retained Earnings Account (Account 970 in
step 4 above) with the value noted in step 6. If your company made a
loss, the debits and credits should be reversed.

The result of the two Transactions in steps 7 and 9 is that the forward
balance for Account 960 will be the result of the previous year in the
Balance Sheet for the next year. The final balance for Account 970 will
be the accumulated results of all previous years in the Balance Sheet for
the next year.

Some work should now be done to ensure you are ready for the new year.
Follow these steps—

10. Using the Fiscal Years setting in the System module, register the new
financial year on the first blank line. Do not insert the new year at the
top of the list because Fiscal Years have to be listed in chronological
order. Do not remove past Fiscal Years. Click [Save] to save.
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11. You should now define the periods that you will commonly use when
producing reports. This is done using the Reporting Periods setting,
again in the System module. In this case, you should insert the new
periods at the top of the list because the first period in the list is offered
as a default whenever you produce a report. To insert a new period at the
top of the list, click on row number 1 and press the Return key. Enter the
Reporting Periods that you need and click [Save] to save.

12. If you are using Number Series that are date dependent, you should
update them to take account of the new year. This is particularly
important for Number Series that will be used when generating records
remotely (e.g. Deliveries and Invoices from Sales Orders). There are
many Number Series settings in various modules in FirstOffice: be sure
to change every one that you have used.
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Don't forget to make sure that any defaults set in the Number Series
Defaults setting in the System module refer to Number Series in the new
year.

Further details of each of these steps can be seen in the sections describing
the respective functions in the ‘System Module’ and ‘Nominal Ledger’
chapters elsewhere in these manuals.
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Chapter 4: Starting Work with FirstOffice

Entering Data and Opening Balances

If you have been following this manual in sequence, you should by now have
created a new database into which you have entered information about your
company, the current Fiscal Year, a set of VAT Codes and a Chart of
Accounts. If this is not the case, please turn back to the ‘Starting FirstOffice’
section on page 34 of the ‘Introduction and Installation’ chapter before
proceeding.

Settings
As you start using each module for the first time, it is a good idea to check
the different settings in that module. Some settings have default values that
you should be aware of and may wish to change, and some represent a
special functionality that you might be able to use.

Remember, most settings are
imported automatically when a new
database is created. If you alter the
Chart of Accounts, you will probably
have to change any settings that use
Account Codes as well.

Persons
One of your first tasks in creating a new database should be to enter details of
each member of your staff in FirstOffice. You will do this using the Person
register in the System module. One reason for doing this is to protect your
data: the Person register allows you to assign a password to each user. It's a
good idea to do this even in a single-user system: protecting your database
with a password might prove to be a wise precaution if your computer is
stolen. In multi-user systems, you can also use the Person register together
with the Access Groups setting (also in the System module) to restrict the
access each member of staff has to FirstOffice to the modules and function
that are relevant to their job.

It is not necessary to restrict this process to members of staff that will be
using FirstOffice. For example, someone that will not use FirstOffice should
still be recorded in the Person register if you want their sales to be recorded
in their name in the Invoice and Order registers.

!
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Before entering Persons, you may wish to define Access Groups: these are
described on page 307 in the ‘System Module’ chapter elsewhere in this
Volume.

To enter details of your personnel to the Person register, follow these steps—

1. Select the System module using the [Select Module] button in the Master
Control panel.

2. Open the Person register by clicking the [Persons] button in the Master
Control panel. If you are using a new database, a blank browse window
will appear. Otherwise, it will list all Persons previously entered.

3. Click the [New] button in the Button Bar at the top of the browse
window.

Use the ‘Person: New’ window shown below to enter information about
a member of staff. For full details about each field on the screen, please
refer to page 337 in the ‘System Module’ chapter later in this manual.

When you enter a Person’s initials in the Signature field, note that where
there is more than one Company in the database, records in the Person
register are specific to the Company in which they were entered.
However, if you have the CRM and Mail Value Pack and will be using
Mailboxes, each Person’s Mailbox will be open to all Companies in the
database. This allows mail to be sent between Persons in different
Companies. One implication of this is that all Persons across all
Companies should have different Signatures (initials). If there are two or
more Persons in different Companies with the same Signature, they will
not be able to have their own Mailbox.

4. Click the [Save] button in the top right-hand corner of the window. The
record is saved in the Person register.
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5. The window title changes to ‘Person: Inspect’, giving you a chance to
check you have not made any mistakes in entering the record.

6. Close the record by clicking the close box or using the Ctrl-F4
(Windows and Linux) or -W (Macintosh) keyboard shortcut.

7. If you have a number of personnel to enter, click [New] instead of [Save]
at step (4) above (or use the Ctrl-N/-N keyboard shortcut). The Person
record is saved and closed, and a blank window is opened, allowing you
to enter another record straight away.

8. When you close the last Person record at step 6 above, you will be
returned to the ‘Persons: Browse’ window, which now lists the members
of staff that you have just registered. Click on each one in turn and
allocate a password by selecting ‘Change Password’ from the Operations
menu.

If you have the CRM and Mail Value Pack, you should now create a Mailbox
for each Person. Mailboxes allow members of staff to send and receive mail.
If you do not have the CRM and Mail Value Pack, each Person must have a
Mailbox if they are to be able to use the Personal Desktop.

In contrast to the Person register, you should only create Mailboxes for
members of staff that will be using FirstOffice.

Before creating Mailboxes, you should first make sure that you have
recorded the correct number of Mailboxes in the Configuration setting in the
System module. This is described on page 44 in the ‘Introduction and
Installation’ chapter elsewhere in this Volume.

To create a Mailbox, follow these steps—

1. With the ‘Persons: Browse’ window still open, click on each Person in
turn and then select ‘Create Mailbox’ from the Operations menu.

2. The ‘Mailbox/Conference: New’ window opens, containing default
information taken from the Person that you selected. For full details
about each field on the screen, please refer to the ‘Mail’ chapter in
Volume 4 of these manuals.
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3. Click the [Save] button in the top right-hand corner of the window.

Entering the First Customer
FirstOffice keeps all information about Customers and Suppliers together in
a single register, the Customer register, with one record for each company.
All other companies (e.g. leasing companies, factoring companies, sales
leads, etc) should be stored here as well.

Before recording companies in the Customer register, you should first make
sure all relevant Payment Terms (used to calculate Due Dates and settlement
discounts in Invoices) have been entered in the Payment Terms setting. This
is described in the ‘Sales Ledger’ chapter in Volume 2 of these manuals. You
may also wish to define Customer and Supplier Categories (used to group
together companies of a similar type): these are described on pages 225 and
226 respectively in the ‘Customers and Suppliers’ chapter elsewhere in this
Volume.

To enter your first record in the Customer register, follow these steps—

1. Select the Sales or Purchase Ledger or the Sales Support module using
the [Select Module] button in the Master Control panel. The same
Customer register is available in all three modules.

2. Open the Customer register by clicking the [Customers] button in the
Master Control panel. If you are using a new database, a blank browse
window will appear. Otherwise, it will list all Customers previously
entered.

3. Click the [New] button in the Button Bar at the top of the browse
window.

Use the ‘Customer: New’ window shown below to enter data about the
company. For full details about each field on the screen, please refer to
page 228 in the ‘Customers and Suppliers’ chapter later in this manual.
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If in step 1 you opened the Customer register from the Sales Ledger or
the Sales Support module, the new record will be marked as a Customer
automatically. If you opened the Customer register from the Purchase
Ledger, the new record will be marked as a Supplier automatically.

4. Click the tabs (named ‘Contact’, ‘Delivery’, ‘Terms’ and ‘Company’) to
enter more information about the Customer.

5. Click the [Save] button in the top right-hand corner of the window. The
Customer is saved in the Customer register.

6. The window title changes to ‘Customer: Inspect’, giving you a chance to
check you have not made any mistakes in entering the record.

7. Close the record by clicking the close box or using the Ctrl-F4
(Windows and Linux) or -W (Macintosh) keyboard shortcut.

8. If you have a number of Customers to enter, click [New] instead of
[Save] at step 5 above (or use the Ctrl-N/-N keyboard shortcut). The
Customer is saved and closed, and a blank window is opened, allowing
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you to enter another Customer straight away. If you need to enter
Customers, it's a good idea at step 1 above to open the Customer register
from the Sales Ledger or the Sales Support module. All new records will
be marked as Customers automatically. If you need to enter Suppliers,
open the Customer register from the Purchase Ledger to ensure all new
records are marked as Suppliers automatically.

It is a good idea to repeat the above process for a few Customers in order to
familiarise yourself both with the data entry process and with the Customer
entry screen. However, if you are changing to FirstOffice from another
computer program, it is likely that you will want to import your Customers
from a text file created by your old system. If you wish to do this, please
follow the import instructions described in the section ‘Setting up a Basic
Accounts System’ on page 54 in the ‘Introduction and Installation’ chapter to
import your text file. This procedure, although described there as being used
to import a Chart of Accounts, is in fact an all-encompassing import function
which will bring in whatever is in the selected text file and save it in the
appropriate place in FirstOffice. For details of the composition of the text file
(field order, etc), please refer to your FirstOffice representative.

Entering the First Item
FirstOffice keeps all information about Items and prices in an Item register,
with one record for each Item. The Item register contains basic data about all
products and services sold by your business.

Before entering Items, you may wish to define Item Groups (used to group
together Items of a similar type): these are described on page 272 in the
‘Items and Pricing’ chapter elsewhere in this Volume.

To enter your first Item, select the Sales Ledger, Sales Support module or
Stock module using the [Select Module] button in the Master Control panel.
Using the Item register, follow the same basic process described above on
page 203, under ‘Entering the First Customer’.

For full details about each field in the ‘Item: New’ window, please refer to
page 279 in the ‘Items and Pricing’ chapter later in this manual.

If you wish to import Items from your old accounts system, please follow the
import instructions described in the section ‘Setting up a Basic Accounts
System’ on page 54 of the ‘Introduction and Installation’ chapter to import a
text file created by that system. For details of the composition of this text
file, please refer to your FirstOffice representative.
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Entering Opening Balances
Unless you are starting a new business and intend to use FirstOffice to
administer your accounts from the first day, you will need to enter some
opening balances. If you are starting to use FirstOffice at the beginning of the
fiscal year, these opening balances will take the form of the closing balances
for each Account for the end of the previous year. If you are starting to use
FirstOffice in the middle of the fiscal year, there will be two components to
opening balance figures: the closing balances for each Account for the end of
the previous year and Account balances for the current year to date.

To carry out this task, you should equip yourself with as much information as
you can in the form of transaction data and reports produced by the old
system, in order to make this task as easy as possible.

We recommend that you change during a current financial year. You should
enter Account balances for the previous year and then enter individually all
current year transactions registered so far. This will a) make you familiar
with FirstOffice, and b) automatically give you a check of the old
transactions.

You should already have specified the current and, if appropriate, previous
financial years using the Fiscal Years setting and entered the Chart of
Accounts and VAT Codes you wish to use. Normally you will be able to use
the Chart of Accounts included in the program. If this is not suitable, you can
import your own chart from a text file or enter it manually. For more
instructions about this process, please refer to the section entitled ‘Setting up
a Basic Accounts System’ on page 54 in the ‘Introduction and Installation’
chapter.

Once you have entered your Fiscal Year, Chart of Accounts and VAT Codes,
it’s a good idea to enter all the opening balances at once. Ideally, this process
should be completed before you start to enter new Transactions, but it is
possible to change the opening balances at any time during the financial year.

When entering opening balances, the level of detail is up to you. Factors
influencing this decision may be the number of Transactions, the time
available to enter these Transactions, whether they can be imported
(otherwise, you will have to enter them manually) and the level of detail
required in your reports. It might be that you enter or import all Transactions
individually (in the form of Invoices, Receipts, Purchase Invoices, Payments
and Nominal Ledger Transactions) or it might be that you enter a single
opening balance for each Account. Full details covering the necessary data
entry processes follow in the next sections.

Once you have entered your opening balances in their chosen form, print the
reports you usually use and compare them with the reports from your old
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system. These reports should include the Trial Balance, Profit & Loss and
Balance Sheet from the Nominal Ledger, and Debtors and Creditors reports
from the Sales and Purchase Ledgers respectively.

Opening Balances in the Nominal Ledger
In the Nominal Ledger, the task of entering opening balances has two stages.
First, it is recommended that you enter balances for each Account as they
stood at the end of the previous fiscal year. Use the Brought Forward
Balances register for this task. This information should be available on the
Trial Balance report obtained from your old system. Then, if appropriate,
enter Transactions for the current year to date, using the Transaction register.

Once you have entered all Balances and Transactions, print out a Trial
Balance and compare it with that obtained from your old system. Any
discrepancies should be investigated immediately: any delay will make this
more difficult.

The following section assumes you have already defined a Chart of Accounts
and a set of VAT Codes. To enter Account balances as they stood at the end
of the previous financial year to the Nominal Ledger, follow these steps—

1. Select the Nominal Ledger module using the [Select Module] button in
the Master Control panel.

2. Click the [B/FW Balances] button in the Master Control panel.

3. Click [New] on the Button Bar.

4. Enter the information as shown in the following illustration. Full details
of the fields are to be found in the chapter covering the Nominal Ledger
in Volume 2 of these manuals. It is recommended that you choose a
Transaction Date that is at the end of the previous fiscal year and that is,
in any case, prior to the date when you will be starting work with
FirstOffice.
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5. The Brought Forward Balances screen does not have an OK check box,
so Account Balances are updated as soon as the record is saved.
Therefore, before clicking [Save], make sure that no mistakes have been
made. One check is that the Debit and Credit totals are the same. If you
discover a mistake at a later date, you will be able to correct the record
without difficulty.

6. Finish with [New] (or use the Ctrl-N/-N keyboard shortcut) if you
wish to enter more Balances.

7. If you are using Objects, you should enter a separate record to the
Brought Forward Balances register for each Object and one for the total.
For example, if you have a Cash Account with a balance of 100.00 that
is divided between two departments so that 49.00 belongs to Department
1 and 51.00 to Department 2, enter three Brought Forward Balance
records as follows—

1st record, Cash Account, no Objects, total figure (100.00)
2nd record, Cash Account, Object for Dept 1, figure for Dept 1 (49.00)
3rd record, Cash Account, Object for Dept 2, figure for Dept 2 (51.00)
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8. Finish with [Save] when you have entered the last Balance, and close the
window by clicking the close box.

If you are starting to use FirstOffice in the middle of a financial year, you
should now enter the Transactions for the current year so far. You should
enter these from the original documentation, and do not copy them from
Transaction Journal reports produced from your old system. This will ensure
that you do not enter any Transactions that relate to the Sales or Purchase
Ledgers. These will be entered later. Follow these steps—

1. Using the [Select Module] button in the Master Control panel, ensure
you are in the Nominal Ledger.

2. Click the [Transactions] button in the Master Control panel.

3. Click [New] on the Button Bar.

4. Enter the information as shown in the following illustration. Full details
of the fields are to be found in the chapter covering the Nominal Ledger
in Volume 2 of these manuals. Ensure you use the same Transaction
Date that was used when entering the Transaction to your previous
system.
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5. The Transaction screen does not have an OK check box, so Account
Balances are updated as soon as the Transaction is saved. Therefore,
before clicking [Save], make sure that no mistakes have been made. One
check is that the Debit and Credit totals are the same.

6. Finish with [New] (or use the Ctrl-N/-N keyboard shortcut) if you
wish to enter more Transactions.

You can use another feature when you need to enter several Transactions
quickly in one sitting and don’t want to interrupt your typing by reaching
for the mouse. Enter the debits in a Transaction first and then, with the
cursor in the Credit field in the final credit row, press the Return or Enter
key twice. The first pressing causes FirstOffice to enter the correct credit
amount to balance the entry for you. The second saves, closes and
commits the Transaction to the Nominal Ledger and opens a new,
empty, Transaction.

7. Finish with [Save] when you have entered the last Transaction, and close
the window by clicking the close box.
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Opening Balances in the Sales Ledger
It is worth repeating that there can be two components to opening balance
figures in the Sales Ledger: the final Customer balances from the previous
fiscal year and, if you will be starting to use FirstOffice in the middle of a
fiscal year, Customer balances for the current year to date.

In considering Customer balances from the previous year, it is only necessary
to take account of those that are open (i.e. unpaid). These can be entered in
one of two ways—

• as a single outstanding balance for each Customer; or

• as separate Invoices per Customer.

In considering Customer balances for the current year to date, the following
options are available—

• the minimum is to enter a balance for each Customer as a single figure
(in fact, you will need to enter an Invoice total and a Receipt total,
representing totals for the current fiscal year to date, enabling you to
reconcile your bank account and to keep your Aged Debtor report
accurate);

• the opposite extreme is to enter all Invoices raised so far in the current
fiscal year, and all Receipts;

• a compromise route to reduce the amount of work required is to enter
monthly Invoice and Receipt balances for each Customer;

• a final option, available if you are changing to FirstOffice from an older
computerised system, is to import the current year’s Invoices and
Receipts from a text file. Please refer to your local FirstOffice
representative if you would like to consider this option.

In deciding which procedure to use, one factor to consider is credit control. If
you need to produce statements that show details of previous Invoices, it will
not be enough to simply enter a total balance for each Customer. Instead, you
will need to enter individual Invoices and Receipts. If, however, you do not
issue statements or it is acceptable for a single opening balance figure to
appear on your statements, entering a single opening balance figure per
Customer will be sufficient. If you do not issue Invoices or you do not give
credit, it may not be necessary to enter any opening balances at all in the
Sales Ledger.

If you need to enter opening balances in the Sales Ledger, you should first
ensure that all Customers have been entered using the process described in
the section entitled ‘Entering the First Customer’ above on page 203. If you
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are entering individual Invoices, you should also ensure that all Items have
been entered. Depending on your old system, you may be able to import this
information from text files. Finally, if you are entering Receipts in any form
(i.e. individual Receipts, or monthly or year-to-date Receipts) make sure all
relevant Payment Modes have been entered, so that the Receipt amounts can
be posted to the correct Bank or Cash Account. Payment Modes are
described below on page 214.

Nominal Ledger Settings
Enter Sales Ledger opening balances in the form of Invoices and Receipts. In
the case of balances brought forward from the previous fiscal year, they
should be Invoices and Receipts that will not be posted to the Nominal
Ledger if you have already entered previous-year Nominal Ledger opening
balances to the Brought Forward Balances register as described in the
previous section on page 207. The Nominal Ledger opening balances include
balances for the Accounts affected by Invoices and thus to post to those
Accounts from opening balance Invoices is to post the same amounts twice.
Therefore, before Sales Ledger opening balances can be entered, a setting in
the Nominal Ledger needs to be considered to ensure that they will not be
posted.

Using the [Select Module] button in the Master Control panel, ensure that
you are in the Nominal Ledger. Click the [Settings] button in the Master
Control panel or select ‘Settings’ from the File menu. In the subsequent list,
double-click ‘Sub Systems’. The following window appears—

Specify by clicking the check boxes the transactions (‘Sub Systems’) that are
to create Nominal Ledger Transactions automatically. In the illustration, for
example, approving and saving an Invoice with a Transaction Date later than
1/1/2005 will cause a Nominal Ledger Transaction to be created
automatically. If the Transaction Date is earlier than 1/1/2005, a Nominal
Ledger Transaction will not be created.
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It is recommended that for each Sub System you enter the first day of your
fiscal year. When you enter previous-year opening balances, use a
Transaction Date prior to that date. This will ensure that Nominal Ledger
Transactions are created when expected and that they are not created for
opening balances. If it takes longer than expected to enter opening balances,
you can continue doing so (using early Transaction Dates) and start to issue
new Invoices without needing to worry about the consequences in the
Nominal Ledger.

If you are starting to use FirstOffice in the middle of a financial year, you
should already have entered the Nominal Ledger Transactions for the current
year so far, as described in the ‘Opening Balances in the Nominal Ledger’
section above on page 207. If, as was recommended, you entered these from
the original documentation and did not copy them from Transaction Journal
reports produced from your old system, you will not have any current year
Transactions that relate to the Sales or Purchase Ledger. These will now be
created automatically from the Invoices and Receipts (and Purchase Invoices
and Payments) that you are about to enter, providing that their Transaction
Dates are later than the Sub System Date (the first day of your fiscal year). If
you did enter current year Transactions relating to the Sales or Purchase
Ledger as part of the previous exercise, you will not want them created again
when you enter Invoices and Receipts. In this case, make the Sub System
Date later (a few days before the date you start using FirstOffice to originate
transactions). This means you will be able to enter Invoices for the current
year to date and to issue new Invoices simultaneously without needing to
worry about the consequences in the Nominal Ledger.

If you are not certain whether you have entered current year Transactions
relating to the Sales or Purchase Ledger, produce a Trial Balance report for
the current year and check the balances for your Sales, Purchase, Debtor and
Creditor Accounts. If these are zero, you have not entered these Transactions.
If they are the same as those on the Trial Balance produced from your old
system, you have entered these Transactions already. Please refer to the
section below on page 221 entitled ‘Printing Reports’ for instructions about
printing a Trial Balance report.

Once the Sub Systems setting is to your satisfaction, save and close the
window by clicking [Save] in the Button Bar.
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Note that if you have entered
previous-year opening balances in
the Nominal Ledger, you should not
post any Sales, Purchase or Stock
opening balances to your Nominal
Ledger. To do so will duplicate the
work you have already done and will
immediately render your accounts
inaccurate.

Sales Ledger Settings
Before entering the first opening balance, there is a single setting in the Sales
Ledger that needs to be considered if you will be entering Receipts for the
fiscal year to date.

Use the [Select Module] button in the Master Control panel to enter the Sales
Ledger and click the [Settings] button, also in the Master Control panel.
Double-click ‘Payment Modes’ in the subsequent list.

Payment Modes represent the different methods that your Customers will use
to pay your Invoices and you will use to pay your Suppliers. Typical
examples are cash, cheque, direct debit and credit card. If necessary,
FirstOffice allows each Payment Mode to debit a different Account and to be
paid into a different bank account.

If you have used the accounts template supplied with FirstOffice, you will
find that the basic Payment Modes have already been entered. If you have
modified the Chart of Accounts supplied, or you have created your own,
ensure that the Account Code shown in the fourth column now refers to the
correct Account (remember, you can use ‘Paste Special’ if necessary).

!
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To create a new Payment Mode, simply click in the first blank row and enter
a unique Code. Then enter the other details as appropriate, referring to the
‘Sales Ledger’ chapter in Volume 2 of these manuals if necessary. Click flip
B to complete the entry.

Click [Save] when you have finished.

Opening Balances
The process described below applies to the entering of opening balances both
from the previous fiscal year and for the current year to date.

You are now ready to enter the first Invoice. If you are entering a single
opening balance figure per Customer, either for the previous fiscal year or for
the current year to date, you will need to do this by entering it in an Invoice.
If so, omit step 7 in the following procedure. Do this—

1. If you are not already in the Sales Ledger module, move into it using the
[Select Module] button in the Master Control panel.

2. Click the [Invoices] button in the Master Control panel to open the
Invoice register.

3. Click [New] in the Button Bar.
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4. In the ‘Invoice: New’ window three fields are already filled in: the
Invoice Number (except in multi-user systems) and the Invoice and
Transaction Dates (which show the current date taken from the system
clock). If you are entering a single opening balance figure for each
Customer, you might like to use a separate numbering sequence for
opening balances (use the Number Series - Invoices setting in the Sales
Ledger to set up numbering sequences). If you are entering individual
Invoices, you will need to use the Invoice Number and Date of the
original Invoice. In multi-user systems, an Invoice Number will be
allocated when the Invoice is saved: when entering individual Invoices
for the current year to date, to ensure each Invoice retains the number
with which it was originally issued, it is recommended that you enter
these Invoices in number order from a single client computer to ensure
each Invoice retains the number with which it was originally issued. You
can enter the Invoice Number yourself before you save the Invoice for
the first time to be sure that it is correct.

5. Place the insertion point in the Customer field and select ‘Paste Special’
from the Edit menu or use the shortcut (Ctrl-Return - Windows/Linux or
-Return - Macintosh). The ‘Paste Customer’ window appears, showing
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a list of the Customers recorded in the Customer register. Select a
Customer by clicking on its row and press the Return key twice. The
first pressing causes the Customer Number to be transferred to the field
in the Invoice, and the second will move all information about the
Customer (Name, Address etc.) to the Invoice.

6. Use the Return key to move the insertion point to the Date field. In the
case of Customer balances from the end of the previous fiscal year,
ensure that this is set to a date that is earlier than the cut-off date you
specified in the Sub Systems setting.

7. If you are entering individual Invoices, move the insertion point to the
Item field and press Ctrl-Return or -Return again. Select the correct
Item from the list and press Return twice. The insertion point is moved
to the Qty field. Enter the number of items ordered, and press Return.
Check that the Unit Price is correct and repeat for each item on the
Invoice.

8. If you are entering single opening balances, move the insertion point to
the Qty field and enter a quantity of 1. Press Return and enter the text
“Opening Balance” in the Description field. Enter an amount (excluding
VAT) in the Unit Price field.

9. Until you are familiar with the Invoice screen, it is a good idea to check
that every field is correct. Clicking the named tabs marked ‘Delivery’,
‘Inv. Address’, etc causes different information about the Invoice to be
shown, while the tabs marked A-D display further information about the
Invoice items. Pay particular attention to the Sales Account and VAT
Code fields on flip B. These defaults are taken from the Item record or,
if not specified there, from the Account Usage S/L setting. It will be the
latter, in the case of single opening balances as then you are not referring
to the Item register.

10. At the bottom of the Invoice the total is shown, together with the VAT
amount and the total payable amount.

11. Click [Save] to save the Invoice.

The window title changes to ‘Invoice: Inspect’. You can now correct any
mistakes before you click the OK check box. With the OK box checked,
clicking the [Save] button in the Button Bar once again approves the
Invoice and commits it to your Sales Ledger. After this you may not
change the individual fields. Invoices must be approved before Receipts
can be allocated to them and to appear in the Periodic Customer
Statement.
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12. Finish with [New] if you wish to enter another Invoice. Or, if you are
entering all Invoices for the current fiscal year, click [Duplicate]. This
will create a new Invoice which will be a copy of the one just saved.
This will save you having to enter Customer details, etc, again if they are
the same.

13. Finish with [Save] when you have entered the last Invoice, and close the
window by clicking the close box.

Entering Receipts
As with entering Invoices, you can get a lot of help with entering your
Receipts using FirstOffice’s built-in shortcuts. Perhaps the most useful tool is
the ‘Paste Special’ command. ‘Paste Special’ can be used whenever you
enter data in a field that refers to a register or setting in FirstOffice.

There is no need to enter any Receipts from the previous fiscal year, because
you should only have entered outstanding Invoices from that year. You
should only follow the steps described below for Receipts from the current
year to date, and thus they are only applicable if you are starting to use
FirstOffice in the middle of a fiscal year.

1. Open the ‘Receipts: Browse’ window by clicking the [Receipts] button
in the Sales Ledger.

2. Click [New] or use the keyboard shortcut Ctrl-N (Windows and Linux)
or -N (Macintosh).

3. The ‘Receipt: New’ window is shown. You can use a single window to
enter all your Receipts from the earlier part of the year, even if they use
different Payment Modes.
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4. Enter the data in the top of the window. Select a Payment Mode using
‘Paste Special’ to open the list of Payment Modes you created earlier.
Make sure the Transaction Date is correct.

5. For each Receipt, enter the Invoice Number in the first column (or use
‘Paste Special’ to choose an unpaid Invoice) and press the Return key.

6. If you have an Invoice that is part-paid, alter the Received Value field to
show the amount paid.

7. If any receipt uses a different Payment Mode to that specified in the top
of the window, move to flip C to enter a Payment Mode to be used for
that row only. Again, use ‘Paste Special’ to ensure the correct one is
selected.

8. When you have entered every receipt, you should check what you have
entered. If you find any errors you can change them as needed. When
you are satisfied, click the OK check box in the lower left-hand corner.

9. When you click [New] or [Save], the Receipt is approved and after this
may not deleted or changed.
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Opening Balances in the Purchase Ledger
When entering opening balances in the Purchase Ledger, you should follow
the same basic decisions and procedures described in the Sales Ledger
section above on page 211, using the Purchase Invoice and Payment registers
in the Purchase Ledger. Before entering opening balances, use the Sub
Systems setting in the Nominal Ledger to make sure that your previous year
Purchase Ledger opening balances will not be posted to the Nominal Ledger,
as described in the Sales Ledger section above.

Opening Balances in the Stock Module
When entering opening balances in the Stock module, the precise procedure
to be followed will be determined by the nature of your business and the
Items that are sold. Again, as in the Sales Ledger, the accuracy of the
opening balances increases with the level of detail entered, but the time
required by the task increases as well.

You should decide whether to—

• enter each example of each Item in stock at the moment of implementing
FirstOffice. You may prefer this option if the cost price of each Item is
often subject to fluctuation;

• enter a single line for each Item together with a quantity and an average
purchase price; or

• use a combination of the two methods.

Before entering opening balances in the Stock module, you should first
ensure that all Items have been entered using the process described in the
‘Entering the First Item’ section above on page 205. Ensure that, for each
Item whose stock levels are to be maintained, the Stocked Item option on the
‘Pricing’ card is selected. Depending on your old system, you may be able to
import Item data from text files.

You should also use the Sub Systems setting in the Nominal Ledger to make
sure that your Stock opening balances will not be posted to the Nominal
Ledger, as described in the Sales Ledger section above on page 211.

When entering opening balances in the Stock module, follow the same basic
procedures described in the Sales Ledger section above, using the Goods
Receipt register.

Importing Opening Balances
If you are changing to FirstOffice from another computer program, it is likely
that you will want to import opening balances for all three ledgers from text
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files created by your old system. If you wish to do this, please follow the
import instructions described in the section ‘Setting up a Basic Accounts
System’ on page 54 in the ‘Introduction and Installation’ chapter to import
your text file. This procedure, although described there as one used to import
a Chart of Accounts, is in fact an all-encompassing import function which
will bring in whatever is in the selected text file and save it in the appropriate
place in FirstOffice. For details of the composition of the text files, please
refer to your FirstOffice representative. Ensure that they contain opening
balances as they were at the beginning of the fiscal year and all subsequent
transactions as described in the previous sections.

Printing Reports
FirstOffice can produce many different reports. Detailed descriptions of each
one will be found in the chapters describing each module. You should,
however, always print a Transaction Journal for the Transactions entered
during one work session. The same goes for the Invoice Journal in the Sales
Ledger.

Having completed the process of entering your opening balances, you should
now print a Trial Balance and compare it with a Trial Balance produced from
your old system.

To print a Trial Balance, follow these steps—

1. Ensure you are in the Nominal Ledger module using the [Select Module]
button in the Master Control panel and click the [Reports] button, also in
the Master Control panel.

2. The following window is shown.
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3. Scroll to the bottom of the list and choose ‘Trial Balance’ by double-
clicking, or press the “T” key twice and then press the Return or Enter
key. The ‘Specify Trial Balance’ window appears.

4. In the ‘Specify Trial Balance’ window, enter the range of transactions
you wish to print. To report on your opening balances, you should enter
a period from the beginning of the current fiscal year to the current date.
Separate the start and end dates of this period using a colon (:), as shown
in the illustration. You can leave all the other fields blank, ensuring that
all Accounts etc will be included in the report.

5. Use the Media options at the bottom of the window to choose a print
destination (for example, ‘Printer’ or ‘Screen’), and click the [Run]
button to produce the report.

6. If you printed to screen and now wish to print on a printer, simply click
the Printer icon in the Button Bar of the report window.
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Chapter 5: Customers and Suppliers
Information about your Customers, Suppliers and all other companies with
whom you have some contact is stored in the Customer register. This register
is available in the Sales Support module and in the Sales and Purchase
Ledgers. Storing Customers, Suppliers and other companies together in one
register means that you can make full use of the Calendar, Task Manager,
Mails and Letters with companies of all kinds (the last two require you to
have the appropriate Value Packs). It also means that you will only have to
maintain a single record for a company who is both a Customer and a
Supplier.

Throughout these manuals (including in the index), the term “Customer” is
usually used when describing the use of a record in the Customer register in a
sales context, while “Supplier” is used in a purchase context. “Supplier”
implies that the Supplier box in the header of the Customer record has been
checked.

On the sales side, you can group Customers of a similar type together using
Customer Categories. Every Customer belonging to a Category will be given
the same default Price List and Debtor Account, saving you the work of
having to specify these in each individual Customer record. Defining and
assigning Customer Categories also makes modification easier: if it is
necessary to assign a different Debtor Account, for example, you only need
to make one change (to the Customer Category), rather than many (to each of
the Customer records). If you specify information both for a Customer
Category and in the Customer record on an individual company belonging to
that Category, the information entered in the Customer record will take
precedence. For example, if you specify a Price List in a Customer Category
and in a Customer belonging to that Category, the one in the Customer will
be used.

Similarly, on the purchase side you can group Suppliers of a similar type
together using Supplier Categories. All Suppliers belonging to the same
Category can be given the same default Creditor Account, saving you the
work of having to specify this for all Suppliers individually. A company that
is both a Customer and Supplier can belong both to a Customer Category and
to a Supplier Category.

This chapter first describes the defining of Customer and Supplier Categories.
This is followed by a detailed description of the Customer register and of
Customer-related reports.
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Prior to FirstOffice and Office/2 version 4.1, Customers and Suppliers were
stored in separate registers. In this version, the two registers were made into
one. When you update to this or a later version, you can use the ‘Convert
Suppliers to Customers’ Maintenance function in the System module to bring
the information in the two registers together. This is described in the section
entitled ‘Combining Customers and Suppliers’ below on page 246.

Settings

Customer Categories

Customer Categories are defined using the setting in the Sales Ledger. Use
the [Select Module] button in the Master Control panel to enter the Sales
Ledger and then select ‘Settings’ from the File menu or click the [Settings]
button, also in the Master Control panel. Double-click ‘Customer Categories’
in the resulting list. Then click [New] to open a new record, or double-click
an existing record to modify it.

Code Specify a unique code, by which the Customer Category
may be identified from the Customer screen and
elsewhere in FirstOffice.

Description Enter text describing the Customer Category here.

Price List Paste Special Price Lists setting, Sales Ledger

Used as default in Customers, Sales Orders, Sales
Invoices

The Price List entered here determines the prices used in
Sales Orders and Sales Invoices for all Customers



HansaWorld FirstOffice Professional

226

belonging to this Category. Price Lists are described in
the next chapter, ‘Items and Pricing’ (page 293).

Debtors Account Paste Special Account register, Nominal
Ledger/System module

Specify here the Debtor Account that you wish to be
debited by the Nominal Ledger Transactions created
when Sales Invoices are raised for Customers that
belong to this Category. In the example shown in the
illustration above, a Customer Category has been
defined to post Invoices for all Customers with credit
accounts to a special Nominal Account.

Note that you can only specify a Debtor Account at the
Customer Category level, not at the individual Customer
level. If you do not specify a Debtor Account in a
Category, the Debtor Account specified in the Account
Usage S/L setting in the Sales Ledger will be used.

If you have Sub-ledger Checking switched on, any
Account entered here must first be defined as a Debtor
Control Account. Sub-ledger Checking is switched on
using the check box on the ‘Debtors’ card of the
Account Usage S/L setting, and Control Accounts are
defined using the Control Accounts setting in the
Nominal Ledger.

Supplier Categories

You can group Suppliers of a similar type together using Supplier Categories.
All Suppliers of the same Category can be given the same default Creditor
Account, saving you the work of having to specify this for all Suppliers
individually.

If you specify a Creditor Account both for a Supplier Category and for a
Supplier that belongs to that Category, the Account entered for the Supplier
will take precedence. If you do not specify a Creditor Account for a Category
or a Supplier, the Creditor Account specified in the Account Usage P/L
setting (‘Creditors’ card) will be used. If you are using Sub-ledger Checking,
any Creditor Account specified in a Supplier Category must first be defined
as a Creditor Control Account. Sub-ledger Checking is switched on using the
check box on the ‘Creditors’ card of the Account Usage P/L setting, and
Control Accounts are defined using the Control Accounts setting in the
Nominal Ledger.
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Supplier Categories are defined using the setting in the Purchase Ledger. Use
the Modules menu to enter the Purchase Ledger and then select ‘Settings’
from the File menu or click [Settings] in the Master Control panel. Double-
click ‘Supplier Categories’ in the resulting list. The ‘Supplier Categories:
Browse’ window is displayed, showing all Categories previously entered.
Click [New] to enter a new record, and [Save] to save it.
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The Customer Register
The Customer register is where you store information about every company
with whom you have contact, be they Customers, Suppliers, shipping
companies, factoring or leasing companies or sales leads. The register is
accessible from the Sales Support module and the Sales and Purchase
Ledgers. To open the register, use the [Select Module] button in the Master
Control panel to enter either of these modules and click the [Customers]
button, also in the Master Control panel.

The ‘Customers: Browse’ window is opened, showing all Customers already
entered.

Entering a Customer

To enter a new record in the Customer register, click [New] in the Button Bar
or use the Ctrl-N (Windows and Linux) or -N (Macintosh) keyboard
shortcut. Alternatively, highlight a record similar to the one you want to enter
and click [Duplicate] on the Button Bar.

The ‘Customer: New’ window is shown, empty if you clicked [New] or
containing a duplicate of the highlighted record.

Since the amount of information stored about each company will not fit in a
single window, the Customer screen has been divided into four cards. At the
top of each is the header. This contains the Customer Number, Short Code,
Customer and Supplier Categories, Customer and Supplier check boxes,
Name and Department. There are four named buttons (‘tabs’) in the header.
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By clicking the tabs you can navigate between cards. The header is always
visible, as a reminder of the Customer you are working with.

Below, the Customer screen is described field by field. The entry of
Customer information often requires reference using ‘Paste Special’ to
settings entered in the Sales Ledger or Sales Support modules. Where use of
‘Paste Special’ is appropriate, this is indicated in the text. Apart from
Customer and Supplier Categories (described above on pages 225 and 226
respectively), please refer to the ‘Sales Ledger’ or ‘Sales Support’ chapters in
Volumes 2 and 3 respectively of this manual for full details of a particular
setting.

Header

No. Enter the unique code you are assigning to this company:
this is the means by which this company will be
identified elsewhere in FirstOffice. The field holds up to
20 letters and/or numbers. FirstOffice offers a default
based on the Customer Number of the previous record
entered. Once you have saved the record, you cannot
change the Customer Number.

Cust. Category Paste Special Customer Categories setting,
Sales Ledger

Used as default in Sales Orders, Sales Invoices

Supp. Category Paste Special Supplier Categories setting,
Purchase Ledger

Used as default in Purchase Invoices

If the company is a Customer, you can assign it to a
Customer Category. If it is a Supplier, you can assign it
to a Supplier Category.
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Customer Categories enable you to classify similar
Customers together. All Customers belonging to the
same Category can use the same default Price List and
Debtor Account, saving you the work of having to
specify these for each Customer individually.

Supplier Categories enable you to classify similar
Suppliers together. All Suppliers belonging to the same
Category can use the same default Creditor Account,
saving you the work of having to specify these for each
Supplier individually.

Customer, Supplier

Check one or both of these boxes to indicate whether the
company you are entering is a Customer or a Supplier or
both.

If you have marked a company as a Customer only, you
will be able to use it in all sales registers (e.g. Sales
Orders, Sales Invoices, Deliveries), but not in any
purchase registers. Similarly, if you have marked it as a
Supplier only, you will be able to use it in all purchase
registers (e.g. Purchase Invoices, Goods Receipts), but
not in any sales registers. Both Customers and Suppliers
can be used in Activities (i.e. in the Calendar and Task
Manager), and in Customer Letters and Mails if you
have the relevant Value Packs.

If you originally opened the Customer register in a sales-
orientated module (e.g. Sales Ledger or Sales Orders
module), the new record will be marked as a Customer
automatically. If you originally opened the Customer
register in a purchase-orientated module (e.g. Purchase
Ledger), the new record will be marked as a Supplier
automatically. Similarly, if you created the new record
by clicking the [New] button in the ‘Paste Special’
window listing Customers, these check boxes will be set
automatically depending on the context. For example, if
you entered a Sales Order, activated ‘Paste Special’ from
the Customer field and clicked [New], the new record
will be marked as a Customer.

Once you have marked a company as a Customer and
you have issued at least one Sales Order or Invoice to
that company, you will not be able to remove the check
from the Customer box. Similarly, if you have marked a
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company as a Supplier and you have received at least
one Purchase Order or Invoice from that company, you
will not be able to remove the check from the Supplier
box.

Throughout these manuals (including in the index), the
term “Customer” has been used when referring to
companies marked as Customers, and the term
“Supplier” refers to companies marked as Suppliers.

Short This field can be used as an alternative means of
identifying this company - information entered here
appears in the Short column in the ‘Customers: Browse’
window. You can give the same Short Code to
Companies of a similar nature so that they will be
grouped together in the ‘Customers: Browse’ window
when you sort it by the Short column. The field holds up
to ten letters and/or numbers.

Name Enter the Name of the company.

If you want the Customer Name to be printed as part of
the address in all documents, use the Organisation Name
option in the Form Settings setting in the System
module.

Department You can record the name of a Department here. This
might be necessary if you are dealing with several
Departments in the same company.

Alternatively, if your company has several departments,
you can specify the one responsible for relations with
this company can be recorded here.

The Customer List report can be sorted into Department
order.
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Contact Card

Inv. Address Used as default in Sales Invoices

Enter here the address to which Sales Invoices,
statements and Payments are to be sent.

Sort Key This field can be used in countries where a post code, zip
code or other area code appears on a separate line in an
address. This can be made to appear on the standard
Forms (Invoice, Delivery Note, etc).

Changed Date This field is updated automatically by FirstOffice
whenever any modification is made to the Customer
record on screen.

Attn. Paste Special Contact Person register, Sales
Support module

Used as default in Sales Orders, Sales Invoices

You can enter the name of your main contact person
here: it will be transferred as a default entry whenever
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this Customer record is used in a transaction. The ‘Paste
Special’ selection list will only show contact names for
the Customer in question (identified by Customer
Number).

Telephone, Fax, Mobile, Email, Skype Name

Enter the company’s main telephone, mobile and fax
numbers, email address and Skype name here. You
should enter extensions, direct line and mobile numbers,
e-mail addresses and Skype Names for each contact in
the Contact Person register in the Sales Support Module.

If you need to contact the company and you are using
Windows, click the [Communicate] button in the Button
Bar—

The following window opens, containing the company’s
contact details—

Subject to your computer or network having the suitable
connection software and hardware, click on a contact
method in the list on the left, and then click the
appropriate button on the right. The Skype application
will be started automatically, allowing you to call using
Skype or SkypeOut (if you clicked on a telephone
number). A new Activity window will also be opened,
allowing you to record the details of the call or contact
immediately.
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Web Site If the company has a website, enter its address (URL)
here.

Delivery Card

Del. Address Used as a default in Deliveries

Specify the Customer’s usual delivery address here.

Sales Del. Terms Paste Special Delivery Terms setting, Sales
Support module

Used as default in Sales Orders, Deliveries

Purch. Del. Terms Paste Special Delivery Terms setting, Sales
Support module

Used as default in Purchase Orders (if you have
the Purchase Orders Value
Pack)

Use these two fields to specify the Delivery Terms that
you will use when shipping goods to this Customer
company and that they will use when shipping goods to
you. You will tend to use these fields for international
companies: examples might be Cost, Insurance, Freight
or Free On Board.



Chapter 5: Customers and Suppliers - Registers - Customers

235

Sales Del. Mode Paste Special Delivery Mode setting, Sales
Support module

Used as default in Sales Orders, Deliveries

Purch. Del. Mode Paste Special Delivery Modes setting, Sales
Support module

Used as default in Purchase Orders (if you have
the Purchase Orders Value
Pack)

Enter the mode of shipping (i.e. shipping method) that
you will tend to use when shipping goods to this
company and that they will use when shipping goods to
you. Examples might be Post or Courier, or might
specify the name of one of the couriers that you use.

Terms Card
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Sales Pay. Terms Paste Special Payment Terms setting,
Sales/Purchase Ledger

Used as default in Sales Invoices

Purch. Pay. Terms Paste Special Payment Terms setting,
Sales/Purchase Ledger

Used as default in Purchase Invoices

In addition simply to ensuring the correct Payment
Terms appear on Sales and Purchase Invoices and
therefore that the Due Dates of those Invoices are
calculated correctly, entering Payment Terms records
using the setting available in both the Sales and Purchase
Ledger modules can enable a system of early settlement
discounts to be established.

Specifying Sales and Purchase Payment Terms for each
Customer and therefore for each Invoice provides the
basis for the debt-chasing and credit management reports
provided in FirstOffice.

Sales Credit Limit

Specify here the Credit Limit that you have granted to
this company. You can use the Credit Limit setting in the
Sales Ledger to warn against or prevent the entering of
Orders or Invoices for Customers who have exceeded
their Credit Limit.

If you want to allow a company no credit at all, set their
Sales Credit Limit to 0.01.

Purch. Credit Limit

Specify the Credit Limit extended to your firm by this
company here. This is for information only.

Sales VAT Code Paste Special VAT Codes setting, Nominal
Ledger

Purch. VAT Code Paste Special VAT Codes setting, Nominal
Ledger

The Sales VAT Code entered here refers to a VAT Code
record entered using the VAT Codes setting in the
Nominal Ledger. It determines the rate at which VAT
will be charged in sales to this company and the VAT
Account to be credited.
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When you create Sales Orders or Sales Invoices for this
Customer, the VAT Code entered here will take
precedence over those specified for the Item and the
Item Group and that on the ‘VAT’ card of the Account
Usage S/L setting in the Sales Ledger. Usually, you
should only specify a Sales VAT Code here for an
individual Customer if for some reason your usual VAT
accounting method does not apply to them.

The Purch. VAT Code determines the rate at which VAT
will be charged to you by this company and the VAT
Account to be debited.

When entering Purchase Invoices for this Supplier, the
VAT Code entered here will take precedence over those
specified in the Account record and in the Account
Usage P/L setting in the Purchase Ledger.

Sales Objects Paste Special Object register, Nominal Ledger

Used as default in Sales Orders, Sales Invoices

Purch. Objects Paste Special Object register, Nominal Ledger

You can specify up to 20 Objects in each of these fields,
separated by commas. You might define separate
Objects to represent different departments, cost centres
or product types. This provides a flexible method of
analysis that can be used in Nominal Ledger reports.

The Sales Objects will be used as defaults in all Sales
Orders, Sales Invoices and other sales transactions
involving this company.

On the purchase side, when entering a Purchase Invoice,
the Purchase Objects entered here will be brought in to
the Object field on the ‘Identifiers’ card of the Purchase
Invoice screen if you are using the Objects on Creditor
Account option in the Account Usage P/L setting. In any
Nominal Ledger Transactions generated from the
Invoice, these Objects will be assigned to the debit
posting to the Purchase Account(s) and, if you are using
the Objects on Creditor Account option, to the credit
posting to the Creditor Account.

When a Nominal Ledger Transaction is generated from a
Goods Receipt, the Purchase Objects will be assigned to
the credit posting to the Purchase Control Account.
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Cost A/C Paste Special Account register, Nominal
Ledger/System module

When entering Purchase Invoices in the name of this
Supplier, you can determine that a particular Purchase
Account is offered as a default in each Purchase Invoice
row. This can be particularly useful in the case of
specialist Suppliers or Suppliers of services such as
electricity or telephone services, whose Purchase
Invoices are usually debited to the same Account.

If you want to set a default Cost Account (i.e. Purchase
Account) for this Supplier, enter its Account Number
here.

Creditor A/C Paste Special Account register, Nominal
Ledger/System module

If you are using a particular Creditor Account for a
certain Supplier, enter its Account number here.

If you leave this field empty the Creditor Account will
be taken from the Supplier Category (if appropriate) or
from the Creditor Account on the ‘Creditors’ card of the
Account Usage P/L setting.

Their Customer Code

Enter the Account Number allocated to your firm by this
Supplier. It can be printed on Payment documents.
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Company Card

Comment This field can be used to record any additional
information about the Customer. Comments entered here
will be shown on Sales Ledger reports featuring this
Customer.

Order Com. Text entered here will appear as a default in the
Comment fields of Orders and Invoices for this
Customer.

Warning on Sales Text entered here will be used to alert users whenever a
Sales Order or Invoice is entered for this Customer.

Warning on Purch.

Text entered here will appear as a warning to alert users
whenever a Purchase Invoice is entered for this Supplier.



HansaWorld FirstOffice Professional

240

VAT Zone Used as default in Sales Orders, Sales and
Purchase Invoices

Select a Zone for this company. This will be used in
Sales Orders and in Sales and Purchase Invoices to
control VAT calculation and accounting and the choice
of Sales Account. Separate default sales VAT Codes and
Sales Accounts can be assigned to each Zone on the
‘VAT’ card of the Account Usage S/L setting in the
Sales Ledger. Separate default purchase VAT Codes can
be assigned to each Zone on the ‘VAT’ card of the
Account Usage P/L setting in the Purchase Ledger.

For Customers in the “Within EU” Zone, it is important
that their VAT Number is recorded (see below).

When Sales Invoices are raised for Customers in the
“Inside EU” and “Outside EU” Zones, VAT will not be
charged, irrespective of the VAT Code. If you want to
charge VAT to such Customers, place them in the Inside
EU (Post VAT)” and “Outside EU (Post VAT)” Zones.

Similarly, on the Purchase Side, VAT will not be
calculated on Purchase Invoices received from Suppliers
in the “Outside EU” Zone. If the Supplier is in the
“Inside EU” Zone, VAT from Purchase Invoices will be
debited to the Input Account from the VAT Code and
credited to the Output Account from the VAT Code. If
you want VAT to be calculated and debited to the Input
Account from the VAT Code in the normal way, place
your Suppliers in the Inside EU (Post VAT)” and
“Outside EU (Post VAT)” Zones.

Closed Check this box if the Customer or Supplier is no longer
to be used (Customer records cannot be deleted if Sales
Orders or Sales or Purchase Invoices have been raised in
their name). Closed Customers will appear in the
‘Customers: Browse’ window but not in the Customers
‘Paste Special’ list. You will not be able to enter Sales
Orders or Sales or Purchase Invoices for closed
Customers. A closed Customer can be re-opened at any
time.

Reminders Check this box if the Customer is to receive Open
Invoice Customer Statements and reminders for late
payment. Please refer to the description of the Reminder
document in the ‘Documents’ section of the ‘Sales
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Ledger’ chapter in Volume 2 for full details of this
feature.

Interest Check this box if the Customer is to be sent interest
Invoices for late payments. Please refer to the
‘Maintenance’ section of the ‘Sales Ledger’ chapter in
Volume 2 for full details of this feature.

On Account Check this box if the company is a Customer from whom
you want to be able to receive Prepayments and On
Account Receipts (i.e. you want to allow them to pay
before you have invoiced them) and/or the company is a
Supplier to whom you want to be able to issue
Prepayments and On Account Payments (i.e. to be able
to pay them before you receive Invoices). Full details
can be found in the ‘Receipts’ section of the ‘Sales
Ledger’ chapter and in the ‘Payments’ section of the
“Purchase Ledger’ chapter, both in Volume 2.

Before you can enter Prepayments and On Account
Receipts, you must specify an On Account A/C on the
‘Exchange Rate’ card of the Account Usage S/L setting.
This Account will be credited with the value of these
Receipts.

On the purchase side, before you can enter Prepayments
and On Account Payments, you must specify an On
Account A/C on the ‘Exchange Rate’ card of the
Account Usage P/L setting. This Account will be debited
with the value of these Payments.

Type Use these options to specify whether the Customer or
Supplier is a company or a private individual. This will
affect the check that the VAT Number is correct in
Argentina and Paraguay.

Reg No 1 If the Customer is a limited company, enter their
Company Registration Number here.

Reg No 2 This field is used in Finland, where companies have two
registration numbers.

VAT Reg No. It is important that you record the company’s VAT
Number here if they are in the “Within EU” Zone as this
information is required for EU VAT reporting purposes.

A check is made when you save the record that the VAT
Number has not been used in any other Customer record.
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If this check fails, you will be warned, but you will still
be able to save the record.

Salesman Paste Special Person register, System module

Used as default in Sales Orders, Sales Invoices

Enter the initials of the salesman responsible for this
Customer’s account. By default, Sales Orders and Sales
and Purchase Invoices for this Customer will be
attributed to the salesman entered here.

Price List Paste Special Price Lists setting, Sales Ledger

Used as default in Sales Orders, Sales Invoices

If you wish to assign a particular Price List to a
Customer, you can do so here. It will determine the
prices used in Sales Orders and Sales Invoices for this
Customer.

Note that you can also allocate Price Lists to Customer
Categories. This makes it easy to allocate or change the
Price List of a group or Customers in a single step. Any
Price List specified here will override that of the
Customer Category (if any) to which the Customer
belongs.

Please refer to the ‘Price List’ section on page 293 in the
‘Items and Pricing’ chapter for full details of how to use
this feature.

Freight No In some countries each Customer can be allocated a
specific Freight Number that will be quoted on all
Deliveries. Freight Numbers can be included on delivery
documents if necessary.

Bank Account Enter the company’s main bank account number here. If
the company is a Supplier, this bank account number
will be transferred to any Purchase Invoices and
Payments entered in their name, facilitating payment by
the transfer of funds between banks.

Bank 2 This field is used by the ‘Banking File’ Export function.
Please refer to your local FirstOffice representative for
details.
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Account Operator Paste Special Banks setting, Purchase Ledger

Enter the name of the company’s bank or building
society here. If the company is a Supplier, their bank
information will be transferred to any Purchase Invoices
(‘Identifiers’ card) and Payments (flip C) entered in their
name, facilitating payment by the transfer of funds
between banks.

Sort Code Enter the Sort Code (branch number) of the company’s
bank here.

Editing a Customer

The Customer register must be kept up to date, so it will need editing from
time to time.

In the ‘Customers: Browse’ window that appears when you open the
Customer register, the Customers are initially shown in Customer Number
order. You can change the sort order by clicking on one of the headings. The
underlined heading shows the current sort order.

To search for a specific Customer, enter the text to be found in the Search
field in the top right-hand corner of the window and press Return. The text
should be such that it would appear in the current sort column: to search by
Company Name, for example, sort by Company Name before entering a
Company Name (or its initial letters) to the Search field.

To modify a Customer’s record, double-click on the line in the browse
window. That record will be opened in a window entitled ‘Customer:
Inspect’. The fields in this window are the same as those in the ‘Customer:
New’ window: please refer to the previous section for a detailed description
of each field.

Edit the fields as necessary. Move from field to field with the Return key, or
with the arrow keys. Click [Save] when you have finished, to save changes.
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Deleting a Customer

Select and open the Customer record in the same way as for editing. Select
‘Delete’ from the Record menu. The Customer is deleted. Note that once
Orders or Invoices have been entered in a Customer’s name, that Customer
can no longer be deleted.

You cannot undo the deletion of a
Customer record.

Operations Menu

The Operations menu for Customers is shown above. It is available for the
‘Customers: Browse’ window: highlight a Customer in the list before
selecting the function. You can also apply the function to a group of
Customers: highlight the first Customer in the group and then click on the last
while holding down the Shift key. Then select the function. The Operations
menu is also available for the ‘Customer: New’ and ‘Customer: Inspect’
windows.

Customer Status
The ‘Customer Status’ function provides a short cut to the Customer Status
report, otherwise only available in a less detailed form in the Sales Ledger.

In its basic form, this report shows address and turnover information and lists
all Contact Persons for the Customer currently on screen or for those
Customers highlighted in the browse window. However, if required, more
information can be shown in the report, such as lists of recent Activities,
Invoices, Quotations (if you have the Quotations Value Pack) and Orders.
Use the Info on Customer Status Report setting in the Sales Support module
to control how much of this additional information will be shown to different
users, each of whom can be given a different report definition. Much of this
additional information will not be shown if the report is produced from the
‘Reports’ function in the Sales Ledger.

The Customer Status report has FirstOffice’s Drill-down feature. You can
open many records such as Contact Persons, Quotations and Invoices from
the report by clicking in the appropriate places (i.e. on Contact Person names
and on Quotation and Invoice Numbers). Text with the drill-down feature is

!
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shown underlined in the report. The report also contains a [New Activity] text
button that you can click to create an empty new Activity.

The function will have no effect if you try to use it with a company that is not
marked as a Customer.

Supplier Status
The ‘Supplier Status’ function provides an immediate report listing previous
Invoices and Payments for the Supplier currently on screen or for those
highlighted in the browse window. It also shows total turnover and amount
due figures. The function will have no effect if you try to use it with a
company that is not marked as a Supplier.
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Combining Customers and Suppliers
Prior to FirstOffice and Office/2 version 4.1, Customers and Suppliers were
stored in separate registers. In this version, the two registers were made into
one. When you update from 4.0 or earlier to 4.1 or later, you will need to
copy your Supplier information out of the old Supplier register into the
Customer register. You must do this before you can use your Supplier
information anywhere in the system (e.g. before you can create Purchase
Orders or Purchase Invoices).

In 4.1 and later, the old Supplier register can be found in the Technics
module, where it is a setting. You can edit the Suppliers that are already there
(e.g. change their VAT Numbers as described below), but you cannot add
new Suppliers. New Suppliers can only be added to the new unified
Customer register.

We will illustrate the procedure for converting Suppliers to Customers using
a database containing the following Customers and Suppliers—

Follow these steps—

1. Before updating to the new version, print the significant Purchase Ledger
reports such as the Purchase Ledger itself and the Periodic Supplier
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Statement. Similarly, if you have the Purchase Orders Value Pack, print
reports such as the Purchase Order Stock report and the Purchase Order
Journal.

2. Referring to the section entitled ‘Updating from Previous Versions of
FirstOffice’ on page 72 in the first chapter of this manual, update your
database to the new version of FirstOffice.

3. Back up your database in the usual fashion.

4. Before you can copy your Suppliers into the Customer register, you
should edit your Supplier register with these goals in mind—

i If a company is both a Customer and a Supplier, its Customer
Number and its Supplier Number should be the same, and the VAT
Registration Numbers should be the same in both registers. The
conversion process will copy the information about this company in
the Supplier register to the corresponding existing record in the
Customer register.

ii If a company is a Supplier only, its Supplier Number should be a
number that is not used as a Customer Number in the Customer
register. When the conversion process copies this company into the
Customer register, it will be as a new record, with a Customer
Number that is the same as its Supplier Number. That Customer
Number cannot therefore already be in use.

Start this process by running the Convert Suppliers To Customers report
in the System module (do not use the Compare With Conversion -
Supplier Settings option).
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The first line of this report will state whether you can copy your Supplier
information into the Customer register immediately. If so (and if the
remainder of the report is empty), proceed to step 6.

The remainder of the report will contain up to four sections listing
changes that you should make in the Supplier register before the
conversion process can copy the information into the Customer register.

The four sections are—

a. Lists the cases where the Supplier Number is the same as the
Customer Number, but the companies appear to be different (they
have different VAT Registration Numbers, or one or both companies
do not have VAT Numbers). In this case you must change the
Supplier Number, as described in step 5 below (or if they are in fact
the same company you should make sure they have the same VAT
Numbers by clicking on the Customer or Supplier Number in the
report).



Chapter 5: Customers and Suppliers - Combining Customers and Suppliers

249

In the example, Customer 002 and Supplier 002 are different
companies. We will therefore give Supplier 002 a different Supplier
Number (one that is not used as a Customer Number).

b. Lists the cases where the Supplier Number is not the same as the
Customer Number, but the Companies appear to be the same (they
have the same VAT Registration Number). If the companies are
different, you should change the VAT Number in one or both
companies by clicking on the Customer or Supplier Number in the
report. If in fact the companies are the same, you must change the
Supplier Number to be the same as the Customer Number, as
described in step 5 below.

In the example, Customer 003 and Supplier 303 are the same
company. We will renumber Supplier 303 to be Supplier 003, so that
the conversion process can then copy its Supplier information to
Customer 003.

c. Lists the cases where the Supplier Number is the same as the
Customer Number and the companies appear to be the same (they
have the same VAT Registration Number). If the companies are in
fact the same, you need take no action. If they are different, you
must change the Supplier Number as described in step 5 below, and
you should also change the VAT Number in one or both companies
by clicking on the Customer or Supplier Number in the report.

In the example, Customer 001 and Supplier 001 are the same
company. We will allow the conversion process to copy Supplier
information from Supplier 001 and to attach it to Customer 001.

d. Lists the cases where the Supplier Number is not the same as the
Customer Number and the Companies have different VAT
Registration Numbers, but they have the same name. If the
companies are different, you need take no action. If they are the
same, you must change the Supplier Number to be the same as the
Customer Number as described in step 5 below, and you should
change its VAT Number to be the same as the Customer’s.

In the example, Customer 004 and Supplier 304 fall into this
category. In fact, they are the same company so we will make their
VAT Numbers agree. Then we will renumber Supplier 304 to be
Supplier 004, so that the conversion process can attach its Supplier
information to Customer 004. Customer 005 and Supplier 305 are
also in this category, but they are different companies. In their case,
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the conversion process can copy Supplier information in to the
Customer register with no intervention.

Customers and Suppliers that do not fall into any of the four categories
described above (i.e. they are clearly separate companies, with no shared
Customer/Supplier Numbers or VAT Numbers) will not be shown in the
report. The conversion process can copy Supplier information in to the
Customer register with no intervention. In the example, a new Customer
record, Customer 503, will be created, to receive information copied
from Supplier 503.

As the basis of comparison is the VAT Registration Number, it is
recommended that you enter VAT Numbers for as many Suppliers and
Customers as possible before producing the report, or from the report by
drilling down. Recalculate the report when you've entered as many VAT
Numbers as possible. When the VAT Number information is as complete
as possible, proceed to step 5.

5. If the report showed that you need to change some Supplier Numbers, do
this now.

In the example, we need to change three Supplier Numbers—

• Supplier 002 should be given a new number that is not in use as a
Customer Number. It does not matter what this number is.

• Supplier 303 should be given number 003 to be the same as
Customer 003, and Supplier 304 should be given number 004.

In brief, this is done by listing the old and new Supplier Numbers in the
Conversions - Suppliers setting. You can do this yourself, or you can
have the ‘Prepare Conversion Suppliers Settings’ Maintenance function
do it for you. Then, export the database to a back-up file, create a new
database, switch on the correct import option in the Conversions - Master
setting and import the back-up file.
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For more detail, follow these steps—

i. Open the Conversions - Suppliers setting in the System module and
fill in the conversion table with Suppliers’ old Numbers in the left-
hand column and the new Numbers that they are to be given on the
right—

 
ii. If you have many Supplier Numbers to change, you can use the

‘Prepare Conversion Suppliers Settings’ Maintenance function in the
System module to fill the setting for you.

In essence, this function will assume that a Customer and a Supplier
with the same VAT Number are in fact the same company. It will
then try to ensure that such a company will end up with matching
Customer and Supplier Numbers. Therefore, before using this
function, you should ensure that your Customer and Supplier records
have as many VAT Numbers as possible, as described in step 4
above.
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When you open the ‘Prepare Conversion Suppliers Settings’
Maintenance function, the following dialogue box appears—

General Rules for matching Numbers

These options control how a new Supplier Number will
be assigned to a Supplier falling into category 4a as
described above (Supplier Number is the same as a
Customer Number, but companies are different).

Start from last Customer No.

Creates a new Supplier Number by finding the
last Customer Number and adding 1.

Start from No. Starts a new number sequence starting by adding
1 to the number you specify in the field to the
right.

Take great care if you use this option. You should
choose a number sequence that is currently not
used in the Customer register or in the old
Supplier register.

Add Retains the old Supplier Number but adds as a
prefix the character(s) you specify in the field to
the right.



Chapter 5: Customers and Suppliers - Combining Customers and Suppliers

253

When Customer with same VAT No. found

These options control how a new Supplier Number will
be assigned to a Supplier falling into category 4b as
described above (VAT Number is shared with a
Customer but Supplier and Customer Numbers are
different).

Convert Supplier No. to Customer No.

The Supplier will be given the Customer Number
of the Customer with the shared VAT Number.

Apply General Rules

The Supplier will be given a new Supplier
Number, created using the option chosen in the
General Rules For Matching Numbers section
above.

When Customer with same VAT No. and same No. found

These options control how a new Supplier Number will
be assigned to a Supplier falling into category 4c as
described above (VAT Number is shared with a
Customer, and Supplier and Customer Numbers are the
same)

Skip No action will be taken for these Suppliers.

Apply General Rules

The Supplier will be given a new Supplier
Number, created using the option chosen in the
General Rules For Matching Numbers section
above.

Apply these rules to all Suppliers

Check this box if the option chosen in the General Rules
For Matching Numbers section above is to be applied to
all other Suppliers (i.e. if all Suppliers with no possible
match in the Customer register are to be renumbered or
given a prefix as described above).

Click the [Run] button to operate the function. When it has finished,
check the Conversion - Suppliers setting to see that it has been filled
correctly and make any adjustments necessary.
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In the example illustrated above, the top section, General Rules For
Matching Numbers, will apply to Supplier 002. We have chosen a
number sequence beginning at 600, a sequence that is not currently
used in either the Customer or the Supplier registers. The second
section, When Customer With Same VAT No. Found, will apply to
Suppliers 303 and 304. We have specified that these are to become
Suppliers 003 and 004 respectively. Note that this rule will apply to
all Suppliers that share a VAT Number with a Customer. If there are
some Suppliers for whom this was not applicable, we would have to
move them out of this group by changing their VAT Numbers
before running the Maintenance function.

iii. Produce the Convert Suppliers To Customers report again, this time
using the Compare With Conversion - Supplier Setting option. This
option means that the report will check that your Suppliers can be
copied into the Customer register, taking the information in the
Conversions - Suppliers setting into account (i.e. the report will
assume the Suppliers have been renumbered as stated in the
Conversions - Suppliers setting).

If the report suggests further changes, carry them out as already
described.

This is the result in the example database—
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The report only contains two sections. The first is a reminder that
information from Supplier 001 will be copied to Customer 001. As
we know, they are in fact the same company, so we are happy for
this to happen. The second is a reminder that Supplier 305 and
Customer 005 have the same name and could therefore be the same
company. At the moment, a new Customer 305 will be created, so
they will be treated as being different companies. As we know, they
are in fact different companies, so again we are happy for this to
happen. So, in the example no further changes to the Customer or
Supplier register are necessary and we can proceed to the next step.
Otherwise, the report will provide a reminder that further changes
are needed.

iv. Make a back-up of your entire database in the usual way and quit
FirstOffice.

v. Create a new database. Open the Conversions - Master setting
(System module) and check the Convert Suppliers box.

vi. Import the database text backup. When it has finished, turn off the
option to Convert Suppliers in the Conversions - Master setting, and
empty the Conversions - Suppliers setting.

For more details of steps iv-vi, please refer to the description of the
Conversions - Master setting in the ‘System Module’ chapter of this
manual (page 317).

vii. Open the Suppliers setting in the Technics module to check the
Supplier Numbers have been updated as expected.
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All related transactions (e.g. Purchase Invoices and Goods Receipts)
will have been given the new Supplier Numbers as well.

viii. Run the Convert Suppliers to Customers report in the System
module again. The report should now state that it is safe to run the
‘Convert Suppliers to Customers’ Maintenance function.
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6. Run the ‘Convert Suppliers to Customers’ Maintenance function in the
System module. This will copy all Supplier information into the
Customer register, and empty the Suppliers setting.

7. Check that the Customer register now includes Suppliers and that all the
fields contain the correct information.

8. Produce the same reports as in step 1 above and check that they match.

If you have several Companies in your database, you should carry out steps 1,
3, 4 and 5i-iii separately in each Company. Make sure that the Conversions -
Suppliers setting is complete in each Company before carrying out steps 5iv-
vi, since ideally you only want to do these once for the whole database.
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Documents

Introduction

You can print Customer documents from the Sales Ledger. Use the [Select
Module] button in the Master Control panel to ensure you are in the Sales
Ledger and then select ‘Documents’ from the File menu or click the
[Documents] button, also in the Master Control panel. Then, double-click the
appropriate item in the list. A specification window will then appear, where
you can decide the Customers for which documents are to be printed. Click
[Run] to print the documents.

Where specified below, it is often possible to report on a selection range,
such as a range of Customers. To do this, enter the lowest and highest values
of the range, separated by a colon. For example, to report on Customers 001
to 010, enter “001:010” in the Customer field. Depending on the field, the
sort used might be alpha or numeric. In the case of an alpha sort, a range of
1:2 would also include 100, 10109, etc.

To determine the Form that will be used when you print a document, follow
this procedure (when FirstOffice is supplied, a sample Form will be
printed)—

1. Design a Form (or change the sample Form supplied to reflect your own
requirements) using the Form register in the System module. This
process is fully described on page 346 in the ‘System Module chapter
later in this manual. The sample Form supplied has the Form Code
“CUST_LABEL”.

2. Change to the Sales Ledger module and open the ‘Documents’ window
using the ‘Documents’ item on the File menu or by clicking the
[Documents] button in the Master Control panel.

3. Highlight ‘Customer Labels’ in the list and select ‘Define Document’
from the Operations menu. In the subsequent window, assign a Form (or
more than one Form) to the document: this window and is fully
described in the ‘Documents’ section on page 112 of the ‘Work Area’
chapter earlier in this manual. In this instance, enter “CUST_LABEL” in
the Form field of the first line.

4. You only need use the ‘Define Document’ function once. Afterwards,
Form selection will be automatic.
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Customer Labels

This document prints name and address labels to Customers. It uses the
Invoice Address and Attn. on the ‘Contact’ card of the Customer screen.

Customer Paste Special Customers and Suppliers in
Customer register

Range Reporting Alpha

Enter the Customer Number or range of Numbers for
which you want the labels printed.

By default, the ‘Paste Special’ list shows Customers.
Click the [Suppliers] button if you need to see Suppliers.

Category Paste Special Customer Categories setting,
Sales Ledger

Select a Customer Category. Labels will be printed for
all Customers in that Category.

Sort Key Enter a Sort Key. Labels will be printed for all
Customers with that Sort Key.
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Start with Label No.

If you will be printing to a sheet of labels, some of which
have already been used, specify here where on the sheet
you wish to begin printing.

Sorting The labels can be sorted by Customer Number,
Customer Name or Sort Key.

Function Choose which of the three standard label formats you are
using, 2 or 3 columns and 8 rows on an A4 page, or a
single label per page.

Illustrated below is a sample CUST_LABEL record from the Form register in
the System module. Note that you should only draw each field once: the label
printing function will print the fields the appropriate number of times on each
page.

If you want static text to be printed on your labels (i.e. text that identifies the
information on the labels, such as “Customer Name”), open your
“CUST_LABEL” Form (using the Form register in the System module) and
follow these steps—

1. Click the [Field] button and draw a rectangle where you want the static
text to appear. The Field dialogue box opens.

2. Leave the Fieldname blank and enter the static text in the Field
Argument field.
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3. Click [OK] to save.

4. Do not use the [Text] button for this purpose: any text entered this way
will be printed for the first label only.
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Reports

Introduction

Customer reports are located in the Sales Ledger and Sales Support module,
and Supplier reports in the Purchase Ledger. To produce a report, use the
[Select Module] button in the Master Control panel to ensure you are in the
correct module and then select ‘Reports’ from the File menu or click the
[Reports] button, also in the Master Control panel. Then, double-click the
appropriate item in the list. A specification window will then appear, where
you can decide what is to be included in the report. Leave all the fields in this
window blank if the report is to cover all the Customers or all the Suppliers in
the database. If it is necessary to restrict the coverage of the report, use the
fields as described individually for each report.

Where specified below, it is often possible to report on a selection range,
such as a range of Customers, or a range of Items. To do this, enter the lowest
and highest values of the range, separated by a colon. For example, to report
on Customers 001 to 010, enter “001:010” in the Customer field. Depending
on the field, the sort used might be alpha or numeric. In the case of an alpha
sort, a range of 1:2 would also include 100, 10109, etc.

Use the Media options at the bottom of the specification window to
determine the print destination of the report. The default is to print to screen.
You can initially print to screen and subsequently send the report to a printer
by clicking the Printer icon at the top of the report window.

Once you have entered the reporting criteria and have chosen a print
destination, click [Run].

With a report in the active window, use the ‘Recalculate’ command on the
Operations menu to update the report after making alterations to background
data. The ‘Reopen Report Specification’ command on the same menu allows
you to produce a new report using different reporting criteria.

Customer List

This report in the Sales Support module is a simple listing of all the
Customers in the Customer register. The report can also be produced for an
individual Customer by clicking the Printer icon when that Customer is open
in a record window. In this case, it will be printed as if the Include all Contact
Persons box is on.
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If you need to print a list of Suppliers in the Customer register, use the
Supplier List report in the Purchase Ledger.

The Customer List report has FirstOffice’s Drill-down feature. Click on any
Customer Number in the report to open that Customer record.

Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.

Customer Paste Special Customers in Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Category Paste Special Customer Categories setting,
Sales Ledger

To restrict the report to Customers of a single Category,
enter a Category Code here.

Salesman Paste Special Person register, System module

To restrict the report to Customers of a single Salesman,
enter a Salesman’s initials here.



HansaWorld FirstOffice Professional

264

Payment Terms Paste Special Payment Terms setting,
Sales/Purchase Ledger

Use this field to restrict the report to Customers with the
same Payment Terms.

New or updated since

Paste Special Choose date

This field refers to the Changed Date field on the
‘Contact’ card of the Customer record and can be used to
display recently entered or changed Customers.

Include all Contact Persons

This option will list all Contacts for each Customer, as
recorded in the Contact Person register in the Sales
Support module.

Sorting These radio buttons control the sort order of the report.
The default is to print the report in Customer Number
order, but you can also print in Name, Category, Sort
Key, Department or Telephone Number order.

Function These radio buttons control the level of detail shown in
the report.

Detailed This, the default option, causes all data in the
Customer register to be printed.

Contact Data This alternative limits the output to Customer
Number, Name, Telephone Number, and Contact
Person.



Chapter 5: Customers and Suppliers - Reports - Customer Statistics

265

Customer Statistics

This report in the Sales Ledger displays trading statistics for each Customer,
including turnover, margin and gross profit.

Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.

Customer Paste Special Customers in Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Item Paste Special Item register

To limit the report to a single Item, enter an Item
Number here.

Categories Paste Special Customer Categories setting,
Sales Ledger

Range Reporting Alpha

To restrict the report to Customers of a single Category,
enter a Category Code here.
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Salesman (from Cust.)

Paste Special Person register, System module

To restrict the report to Customers of a single Salesman,
enter a Salesman’s initials here.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end dates of the reporting period,
separated by a colon.

Min Turnover Enter a value to exclude customers with a lower turnover
during the period.

Min. GP Enter a value to exclude customers with lower gross
profit.

Customer Status

This report, which can be found in both the Sales Ledger and the Sales
Support module, shows the paid and unpaid Invoices for each Customer in
the selection. The age of due Invoices is shown together with their Reminder
Levels as are Receipts and total turnover and amount due figures.

The Customer Status report has FirstOffice’s Drill-down feature. Click on the
Invoice Number of any Invoice in the report to open that Invoice record. The
report also contains a [New Activity] text button that you can click to create
an empty new Activity, if you have the CRM and Mail Value Pack.
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Leave all the fields blank if the report is to cover all the Customers in the
Customer register. If it is necessary to restrict the coverage of the report, use
the fields as described below.

Customer Paste Special Customers in Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Category Paste Special Customer Categories setting,
Sales Ledger

To restrict the report to Customers of a single Category,
enter a Category Code here.

Customers with Balance Only

Switch this option on to exclude Customers with no
unpaid Invoices. Customers with unpaid Invoices that
are not yet due for payment will not be excluded.

Function Use these options to limit the report to include only the
last five paid Invoices (the default), or to start the report
from a specific date.
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Supplier List

The Supplier List in the Purchase Ledger is a simple listing of the Suppliers
entered in the Customer register.

Supplier Paste Special Suppliers in Customer register

Range Reporting Alpha

Use this field to limit the report to a single Supplier, or
range of Suppliers.

Category Paste Special Supplier Categories setting,
Purchase Ledger

To restrict the report to Suppliers of a single Category,
enter a Category Code here.

Function These options control the level of detail shown in the
report.

Detailed This gives a report showing all available
information for each Supplier.

Contact Data This gives a report showing only contact data
(Supplier Number and Name, Contact Person and
Telephone Number), and is therefore a more
compact listing.

Sorting The report can be sorted by Supplier Number or Name.
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Supplier Statistics

The Supplier Statistics report in the Purchase Ledger shows the turnover of
business conducted by your company with each Supplier in the specified
period.

Supplier Paste Special Suppliers in Customer register

Range Reporting Alpha

Use this field to limit the report to a single Supplier, or
range of Suppliers.

Category Paste Special Supplier Categories setting,
Purchase Ledger

To restrict the report to Suppliers of a single Category,
enter a Category Code here.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end dates of the reporting period,
separated by a colon.

Specify You can choose whether the turnover figures are to
include or exclude VAT.
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Chapter 6: Items and Pricing
The Item register contains information about the products and services that
you sell. It is accessible from the Sales Support, Stock and Sales Ledger
modules.

You can group Items of a similar type together using Item Groups. You can
give every Item belonging to the same Group the same default Sales and Cost
Accounts, Credit Account and VAT Codes, saving you the work of having to
specify these for all Items individually. Defining and assigning Item Groups
also makes modification easier: if you need to assign a different Cost
Account, for example, you only need make one change (to the Item Group),
rather than many (to each of the Items).

If information is specified both for an Item Group and for an Item that
belongs to that Group, the information entered for the Item will take
precedence.

This chapter first describes the defining of Item Groups. This is followed by a
detailed description of the Item register and of FirstOffice’s pricing features.
The final section covers Item related reports.

Settings

Item Groups

It can be practical to organise Items of similar kinds into Item Groups. This
option gives you more flexibility in reporting, and helps you to achieve an
efficient accounting of costs and stock values.

Entering Item Groups
Use the Item Groups setting in the Sales Ledger to define Item Groups. Use
the [Select Module] button in the Master Control panel to enter the Sales
Ledger and then click the [Settings] button, also in the Master Control panel.
Double-click ‘Item Groups’ in the ‘Settings’ list. Then click [New] to open a
new record, or double-click an existing record to modify it.
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Header

No. Enter the code or number identifying this Item Group.
You can use any combination of letters and numbers.
There is a maximum of five characters.

Name Enter the name or description of the Item Group.

A/C Card

Sales Accounts Paste Special Account register, Nominal
Ledger/System module

Used as default in Invoices, N/L Transactions

One of the Sales Accounts specified in these three fields
will be credited whenever you use a member of this
Group in an Invoice, depending on the Zone of the
Customer (specified on the ‘Company’ card of the
Customer screen). If the Item has a Sales Account
specified for the appropriate Zone, or there is a record in
the Price register for the appropriate Item/Price List
combination with a Sales Account, those will take
precedence over any entry here. If these fields are blank,
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the Sales Account will be taken from the Account Usage
S/L setting in the Sales Ledger.

VAT Codes Paste Special VAT Codes setting, Nominal
Ledger

Used as default in Invoices, N/L Transactions

Enter a VAT Code for each Zone. Each will specify the
VAT Account to be credited whenever you use a
member of this Group in an Invoice and the rate at which
VAT will be charged. The Zone used will depend on that
specified for the Customer.

If the Customer or Item has a VAT Code specified, they
will take precedence over any entry here. If these fields
are left blank, the VAT Code will be taken from the
‘VAT’ card of the Account Usage S/L setting.

Cost A/C Paste Special Account register, Nominal
Ledger/System module

If you are maintaining stock valuations in the Nominal
Ledger, specify here the Account to be debited with the
calculated cost of goods when Items that are members of
this Item Group are sold (removed from stock). You
should specify three separate Cost Accounts, one for
each Zone. The cost of goods is calculated using the
Cost Model chosen on the ‘Cost Model’ card or in the
Cost Model setting in the Sales Ledger. If blank, the
Stock Cost Account from the Account Usage Stock
setting will be debited.

This Accountwill only be used as described above if you
are using the Use Item Groups for Cost Accounts option
in the Cost Accounting setting in the Stock module. If
so, it is recommended that you assign every Stocked
Item to an Item Group and that you specify Cost and
Stock Accounts in every Item Group.

Please refer to the ‘Cost Accounting’ section of the
‘Stock Module’ chapter in Volume 3 of these manuals
for full details of this feature.

As with all Accounts on this screen, make sure the
desired Account is defined in the Account register
(available in the Nominal Ledger and in the System
module) to ensure that Nominal Ledger Transactions are
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generated without difficulty: FirstOffice will not attempt
to post to non-existent Accounts.

Stock Account Paste Special Account register, Nominal
Ledger/System module

If you are maintaining stock valuations in the Nominal
Ledger, specify here the Account to be credited with the
calculated cost of goods when Items that are members of
this Item Group are sold. The cost of goods is calculated
using the Cost Model chosen on the ‘Cost Model’ card
or in the Cost Model setting in the Sales Ledger. If this
Account is blank, the Stock Account from the Account
Usage Stock setting will be credited.

This Account will be debited when Items that are
members of this Item Group are received into stock.
Again, if this field is blank, the Stock Account from the
Account Usage Stock setting will be debited.

For both goods out and goods in transactions, this
Account will only be used as described above if you are
using the Use Item Groups for Cost Accounts option in
the Cost Accounting setting in the Stock module. If so, it
is recommended that you assign every Stocked Item to
an Item Group and that you specify Cost and Stock
Accounts in every Item Group.

Cost Model Card
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If you are maintaining stock valuations in the Nominal Ledger (‘cost
accounting’), this card is concerned with the selection of the Cost Model for
this Item Group. The Cost Model is the valuation method that will be used to
calculate the amount to be debited to the Cost Account and credited to the
Stock Account whenever an Item is sold. Both these Accounts are specified
on the A/C card.

The Cost Model will be chosen as follows—

• if the Item belongs to an Item Group, and you are using the Use Item
Groups for Cost Model option in the Cost Accounting setting in the
Stock module, it will be the Cost Model specified here. If that Cost
Model is “Default”, then it will be the Cost Model, Invoice or the Cost
Model, Delivery specified in the Cost Model setting in the Sales Ledger,
depending on whether you created the cost accounting transaction from
an Invoice or a Delivery;

• if the Item belongs to an Item Group, the Item Group does not have Cost
and Stock Accounts, you are using the Use Item Groups for Cost Model
option and you created the cost accounting transaction from an Invoice,
it will be the Cost Model, Invoice specified in the Cost Model setting;

• if the Item does not belong to an Item Group, or you are not using the
Use Item Groups for Cost Model option, and you created the cost
accounting transaction from a Delivery, it will be the Cost Model,
Delivery specified in the Cost Model setting;

• if the Item does not belong to an Item Group, or you are not using the
Use Item Groups for Cost Model option, and you created the cost
accounting transaction from an Invoice, it will be the Cost Model,
Invoice specified in the Cost Model setting.

Cost accounting is fully described in the ‘Stock Module’ chapter in Volume 3
of these manuals.

Cost Model If you use cost accounting, select one of the alternatives
for calculating the cost amount.

Default This option will calculate the cost amount using
the default Cost Model, set in the Cost Model
setting in the Sales Ledger.

Cost Price Use the Cost Price of the Item (visible on the
‘Costs’ card of the Item screen). If you choose
this option, it is recommended that you also
choose one of the Update Cost Price at Goods
Receipt options (again, on the ‘Costs’ card of the
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Item), to ensure the Cost Price is always up-to-
date.

% of Base PriceCalculate the cost by applying a specified
percentage to the Base Price (i.e. the retail price)
of the Item. Specify the percentage in the Cost in
% of Base Price field, just above this Cost Model
selection area. This option can be used in cases
where a consistent gross margin is required.

Cost from Invoice Use the Cost Price of the appropriate row of the
Invoice.

FIFO Price A true FIFO (First In First Out) cost is used based
on the cost prices recorded in Goods Receipts.

As its name suggests, First In First Out requires
that you must make certain that you enter all
stock transactions in strict chronological order.
Failure to do this may cause your FIFO values to
become incorrect. Do not, for example, enter a
Goods Receipt with yesterday’s date if you have
already entered one with today’s. This applies to
Deliveries and Stock Depreciations as well. It is
also recommended that you always approve stock
transactions when you save them for the first
time. Do not, for example, go back to an earlier
unapproved Goods Receipt and approve it if there
are later approved ones, unless you change the
date as well.

Weighted Average Use the Weighted Average Cost Price of the Item
(the average unit price of all previous purchases,
visible on the ‘Costs’ card of the Item screen).

None Select this option to ensure cost accounting
postings will not be made on the sale of Items of
the Item Group.

Cost in % of Base Price

Specify here the percentage to be applied if you have
chosen the % of Base Price Cost Model.
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If you choose Cost Price, % of Base
Price or Weighted Average, make
sure that the appropriate field
contains values for each Item.
Otherwise ,  cos t  account ing
Transactions with a zero amount may
result.

Deleting an Item Group
1. Ensure you are in the Sales Ledger using the [Select Module] button in

the Master Control panel and click the [Settings] button, also in the
Master Control panel. Double-click ‘Item Groups’ in the ‘Settings’ list.

2. Find the Item Group you want to remove, and open it by double-clicking.

3. Select ‘Delete’ from the Records menu.

The Item Group is permanently removed. The window shows the
preceding Item Group.

4. Close the window with the close box.

You cannot undo the deletion of an
Item Group.

!

!
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The Item Register

Entering an Item

The Item register contains information about the products and services that
you sell. If you also define Item Groups (described above on page 272) you
can improve the reporting capabilities of the program. The Item register is
accessible from the Sales Support, Stock and Sales Ledger modules.

To open the Item register, use the [Select Module] button in the Master
Control panel to enter one of these modules and click the [Items] button, also
in the Master Control panel. The ‘Items: Browse’ window is opened, showing
all Items already entered.

To enter a new Item, click [New] in the Button Bar or use the Ctrl-N
(Windows and Linux) or -N (Macintosh) keyboard shortcut. Alternatively,
highlight an Item similar to the one you want to enter and click [Duplicate]
on the Button Bar.

The ‘Item: New’ window is shown, empty if you clicked [New] or containing
a duplicate of the highlighted Item.
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Since the amount of information stored about each Item will not fit on a
single screen, the Item window has been divided into four cards. At the top of
each is the header. This contains the Item Number, Item Group and
Description, and the Closed check box. There are four named buttons (‘tabs’)
in the header.

By clicking the tabs you can navigate between cards. The header is always
visible, as a reminder of the Item you are working with.

Header
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No. Enter the unique identification code you are assigning to
this Item. This is the means by which you will identify
the Item when including it in Orders, Invoices etc. The
field holds up to 20 characters.

Group Paste Special Item Groups setting, Sales
Ledger

Enter the Item Group to which this Item belongs. Item
Groups enable you to classify similar Items together. All
Items belonging to the same Group can use the same
default Sales and Cost Accounts, Credit Account, VAT
Codes and Cost Model, saving you the work of having to
specify these for all Items individually. All Items in a
Group can also use the same Cost Model: this cannot be
changed for individual Items.

Closed Check this box if the Item is no longer to be used (Item
records cannot be deleted if they have been used on
Orders or Invoices). Closed Items will appear in the
‘Items: Browse’ window but not in the Items ‘Paste
Special’ list. You will not be able to use a closed Item on
Orders or Invoices. A closed Item can be re-opened at
any time.

Description Enter the name or a short description of the Item.

Pricing Card

Unit Paste Special Units setting, Sales Ledger

Specify here the quantity to which the Base Price
(below) refers. In the majority of cases, this will be a
single item, but otherwise it might be a pair or a dozen.

Base Price Used as default in Orders, Invoices

Enter the normal sales price for the Item here.
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Sales Accounts Paste Special Account register, Nominal
Ledger/System module

When you use this Item in an Order or Invoice, one of
the three Sales Accounts entered here will be offered as
a default, depending on the Zone of the Customer. It will
override any Sales Accounts specified for the Item
Group or in the Account Usage S/L setting. If there is a
record in the Price register for the appropriate Item/Price
List combination with a Sales Account, that Sales
Account will take precedence over the one entered here.

VAT Codes Paste Special VAT Codes setting, Nominal
Ledger

When entering Orders or Invoices and including this
Item, one of the three VAT Codes entered here will be
offered as a default, depending on the Zone of the
Customer. It will override any VAT Code specified for
the Item Group or in the Account Usage S/L setting.
However, if the Customer has a VAT Code specified,
that will take precedence over any entry here.

This Code will determine the rate at which VAT will be
calculated for this Item when it is bought or sold and the
Accounts to be debited and credited respectively with
the VAT amount.

Price Factor Used as default in Orders, Invoices

Use the Price Factor to define the Base Price of the Item
as being for a certain quantity; e.g. a price per box. If a
box contains 12 units and the Item is usually sold by the
box, enter “12” in this field to indicate that the Base
Price refers to a box of 12. The price per unit will be
calculated automatically in Orders and Invoices.
Although related to the Unit field above, this field will
tend to be used for Items where the basic sales unit can
be broken (e.g. where an Item is usually sold as a box of
12 but can occasionally be sold individually), while the
Unit field refers to unbreakable sales units.

Base Price Change

This field shows the date of the last change to the Base
Price for the Item and is updated automatically.



Chapter 6: Items and Pricing - Registers - Items

283

Item Type The Item Type selected here determines how the Item
will be treated elsewhere in FirstOffice.

Plain Select this option if the Item is one for which
there is no requirement to maintain stock values.
This might be the case for Items such as labour or
training. Stock level quantities are maintained for
such Items, but they are not subject to the Do Not
Allow over Delivery Setting in the Stock module
(i.e. you will not be prevented from creating
negative stock).

Stocked Select this type for normal stocked Items.
FirstOffice will keep track of the stock values for
these Items.

Stock Card

Min. Level This is the re-order point for the Item, the minimum
quantity that can be held in stock. This is used in the
Deficiency List, a report in the Stock module that
produces purchase proposals.

Shelf Code The Shelf Code recorded here will be printed on the
Stocktaking List report and on Picking Lists.

Weight The weight of one unit should be recorded here.

Volume The volume of one unit should be recorded here.

Conversion 1, Conversion 2

You should use these fields for Items that are sold in
different quantities. For example, you might sell a
particular Item in pairs, by the dozen and in boxes of
144. The Unit field on the ‘Pricing’ card refers to the
basic unit of sale, since this is the unit to which the Base
Price refers. In this example, the basic unit is a pair. “72”
will be entered as the Conversion 1 (72 of the basic unit
i.e. 72 pairs make 144) and “6” as the Conversion 2.

When you design the Invoice and Delivery Note forms
using the Form register in the System module, you can
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include three relevant fields. These are “Qty Conversion
1”, “Qty Conversion 2”, and “Qty Conversion 3”. Qty
Conversion 1 refers to the Conversion 1 field, Qty
Conversion 2 refers to the Conversion 2 field, and Qty
Conversion 3 refers to the basic sale quantity.

If you receive an Order for 158 units of this Item (i.e.
158 pairs, the basic sale quantity), the three Qty
Conversion fields on the printed documentation will
appear as follows—

Qty Conv 1 Qty Conv 2 Qty Conv 3

2 2 2

2 boxes of 72 pairs + 2 boxes of 6 pairs + 2 pairs = 158
Units (pairs).

Costs Card

Cost Price Used as default in Orders, Invoices, Goods
Receipts

You should record the Cost Price of the Item here. Since
the figure will be used in calculating the Gross Profit of
Sales Orders, it is important that it relates to the same
Unit and Price Factor values as the Base Price on the
‘Pricing’ card. Depending on the setting of the Update
Cost Price at Goods Receipt options (see below), the
figure can be updated automatically from the figures
used in Goods Receipts.

Extra Cost Enter here any extra costs involved in the purchase of
this Item, such as fixed freight costs. The figure will be
included in the cost when calculating Gross Profit.

Weighted AverageThis figure records the average unit cost price of this
Item (including extra costs such as freight and customs
duties). It is updated automatically from Goods Receipts
whatever the setting of the Update Cost Price at Goods
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Receipt options (see below), using the Calc FIFO Value
rounding rules set in the Round Off setting in the System
module. You can recalculate the Weighted Average of
an Item using the ‘Update Item Cost Price’ Maintenance
function in the Stock module.

Last Pur. Price This figure records the last unit cost price (including
extra costs such as freight and customs duties) used
when purchasing this Item. It is updated automatically
from approved Goods Receipts whatever the setting of
the Update Cost Price at Goods Receipt options (see
below).

Price Change This field shows the date of the last change to the Cost
Price for the Item and is updated automatically.

Upd. Cost Price at Goods Receipt

FirstOffice can update the Cost Price of an Item
automatically. If you are using this feature, the update
will occur whenever you approve a Goods Receipt.

The automatic updating of Cost Prices can be useful if
you are using cost accounting (maintaining stock values
in the Nominal Ledger) and your goods-out values are
based on Items’ Cost Prices. In this scenario, it is
advantageous if the Cost Prices are always kept up-to-
date. Cost Accounting is fully described in the ‘Stock
Module’ chapter in Volume 3 of these manuals.

In both cases, a price in a Goods Receipt will be rounded
up or down according to the Calc FIFO Value rounding
rules set in the Round Off setting in the System module
before it is used to update the Cost Price of the Item.

These options are used to control this feature—

No Select this option if this feature is not to be used
for this Item.

Last Purch Cost Price

If you choose this option, the Cost Price is
changed to the Cost Price of the Item on the most
recent Goods Receipt (i.e. the price including
extra costs such as carriage and customs duties).
You will tend to use this option for Items whose
prices do not often change, or where the long-
term pattern is for prices to fall or rise.
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Weighted Average This option changes the Cost Price to the average
unit Cost Price of all previous Goods Receipts
(including extra costs such as freight and customs
duties). This option will be useful where prices
fluctuate without a pattern, perhaps due to
changing exchange rates.

Bar Code Record the Item’s Bar Code here.

Providing the Bar Code does not clash with your Item
Codes, you can enter it instead of the Item Code
whenever you need to refer to this Item (in Orders or
Invoices, for example).

Texts Card

You can use this table to enter extended comments about the Item, such as a
detailed specification, which will also appear on Orders and Invoices. To do this,
enter the text taking up as many rows as necessary.
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Editing an Item

To edit an Item, open the ‘Items: Browse’ window by clicking the [Items]
button in the Master Control panel.

The Items are initially shown in Item Number order. Change the sort order by
clicking on one of the column headings: the underlined heading shows the
current sort order.

To search for a specific Item, enter the text to be found in the Search field in
the top right-hand corner of the window and press Return. The text should be
such that it would appear in the current sort column: to search by Item
Description, for example, sort by Description before entering a Description
(or its initial letters) to the Search field.

To modify an Item’s record, double-click on the line in the browse window.
That record will be opened in a window entitled ‘Item: Inspect’. The fields in
this window are the same as those in the ‘Item: New’ window: please refer to
the previous section for a detailed description of each field.

Edit the fields as necessary. Move from field to field with the Return key, or
with the arrow keys. Click [Save] when you have finished, to save changes.

Deleting an Item

Select and open the Item record in the same way as for editing. Select
‘Delete’ from the Record menu. The Item is deleted. Note that once an Item
has been included on an Order or Invoice, it can no longer be deleted.

You cannot undo the deletion of an
Item.!
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Prices in Sales Transactions

When you enter an Item in a sales transaction (e.g. Order or Invoice), the
Unit Price according to the valid Price List for the Customer will be brought
in automatically (Price Lists are described below on page 293). If the
Customer has no Price List specified, or the Item is not on the Price List in
question, the Base Price from the Item screen is brought in. You are then free
to change this Unit Price in the sales transaction if necessary.

You can prevent a particular user or group of users from changing Unit Prices
in sales transactions using Access Groups. To do this, deny access to the
‘Change Unit Prices’ Action—

Changing Prices of Items in Batches

You can change the Base Prices of many Items at one stroke using the
‘Update Item Base Prices’ Maintenance function in the Sales Ledger. This
function allows you to change Base Prices using a formula, so it will be
useful if, for example, you want to change all Base Prices by 10%.
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To use this function, ensure you are in the Sales Ledger using the [Select
Module] button in the Master Control panel and choose ‘Maintenance’ from
the File menu. When the ‘Maintenance’ list is opened, double-click ‘Update
Item Base Prices’. The ‘Specify Item Prices’ window is displayed—

Item Group Paste Special Item Groups setting, Sales
Ledger

Enter an Item Group here if you want to update the Base
Prices of all Items belonging to that Item Group.

Items Paste Special Item register

Range Reporting Alpha

Enter an Item Number or range of Item Numbers here if
you want to update the Base Price of a specific Item or
of a range of Items. You must enter either an Item
Number here or an Item Group in the field above,
otherwise no Base Prices will be updated. Do not leave
both fields empty in the hope of updating the Base Price
of every Item in the database.

% Adjustment Enter here the percentage by which the Base Prices of
the selected Items are to be recalculated. For example, to
increase prices by 10%, enter “110”. To reduce prices by
10%, enter “90”. If this field is left blank, Base Prices
will not be changed.

When you click [Run], the Base Price of each selected Item will be
recalculated using the specified percentage adjustment.

If necessary, you can deny access to this function using Access Groups as
described earlier in this section.
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Operations Menu

 
The Operations menus for Items are shown above. On the left is that for the
‘Items: Browse’ window: highlight an Item in the list before selecting the
function. On the right is that for the ‘Item: New’ and ‘Item: Inspect’
windows.

Item Status Report
The ‘Item Status Report’ function provides a quick report for the Item(s)
highlighted in the ‘Items: Browse’ window or that showing in the record
window, showing stock and order positions and prices in different price lists.
To apply the function to a group of Items, in the browse window highlight the
first Item of the group and then click on the last while holding down the Shift
key. Then select the function.
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You can have the In Stock figure updated (i.e. reduced by the quantity
delivered) when Deliveries are created or when they are approved. This is
controlled using the Decrease Available on Deliveries options in the Stock
Settings setting in the Stock module. If you have the Purchase Order Value
Pack, the Purchase Order figure will include both approved and unapproved
Purchase Orders. Goods Receipts will update the In Stock and Purchase
Order figures when they are approved.

Item Status
This function provides instant feedback for each Item concerning the quantity
in stock, the quantity on order, how many can be shipped and the current
gross profit.

The function is available from the ‘Items: Browse’ window, as well as on the
Operations menus for Sales Orders, Invoices, Deliveries and Stock
Depreciation records.

When you select this function, the ‘Item Status’ window is opened. This
window is different from other windows because it always “floats” on top of
other windows, even when those windows are active.

When you open the ‘Item Status’ window from the ‘Items: Browse’ window,
it displays information about the Item highlighted in the list. This information
will change as you click on different Items in the list.

When you open the ‘Item Status’ window from other windows, for example,
from an Invoice or Order, it displays information about the Item in the row
containing the cursor. As you move the insertion point to different rows, the
data in the ‘Item Status’ window is immediately updated. If you then select
‘Paste Special’ from the Item Number field of an Invoice or Order row and
highlight an Item in the ‘Paste Special’ window, the ‘Item Status’ window is
updated to show values for the Item highlighted.

You can have the Stock and Order figures updated (i.e. reduced by the
quantity delivered) when Deliveries are created or when they are approved.
This is controlled using the Decrease Available on Deliveries options in the
Stock Settings setting in the Stock module. The Shippable figure is reduced
by the quantity ordered as soon as a new Order is saved, so it assumes that
stock is immediately allocated to that Order. Goods Receipts will update the
Stock and Shippable figures when they are approved.
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When you open the ‘Item Status’ window from the Invoice, Order and
Quotation screens, the GP and GM figures will show the Gross Profit and
Gross Margin (%) for the row containing the cursor. In other circumstances,
these fields will be blank.

You can move the window and put it where you want on the screen. Use the
Window menu (Windows and Linux) or the -Shift-S keystroke (Macintosh)
to ensure it is opened in that position the next time it is used.
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Price Lists

Introduction

FirstOffice has a powerful set of functions to handle different types of Price
Lists in a business. These functions allow you to manage several alternative
Price Lists listing all or some of the goods or services you offer to Customers.
Different Price Lists can be connected with specific Customer Categories.
The number of alternatives is great, but as always is the case with great
flexibility, it is necessary to know and understand the tools and techniques to
set up a specific pricing structure.

The Base Price

Each Item has a Base Price, shown on the ‘Pricing’ card. This is the Item’s
normal selling price. In many cases, this will be the only price used. If each
Item is always sold at the same price (or with an ad hoc discount), whoever
the Customer, you will be able to rely on the Base Price and not worry about
the Price List feature.

On the ‘Costs’ card of the Item record, there is also a Cost Price. This
indicates the cost of purchasing or making the Item. FirstOffice uses the Cost
Price to calculate the Gross Profit of Orders and Invoices.

Structure of Price Lists

FirstOffice allows you to assign different Prices to individual Items so that
each Price is associated with a particular Price List. For example, many retail
outlets have different prices for their retail and trade Customers, or different
retail and educational prices. You might then have separate retail, trade and
educational Price Lists, each of which is available to the appropriate kind of
Customer. When you enter a Customer in an Order or Invoice, the
appropriate Price List will be used and so the correct prices will be selected
automatically.

In planning such a price structure, follow these steps—

1. Enter the Items with their Base Prices, using the Item register as
described towards the beginning of this chapter.

2. Define each Price List (in our example, retail, trade and educational)
using the Price Lists setting in the Sales Ledger.
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3. The Items that are to appear on the Price Lists should be attached as
necessary. For each Item on each Price List, enter a record to the Price
register (available in the Sales Ledger and the Sales Support module)
with an appropriate price. In our example, for each Item three Price
records should be entered, containing the retail, trade and education
prices. If a Price List is specified for a Customer that you then use in an
in an Order or Invoice, FirstOffice searches in the Price register for the
appropriate, and unique, record representing the particular Item for that
Price List.

4. You can now assign a Price List to each Customer or Customer
Category. When you enter an Order or Invoice for a particular Customer,
the specified Price List will be used automatically. If you sell an Item
that is not on the appropriate Price List, the Base Price will be used.

5. You can print Price Lists, or export them to disk for incorporation into
your company’s publicity material. Print Price Lists using the report of
the same name, available in the Sales Support module and the Sales
Ledger. This is fully described in the ‘Reports’ section below on page
302.

Below, steps 2 and 3 are described in detail.

Price Lists

To define a new Price List, first ensure you are in the Sales Ledger using the
[Select Module] button in the Master Control panel. Then click the [Settings]
button, also in the Master Control panel, or select ‘Settings’ from the File
menu. Double-click ‘Price Lists’ in the ‘Settings’ list and click [New].

Code Enter a unique code here, by which this Price List will be
identified elsewhere in FirstOffice.

Description Name the Price List here.

VAT Choose the Exclusive option if the prices are to exclude
VAT, and the Inclusive option if they are to include
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VAT. If you use an ‘Inclusive’ Price List in an Invoice
or an Order, the Unit Price, Sum and Total figures will
all include VAT, but if you use an ‘Exclusive’ Price List,
the Unit Price and Sum figures will exclude VAT. In
both cases, VAT will be calculated using, in order of
preference, the VAT Code specified for the Item, the
Item Group or on the ‘VAT’ card of the Account Usage
S/L setting.

The Price Register

You can have several different Prices for each Item. Enter each Price as a
separate record in the Price register, one record for each Price for each Item.
You should do this after you have defined your Items, Item Groups and Price
Lists.

You should ensure that there is a single, unique, Price record for each
Item/Price List combination, making the use of Price Lists in Orders and
Invoices extremely fast. FirstOffice will prevent you entering a Price record
for an Item/Price List comb ination if one already exists by displaying the
error message “Already Registered”.

To enter a new Price record, open the Prices register using the [Prices] button
in the Master Control panel in the Sales Ledger or the Sales Support module
and click [New]. Enter the Item Number of an existing Item, using ‘Paste
Special’ if necessary to select from a list of Items, and press Return. The Item
Name from the Item register is shown. Enter the required Price, specify a
Price List, again using ‘Paste Special’, and click [Save].

Specifying a Price List in a Price record has the following effects—

• It will be included when the Price List is printed, using the report in the
Sales Ledger. This report is described below on page 302.

• When you create an Order or Invoice in the name of a particular
Customer, the Price List specified for that Customer will determine the
Prices used. The Price List can be specified on two levels: for each
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Customer; or for Customer Categories. Prices from the appropriate Price
List will be offered as a default whenever the Customer places an Order
or receives an Invoice.

If you specify a Sales Account in a Price record, that Account will be offered
as a default in Invoices where pricing is determined by that Price (i.e. by the
unique Price record for the Item/Price List combination). This Account will
take priority over those for the Item and Item Group and that in the Account
Usage S/L setting.
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Reports

Introduction

Item reports are located in the Sales Ledger and Sales Support modules. Use
the [Select Module] button in the Master Control panel to ensure you are in
the correct module and then select ‘Reports’ from the File menu or click the
[Reports] button, also in the Master Control panel. Then, double-click the
appropriate item in the list. Leave all the fields in this window blank if the
report is to cover all the Items in the database. If it is necessary to restrict the
coverage of the report, use the fields as described individually for each
report.

Where specified below, it is often possible to report on a selection range,
such as a range of Customers, or a range of Items. To do this, enter the lowest
and highest values of the range, separated by a colon. For example, to report
on Customers 001 to 010, enter “001:010” in the Customer field. Depending
on the field, the sort used might be alpha or numeric. In the case of an alpha
sort, a range of 1:2 would also include 100, 10109, etc.

Use the Media options at the bottom of the specification window to
determine the print destination of the report. The default is to print to screen.
You can initially print to screen and subsequently send the report to a printer
by clicking the Printer icon at the top of the report window.

Once you have entered the reporting criteria and have chosen a print
destination, click [Run].

With a report in the active window, use the ‘Recalculate’ command on the
Operations menu to update the report after making alterations to background
data. The ‘Reopen Report Specification’ command on the same menu allows
you to produce a new report using different reporting criteria.
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Item List

This report is available in both the Sales Ledger and the Sales Support
modules. For each Item, it displays the Item Number, Name, any Group
membership, Unit, VAT Code and the Base Price.

Leave all the fields blank if the report is to cover all the Items in the Item
register. If it is necessary to restrict the coverage of the report, use the fields
as described below.

Item No. Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.

Item Group Paste Special Item Groups setting, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If you specify both a range of Items and a range of Item
Groups, the report will cover only those Items in the
range that are members of the specified Item Groups.

Sorting The report can be sorted by Item Number, Item Group or
Name.
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Item Statistics

This report is available from the Sales Ledger only. It displays sales statistics
for each Item, including turnover, quantity and gross profit.

When printed to screen, the Item Statistics report has FirstOffice’s Drill-
down feature. Click on any Item Number to open the corresponding Item
record.

Leave all the fields blank if the report is to cover all the Items in the Item
register. If it is necessary to restrict the coverage of the report, use the fields
as described below.

Item No. Paste Special Item register

Range Reporting Alpha

Use this field to limit the report to a single Item, or range
of Items.

Customer Paste Special Customers in Customer register

To limit the report to sales to a single Customer, enter a
Customer Number here.
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Categories Paste Special Customer Categories setting,
Sales Ledger

Range Reporting Alpha

Use this field to limit the report to sales to Customers of
a single Category or range of Categories.

Item Groups Paste Special Item Groups setting, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If you specify both a range of Items and a range of Item
Groups, the report will cover only those Items in the
range that are members of the specified Item Groups.

Period Paste Special Reporting Periods setting,
System module

Enter the start and end date of the reporting period.

Function These settings control the level of detail included in the
report.

Overview This option offers a single line per Item
displaying sales statistics, including turnover,
quantity and gross profit.

Detailed In addition to the information offered by the
previous option, this choice also shows quantities
in stock and on order, the unit price and the cost
price for each Item.
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Customer/Item Statistics

The Customer/Item Statistics report found in the Sales Ledger analyses in a
Customer-by-Customer format the sales in both quantity and turnover terms
of Items to Customers. It can compare this information for two periods.

Leave all the fields blank if the report is to cover all the Customers and all
Items. If it is necessary to restrict the coverage of the report, use the fields as
described below.

Customers Paste Special Customers in Customer register

Range Reporting Alpha

Use this field to limit the report to a single Customer, or
range of Customers.

Categories Paste Special Customer Categories setting,
Sales Ledger

Range Reporting Alpha

To restrict the report to Customers of a single Category,
enter a Category Code here.

Item No. Paste Special Item register

Range Reporting Alpha

To limit the report to a single Item, enter an Item
Number here.
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Item Groups Paste Special Item Groups setting, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If you specify both a range of Items and a range of Item
Groups, the report will cover only those Items in the
range that are members of the specified Item Groups.

This Period Paste Special Reporting Periods setting,
System module

Enter the first and last dates of the reporting period,
separated by a colon.

Compared Period Paste Special Reporting Periods setting,
System module

Enter the first and last dates of the period with which the
reporting period is to be compared, separated by a colon.

Price List

This report, available from the Sales Support module and the Sales Ledger,
prints a Price List. It is a report that perhaps might be sent to a text file so that
it can be incorporated in your publicity material. To do this, decide upon the
contents of the report using the screen illustrated below in the usual fashion.
Then, choose ‘File’ from the Media options at the bottom of the window.
When you click [Run], you will be asked to name the text file and to specify
where it is to be saved.
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Item Paste Special Item register

Range Reporting Alpha

To limit the report to a single Item, enter an Item
Number here.

Item Group Paste Special Item Groups setting, Sales
Ledger

Range Reporting Alpha

To limit the report to a single Item Group, enter an Item
Group Code here.

If you specify both a range of Items and a range of Item
Groups, the report will cover only those Items in the
range that are members of the specified Item Groups

Price List Paste Special Price Lists setting, Sales Ledger

Specify which Price List is to be printed here.

By default, all Items or, if you have also specified a
range of Items and/or a range of Item Groups, all Items
in the range, will be printed irrespective of whether or
not they have been included in the Price List. The Price
shown will be taken from the appropriate Price record
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or, if there isn’t one, from the Base Price of the Item
record.

If you only want to print those Items which fall within
the range and which have been included in the Price List,
use the Only Items from this Price List option (below).

Leave this field blank if you wish to print the Base Price
of each Item, as entered on the ‘Pricing’ card of the Item
screen.

Function These options control the format of the report.

External Select this option to print sales prices (including
and excluding VAT) together with the Item Code
and Description.

Internal This option prints sales prices excluding VAT,
cost prices, gross profit and gross margin.

Sorting The report can be sorted by Item Number, Item Group or
Name.

Items with Balance only

Select this option if you only want Items of which you
have stock to appear in the Price List.

Prices Incl. VAT Check this box to print prices including VAT in the
report. This option applies to the External Price List
only.

Prices Excl. VAT Check this box to print prices excluding VAT in the
report. By checking this box and the one above, both
inclusive and exclusive prices can be shown in the same
report. This option applies to the External Price List
only.

Only Items from this Price List

By default, the report will list all Items in the selected
range, irrespective of whether they have been included in
the Price List. The Price shown will be taken from the
appropriate Price record or, if there isn’t one, from the
Base Price of the Item record.

If you only want to show those Items which fall within
the range and which have been included in the Price List,
check this box.
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Chapter 7: The System Module
This module contains settings and registers used collectively by the other
modules, including the Chart of Accounts. It is also where the administration
of users, including the allocation of access rights to the other modules, is
carried out.

Settings

Introduction

The following settings are available in the System module—

To edit a setting, ensure you are in the System module using the [Select
Module] button in the Master Control panel and click the [Settings] button,
also in the Master Control panel, or select ‘Settings’ from the File menu.
Then double-click the relevant item in the list.
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Access Groups

Access Groups are a part of FirstOffice’s security system. You can define a
number of Access Groups, each of which can be allowed access to one or
more parts of the program. When you enter a record to the Person register
(described below on page 337) for each member of personnel, you can then
allocate them to the relevant Access Group.

Double-click on ‘Access Groups’ in the ‘Settings’ list to open the ‘Access
Groups: Browse’ window. A list of the defined Groups is shown—

To create a new Access Group, click [New] in the Button Bar. To edit an
existing record, double-click one of the items in the list.
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In either case, the following window appears—

Members of the Access Group “ORDER” in the above illustration will have
access to two modules - Sales Support and Stock. The Stock module is
featured in the first row of the grid, so this will be the active module when
they first log in to FirstOffice. They will be allowed access to every function
in those modules. In this manner, you can determine the parts of FirstOffice
to which the members of each Access Group have access.

As you create Access Groups, give each a unique identifier in the Code field,
and enter a description in the Text field.

Use the grid area to determine the modules to which members of the Access
Group will be given access, and the level of that access. You can allow or
disallow access to any module or any component of a module (such as a
particular register or setting).
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First, specify the component in the Type field, using the ‘Paste Special’
function to show a full list of the components available—

Next, use the second field in the grid to specify the individual item. For
example, if you enter “Modules” in the Type field, the ‘Paste Special’ list
from the Item field will contain a list of modules—

The list will show all FirstOffice’s modules, including those that you may not
have installed. Make sure you only select modules that are included in your
particular installation of FirstOffice.

If you enter “Action” in the Type field, the ‘Paste Special’ list from the Item
field will contain a list of functions to which you can restrict access if
necessary. These include the checking of the OK box in transactions of all
kinds, the Operations menu functions and some miscellaneous features such
as deleting records.
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If you enter “Reports” in the Type field, ‘Paste Special’ from the Item field
will list all reports, and so on.

Finally, use the last column to determine the access level of the Group. A
further ‘Paste Special’ list displays the available options—

‘Read’, ‘Read/New’, ‘Browse’ and ‘Browse/New’ should only be applied to
registers or settings, as follows—

Browse Allows access to the browse and ‘Paste Special’
windows only. Searches can be performed. Records
cannot be entered or modified.

Browse/New Allows access to the browse and ‘Paste Special’
windows and the creation of new records. Existing
records cannot be viewed, changed or copied.

Read Allows access to the browse window and the double-
clicking of items so that they can be viewed in an
inspect window. Records cannot be entered or modified.
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This attribute can also be applied to reports, allowing
them to be printed to screen but not to a printer or to a
text file.

Read/New Allows access to the browse window and the double-
clicking of items so that they can be viewed in an
inspect window. New records can be created. Existing
records cannot be modified, but they can be copied.

If you want to allow ‘Paste Special’ access to a register or setting to which
access is otherwise denied, you should grant Browse or Read access to that
register or setting. For example, if a user only has access to the Sales Ledger,
you should grant them Browse or Read access to the Account register if you
want them to be able to choose Sales Accounts in Invoices.

You can allocate access to the various modules using one of two methods, by
specifying one of the two Start From alternatives. These can be described as
follows—

No Access This option effectively excludes members of the Access
Group from all modules except those listed in the grid.
You should use the first row(s) of the grid to specify the
module(s) that members of the Access Group are to be
allowed to use. You should select ‘Full’ in the third
‘Paste Special’ list. This will give full access to those
modules (including to all registers, settings and reports).
You can then exclude users from particular parts of
those modules if necessary. No access will be given to
modules that you have not listed.

Full Access If this option is used, members of the Access Group will
be allowed full access everywhere except those areas
listed in the grid.

Note that it is only possible to restrict access to Persons that belong to an
Access Group. Persons that do not belong to an Access Group will have full
access to your FirstOffice system.
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Logging In
By default, the Sales Ledger is the first module that you will see when you
log in to FirstOffice. If you want another module to be active on log-in but
otherwise do not want to restrict access in any way, this can be achieved
using Access Groups. Enter an Access Group that Starts from Full Access
and with a single module listed in the grid: the module that is to be active on
log in. Assign this Access Group to the Persons as appropriate.

Members of the Access Group illustrated above will see the Stock module
when they enter FirstOffice.
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System Administrator
In multi-user systems, it is recommended that at least one member of staff
acts as a system administrator, able to use the Technics module on a client
machine when other users are logged in. To implement this, the Person
record for that administrator should belong to an Access Group that Starts
from Full Access and explicitly grants full access to the Technics module—

Auto Actions

This setting determines the rules for automatic document printing.

The documents involved are the Order Confirmation/Acknowledgement, the
Internal Order, Delivery Note and the Invoice. The default setting is that no
documents are printed automatically.

You can choose to have Order Confirmations and Internal Orders printed
every time a new Order is saved for the first time, or after every alteration of
an Order. For Invoices and Delivery Notes, the document can be printed each
time an Invoice or Delivery Note is approved and saved.
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Company Info

Use this setting to record your company’s name and address, and other
particulars such as phone and fax numbers, and the bank and bank account
number. This information will be printed as appropriate on all documents.

To open the Company Info setting, double-click ‘Company Info’ in the
‘Settings’ list. The ‘Company Info: Inspect’ window is opened.
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Apart from the Company Name, Address etc, you should enter the following
information in this setting—

Reg Card

Bank 1, Bank 2 You should enter your company’s main bank account
number(s) here. This information can then be printed on
any appropriate documentation.

Bank Customer ID

This is an ID number used for automatic (modem)
communication with certain credit institutions in some
countries. Please contact your local FirstOffice
representative for details.

Edit Font, Report Font, Report Font Size

Paste Special Fonts in your system

These fields allow you to select different fonts for use
on screen and in reports respectively. If you leave these
fields empty, FirstOffice’s default fonts will be used.
These fonts are selected for maximum readability, and
you should only change them if you have good reasons
to do so. In non-English versions of FirstOffice, use
these fields to select fonts with special character sets.

Commercial Reg. No.

The Intrastat system is used to collect statistics on the
physical trade in goods (i.e. the actual movement of
goods) between the various member countries of the
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European Union (EU). If your business is situated in an
EU country and its trade with companies in other EU
countries is greater than the threshold value, it will be
necessary to send an Intrastat report periodically to the
relevant authorities. You can do this by printing a
document or exporting a text file. In both cases, the
report should include your company name and address
(from the ‘Address’ card above), your VAT Number
(above) and a company or branch ident ifier (entered in
this field). You should have a separate identifier for each
branch if you will be submitting Intrastat returns from
different branches using the same VAT Number.

VAT Law Paste Special Choices of possible entries

Use this field to ensure the behaviour of FirstOffice
conforms to the local accounting conventions in your
country. If your country is not listed in the ‘Paste
Special’ list, choose the “Default” option.

Character Set Paste Special Choices of possible entries

This field is used to control sorting in FirstOffice. In
countries where the alphabet differs to that of the
UK/US, sorting by ASCII codes produces a list that is
not in the correct alphabetical order: use this field to
overcome this problem.

Country Enter your Country of operation here. This must be the
same as the Country that you enter in the Weeks setting
(see below).

Confirm the entry by clicking [Save], or cancel it by closing the window
using the close box.

Configuration

Use this setting to register the Value Packs you have purchased, how many
Companies there are in your FirstOffice database and how many users will
have access to the system. Once you have done this, FirstOffice will generate
a Control Code, which you should quote when you need to obtain an Enabler
Key. The setting is fully described in the sections entitled ‘Value Packs,
Users and Companies’ and ‘The Enabler Key’ on pages 44 and 47
respectively in the first chapter of this manual, while Value Packs are
described in Volume 4.
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Conversions - Master, Conversions - Accounts

These settings allow you to move all postings to one or more Accounts to
another Account. For example, you might have been using Account 100 for
sales of a particular product, but for some reason you want to use Account
102 instead. These settings allows you to change Account 100 wherever it
appears in the Transaction register to Account 102 and to recalculate all
previous entries to the old Account, so that they will appear under the new
Account in all reports. To do this recoding you must follow the steps
below—

1. Make a back-up of your entire database and quit FirstOffice.

2. Remove the FirstOffice database file (named “1Office.HDB”) from the
folder or directory containing your FirstOffice application. Ensure,
however, that the “DBDef.txt” and “Default.txt” files are present.

3. Launch FirstOffice again. Because there is now no “1Office.HDB” file, a
new database is created. Enter new Company information to the dialogue
(a Code and Name is sufficient): click [Save] and double-click the new
Company in the subsequent list.

4. When the ‘Import files available’ window appears, close it by clicking
the close box. Do not import anything yet.

5. Select the System module using the [Select Module] button in the Master
Control panel, and select ‘Settings’ from the File menu. Double-click
‘Conversions - Accounts’ in the subsequent list. Enter the old and new
Account numbers one by one in the window as shown in the illustration.
Finish by saving the setting by clicking [Save].
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6. From the ‘Settings’ list, select ‘Conversions - Master’ and enter a check
mark in the Convert Accounts check box. Save the setting by clicking
[Save].

7. Select ‘Imports’ from the File menu and import the back-up using the
‘Automatic’ or ‘Automatic, manual file search’ import routines. Quit
FirstOffice and restart if so prompted.

8. The routine will renumber the Account records in the Account register as
required. In the example, Account 100 will be given the new number of
102. If Account 102 already existed, the old Account (100) would be
deleted. Check the Account register to make sure that this has happened.

9. Produce a Nominal Ledger report for one of the new Accounts and check
that all the Transactions have been converted as you expected.

10. You must now inspect and change all report definitions in the Nominal
Ledger where the old Account number has been used.

11. Return to the Conversions - Master setting in the System module and
turn off the option to Convert Accounts.

12. Return to the Conversions - Accounts setting and delete everything line
by line.

During the import of the back-up file, all references to the old Account
numbers will be replaced in all transactions (including Sales and Purchase
Ledger transactions and Sales Order records) and in all settings (including
Account Usage S/L and Payment Modes).
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Note that if you have more than one Company in your database, the
conversion will apply to all Companies in that database. If you want the
conversion to take place in one Company only, follow the procedure
described above with the following differences—

i. Before step 1, and working in the Company where the conversion is to
take place, enter the old and new Account numbers one by one in the
Conversions - Accounts setting. Check that the setting is empty in all
other Companies, or, if you want a different conversion to take place in
another Company, enter old and new Account numbers in that Company
as necessary.

ii. Omit step 5.

So, if the Conversions - Accounts setting in all Companies is empty when the
original database is exported in step 1, any conversion on import will be
determined by what you enter to the setting in step 5. If the Conversions -
Accounts setting in a particular Company is not empty when the original
database is exported, its contents in that Company only will override what
you enter to the setting in step 5. Therefore, it's important to empty the
Conversions - Accounts setting after conversion in all Companies in step 12:
this is not done automatically. If you do not do this, the conversion may have
unexpected results the next time you carry it out.

Conversions - Master, Conversions - Suppliers

The Conversions - Suppliers setting is described in the section entitled
‘Combining Customers and Suppliers’ on page 246 in the ‘Customers and
Suppliers’ chapter elsewhere in this manual.
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Date and Numbers

Use this setting to ensure your FirstOffice installation displays and prints
dates and numbers using your preferred date and number formats.

Internally, FirstOffice features full Year 2000 compatibility: all dates are
stored with four-digit years (e.g. “2005”). If you switch on the Century check
box, FirstOffice will display the century digits in all dates. However, you do
not have to type the extra two century digits, they will be added
automatically by FirstOffice. If you enter “100405” in a date field,
FirstOffice will change it to “10-04-2005”.

In the current version of FirstOffice, the Century check box must be checked
for the long dates to appear in the text back-up and in FirstOffice’s different
Export files. If the box is not checked, all dates in the exported files will be
written as short dates, without the century digits. This will create a problem if
you later import a back-up or an export file containing dates from both
centuries.

Our recommendation is always to check the Century box. This will make
certain that your FirstOffice program will behave correctly, both internally
and when you communicate with other applications.

In single-user systems, whenever you make a change in this setting, its effect
will be immediate and universal.

In multi-user systems, you can change the Date and Numbers setting, but the
changes will not take effect until the server has been restarted. You can also
have different date and numeric formats on a particular client machine. To
choose date and numeric formats for a client machine, use the Client Date
and Numeric Format setting in the User Settings module. These formats will
be used on that machine irrespective of the Person logging in. You will need
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to quit FirstOffice and restart on that client machine only (not the server) for
the change to take effect.

If a particular client machine has its own date and number formats, they will
be used on screen and in reports. However, numbers and dates will be printed
in documents using the formats chosen in Company Date and Numeric
Formats setting, to retain corporate identity.

Dates and Export Files
Be careful when opening a FirstOffice Export file with Microsoft Excel with
the intention of editing it before importing it to a new database. Under certain
circumstances, Excel will, when opening a text file, convert some variables
that it interprets as dates into its own internal date format. Where you are
expecting a date to appear in the spreadsheet you may see a number such as
“35475”. When you save the spreadsheet again as a text file these variables
will not be converted back to date format. So, if you import this text file to
FirstOffice, the dates will be wrong. To avoid this problem, make sure you
use the third step of Excel’s Import Wizard to set all imported columns to
‘text’ format (highlight all the columns in the Data Preview area using the
Shift key and select ‘Text’ as the Column Data Format).

You cannot open files created using the ‘Database Text Backup’, ‘Company
Text Backup’ and ‘Client Text Backup’ functions in Excel as they are not
text files.
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Fiscal Years

FirstOffice has a multi-year database. In this setting you can define several
financial years. Each year must have a Code, and can be between 6 and 18
months in duration. The Code will be used as a prefix for Transactions
entered directly to the Transaction register in the Nominal Ledger.

Note that you should always list your Fiscal Years in chronological order as
shown in the illustration. You cannot insert new Fiscal Years at the top of the
list, or remove old Fiscal Years. You should not make any changes to a
Fiscal Year once a transaction has been posted.

FirstOffice will issue a warning whenever you try to post a transaction whose
date does not fall in a Fiscal Year as defined in this setting.

Form Settings

Use this setting to control how addresses are printed in documents (in the
Address and Delivery Address fields).
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Print Blank Lines By default, blank lines in addresses are not printed in
documents. Use this option if you want the blank lines to
be printed.

Organisation Name

Use this option if you want the Customer Name to be
printed as the first line of the address.

Internet Enablers

Please refer to the section entitled ‘The Enabler Key’ on page 47 in the first
chapter of this manual for full details of this setting.

Locking

This setting allows you to close an accounting period to prevent the further
entry of new or corrected transactions. You will do this by specifying a cut-
off date: no transactions whose Transaction Date is on or before this cut-off
date will be permitted. Because Locking is carried out by specifying a single
date, months or periods must be locked chronologically.

FirstOffice does not force you to close months or periods, but this setting
allows you to do so if necessary.

Lock Transaction If you enter a date in this field, the entry of Transactions
whose Transaction Date is on or before this date will not
be permitted. This applies only to Transactions entered
directly to the Transaction register in the Nominal
Ledger.
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If you discover that a Transaction that falls within a
closed month contains an error, you can only correct it
using the ‘Correction Mark’ function. Please refer to the
‘Correcting Transactions’ section of the ‘Nominal
Ledger’ chapter in Volume 2 for full details.

If you try to enter a Transaction whose Transaction Date
is on or before the Lock Transaction date, the following
warning will appear—

Warn on Transactions

If you enter a date in this field, a warning will be
displayed when you enter a Transaction whose
Transaction Date is on or before this date. You will still
be able to save the Transaction. This applies only to
Transactions entered directly to the Transaction register
in the Nominal Ledger.

If you try to enter a Transaction whose Transaction Date
is on or before the Warn Transaction date, the following
warning will appear—

No Preliminary Transactions

If you are using Preliminary Transactions (this is
controlled in the Transaction Settings setting in the
Nominal Ledger), and you have entered a date in this
field, only those Transactions whose Transaction Date is
after this date will be treated as Preliminary (i.e.
modifiable). All Transactions whose Transaction Date is
on or before this date will not be modifiable.
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If the No Preliminary Transactions date is later than the
Lock Transaction date, you will be able to enter
Transactions with a Transaction Date that falls between
them. Such Transactions will be treated as actual
Transactions as soon as they have been saved (i.e. they
will never be modifiable).

Lock Others If you enter a date in this field, the creation of records in
any of FirstOffice’s transaction registers whose
Transaction Date is on or before this date will not be
permitted. This covers all transaction registers including
Goods Receipts and Deliveries except Invoices or
Purchase Invoices, which have separate controls
(below).

Warn on Others If you enter a date in this field, a warning will be
displayed when you enter a record in any of
FirstOffice’s transaction registers whose Transaction
Date is on or before this date. You will still be able to
save the record. Again, all transaction registers except
Invoices and Purchase Invoices are affected.

After locking the accounts at a
certain date, you may not enter
Transactions with earlier dates, and
you may not alter earlier
Transactions.

Delete Before Date

Under normal circumstances, you cannot delete Nominal
Ledger Transactions or approved records in the
transaction registers. However, it can be necessary to
delete such records in certain situations, perhaps because
disk space is at a premium and the previous year‘s
accounts have been committed to an archive file.

To allow the deletion of such transactions, you must
enter a Delete Before Date in this field. You will only be
able to delete Nominal Ledger Transactions and records
in FirstOffice’s transaction registers whose Transaction
Date is on or before this Delete Before Date.

You will be able to delete individual records using the
‘Delete’ function on the Record menu, and groups of
records using the ‘Delete Old Transactions’

!
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Maintenance function in the System module. This latter
function will only delete records whose Transaction
Date is on or before the Delete Before Date specified
here.

Use great care when attempting to
delete records, and make sure you
have a backup before you remove any
data.

Lock Sales Invoices

If you enter a date in this field, the creation of Invoices
whose Transaction Date is on or before this date will not
be permitted.

Warn on Sales Invoices

If you enter a date in this field, a warning will be
displayed when you enter an Invoice whose Transaction
Date is on or before this date. You will be able to save
the Invoice.

Lock Purchase Invoices

If you enter a date in this field, the creation of Purchase
Invoices whose Transaction Date is on or before this
date will not be permitted.

Warn on Purchase Invoices

If you enter a date in this field, a warning will be
displayed when you enter a Purchase Invoice whose
Transaction Date is on or before this date. You will be
able to save the Invoice.

!
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Once you have entered a date in any of the fields in this setting, you will
usually only be able to change that date to a later one. You will not be able to
change it to an earlier date. When a period or month is locked, you should
print and file all management reports (e.g. Balance Sheet, Profit & Loss
report, etc), and so it will not be appropriate to re-open the period to post new
transactions. However, in some exceptional circumstances, it may be
appropriate to change a locking date to an earlier one. If you want to do this,
you must belong to an Access Group where Full access has been granted to
the ‘Allow Changing of Locking’ Action—

Access Groups are described above on page 307.
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Number Series Defaults

FirstOffice allows you to define several Number Series (number sequences)
for use in generating Order Numbers, Invoice Numbers, Transaction
Numbers and so on. By default, FirstOffice will select the next available
number from the first Number Series defined for the current period whenever
you create a new record.

If you have several number sequences in each Number Series setting, you
can specify here which one is to be used as the default when creating new
records in each register. Take care to specify a number in each field that falls
in a recognised Number Series. If you specify a number that is not in a
Number Series, all new records in the affected register will not be given
serial numbers when they are created. The implications of this are quite far
reaching: for example, Invoices will not be created by any of the remote
Invoice creation functions (e.g. from Sales Orders). This situation will be
most common in cases where Number Series are tied to a period such as a
calendar year and that period ends.

If you are not using Number Series, FirstOffice will normally start
numbering transaction records from 1.

Click [Save] to save any changes and close, or the close box to close without
saving changes.
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Reporting Periods

This setting allows you to name and define certain time periods. These
should be the periods that you will commonly use when producing reports:
using ‘Paste Special’ from the Period field of a report specification window
will bring up a list of the Report Periods entered using this setting. For
example, if you want to produce monthly reports you should define each
month as a separate period in this setting.

Once memorised, the Code can be used as a fast way of choosing a Report
Period. For example, using the Report Periods illustrated above, type
“Q1CY” in the Period field of a report specification window when you want
the report to cover the period “1/1/2005:31/3/2005”.

To enter a new Reporting Period, simply click in the first blank line and enter
details as appropriate. Click [Save] to save and close, or the close box to
close without saving changes.

Note that the Reporting Period in the first row of this setting will be offered
as a default wherever a Reporting Period is required. You might therefore
like to change the first row from time to time so that a useful option is always
offered as a default. To delete the old first row once it is no longer useful,
click on the row number and press the Backspace key. To insert a new record
on the first row, click on the row number and press the Return key.

Round Off

Use this setting to control the way calculations are rounded off. The setting is
used by Sales Orders and Sales and Purchase Invoices. Any amounts lost or
gained from the rounding off process are posted to the Round Off Account
specified in the Account Usage S/L setting. This Account is used in
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Transactions generated both from the Sales Ledger and from the Purchase
Ledger.

Totals This group of options sets the rule for rounding off Total
figures (i.e. including VAT) in Invoices and Orders.

VAT This group of options allows you to use a different
rounding off rule for taxes. This rule applies to Orders,
Invoices and Purchase Invoices.

FIFO This group of options allows you to determine the
rounding method to be used when calculating FIFO
values in the Stock List report.

If you have chosen to have the Cost Prices of your Items
updated automatically from approved Goods Receipts,
prices in Goods Receipts will be rounded up or down
according to the rounding rules set here before they are
used to update the Cost Prices of Items.

The Weighted Average of each Item will also be
rounded up or down according to the rounding rules set
here.

Discount Calculation

This group of options allows you to determine how
discounts are calculated in Sales Orders and Invoices. In
certain circumstances (where there is a very small unit
price and a large quantity), the two alternatives can
produce different results due to rounding. If you choose
the Value Discount option, the discount will be
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calculated after the multiplication of the unit price and
the quantity. If you choose the Price Discount option,
the discount will be applied to the unit price before it is
multiplied by the quantity.

For example, you receive an Order for 20,000 items
priced at 0.05 with a 25% discount. Using the Value
Discount option, the calculated discount is 250—

20000 x 0.05 = 1000. 25% of 1000 = 250

Using the Price Discount option, the calculated discount
is 200—

25% of 0.05 rounded to two decimal places is
0.01. 0.01 x 20000 is 200

Click [Save] to save any changes and close, or the close box to close without
saving changes.

Weeks

Use the Weeks setting to define the Week Numbers that are shown in the six-
monthly and monthly Calendar views and in the ‘Paste Date’ window. Week
Numbers can vary from country to country and depending on when the year
started. The six-monthly and monthly Calendar views are described in the
‘Activities, Calendar and Task Manager’ chapter in Volume 3 of these
manuals, and the ‘Paste Date’ window is described on page 92 in the ‘Work
Area’ chapter earlier in this manual.

You only need enter one record to the Weeks setting. You should update this
record regularly, so that Week Numbers continue to appear in the Calendar
and the ‘Paste Date’ window. Ensure you are in the System module and click
the [Settings] button in the Master Control panel or select ‘Settings’ from the
File menu to open the ‘Settings’ list. Double-click ‘Weeks’ in the list. If you
have already entered a Weeks record, it will be shown in the ‘Weeks:
Browse’ window. Double-click it to modify, or click [New] to create a new
record.
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Complete the grid for each year of use as shown in the illustration (there is
no need to have the years in order, but you should only enter each year once).
Click [Save] in the Button Bar to save, and then click the close box to save
the record. The Country should be the same as that entered on the ‘Reg’ card
of the Company Info setting.
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The Company Register
If your business is one where there are separate departments or subsidiary
companies that keep separate accounts, these can be set up as separate
accounting entities in FirstOffice using the Company register in the System
module. Each department or subsidiary is termed a ‘Company’. If you set up
more than one Company in FirstOffice, each will be completely separate:
there will be no common information, although you can copy from one to
another using the export and import functions. Separate account balances will
be maintained, and each Company within a database can be backed up
separately or together. You can have up to four Companies in a FirstOffice
database.

Note that you should only use this feature to differentiate between different
departments if you intend to account for each of them separately. If you keep
a single set of accounts covering your whole organisation, you only need
have a single Company in your database.

On launching FirstOffice for the first time, your first task will normally be to
create a Company. Please refer to page 37 in the first chapter of the manual
for full details.

You must ensure you have at least
one Company as your first task in
using FirstOffice.

The number of Companies that you can create is restricted by the
Configuration setting (in the System module). In a new database, this number
will always be one. If you need more than one Company, it is advisable to
enter as many Companies as you need straight away, so that you only need
apply for an Enabler Key once. The Enabler Key is dependent upon the
number of Companies entered, so you will need to apply for a new one if you
add a new Company later. Remember that each Company will maintain
completely separate accounts, so there is no need to create separate
Companies for departments that are part of the same accounting whole.

!
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Entering Companies

This is the first task to be completed when creating a FirstOffice database.
The process is fully described on page 37 in the first chapter of this manual.

If you have been working with a FirstOffice database for some time and need
to change or add to the information in the Company register, ensure you are
in the System module and click the [Companies] button in the ‘Registers:
System’ section of the Master Control panel. The ‘Companies: Inspect’
window appears: this is the same as that used to enter Companies when
starting to use FirstOffice. Please refer to page 46 in the first chapter of this
manual for details.

You can add new Companies at any time (up to a maximum of four), but
remember that doing so will mean that you will need to apply to your
FirstOffice representative for a new Enabler Key.

For security reasons, FirstOffice will shut down after any changes or
additions have been made in the Company register. Restart the program to
continue working.

If you need to change or add to the information in the Company register in a
multi-user system, you must do so either working on the server itself or
having logged on from a client in “Admin Client” mode. “Admin Client”
mode is described below on page 335.

The “Default.txt” file must be present
when adding Companies.!
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Working with Companies

If you have set up more than one Company, you will need to inform
FirstOffice which one you would like to work with each time you start work.
Whenever you launch FirstOffice, the ‘Select Company’ list window will
appear automatically—

Highlight the Company you wish to work with and press the Enter key (or
double-click on the Company in the list).

If you need to change Companies in the middle of a work session, there is no
need to quit FirstOffice and restart. Instead, go to the File menu and select
‘Company’, or click the [Companies] button in the ‘Personal’ section of the
Master Control panel. The ‘Select Company’ list will appear, where you can
choose a new Company to work with.

In a multi-user installation, choose any Company when starting the server.
Users will then be able to log on to and work with any of the Companies
stored within that database.

The Admin Client

In multi-user systems, almost all work done on a client machine will be
saved in the database on the server, and will therefore be available to the
other clients immediately. For example, a change made from a client
machine to the Reporting Periods setting will immediately affect reporting
from all other clients.

In a very small number of cases, the work will be saved in the database on
the client machine and will therefore only affect the operation of that client.
These special cases are the Date and Numbers setting and Company register
in the System module.
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To change these settings and registers in the server database you must either
work on the server itself, or you must log on from a client as the system
administrator, and then change to “Admin Client” mode. You must use the
second method if your server does not have a graphical interface, or if it is
otherwise inconvenient to work on the server (e.g. it is in another building).
To do this, go to the Technics module using the [Select Module] button in the
Master Control panel (or the Ctrl-0 or -0 keyboard shortcuts) and open the
Program Mode register. Choose ‘Admin Client’ from the Operations menu.
Once you have completed the setup work, leave “Admin Client” mode by
returning to the Program Mode register and choosing ‘Normal Client’ from
the Operations menu as the final step.

Ensure you leave “Admin Client”
mode as soon as possible.

Before changing to “Admin Client” mode, you should check that no other
users are logged in. If you change the Company register on the server, the
server will shut down, so you will need to close the client as well.

In multi-user systems, you can control who can change to “Admin Client”
mode using Access Groups (by giving full access to the ‘Admin Client’
Action). Access Groups are described above on page 307.

!
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The Person Register
This register holds information about Persons, i.e. users, employees, sales
persons etc. You can use it as part of your FirstOffice security system: each
Person can be given their own password. Once you have entered at least one
record to the register, starting FirstOffice will require the entry of a Person’s
initials and, if appropriate, a password.

To open the Person register, ensure you are in the System module, then click
the [Persons] button in the Master Control panel. The ‘Persons: Browse’
window is opened, showing Persons that have already been entered.

To enter a new record, click [New] in the Button Bar or use the Ctrl-N
(Windows and Linux) or -N (Macintosh) keyboard shortcut. Alternatively,
highlight a Person similar to the one you want to enter and click [Duplicate]
on the Button Bar.

The ‘Person: New’ window is opened, empty if you clicked [New] or
containing a duplicate of the highlighted Person.
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Signature Enter the Person’s initials to be used when logging on,
or to identify the Person from elsewhere in FirstOffice.

If there is more than one Company in the database,
records in the Person register (as with all registers) are
specific to the Company in which they are entered.
However, if you are using the CRM and Mail Value
Pack, each Person’s Mailbox will be open to all
Companies in the database. This allows mail to be sent
between Persons in different Companies. One
implication of this is that all Persons across all
Companies should have different initials. If there are
two or more Persons in different Companies with the
same initials, they will not be able to have separate
Mailboxes.

Name The name of the Person.

Access Group Paste Special Access Groups setting, System
module

Enter an Access Group, perhaps representing the
department in which the Person works. By allocating an
Access Group, you can restrict the Person’s access to
certain modules or parts of modules. Please refer to the
section covering Access Groups above on page 307 for
full details.

Job Descr. A short job description or title.

Our Ref Using the Our Ref field, you can assign a short (up to 20
characters) reference text for the individual. This text
will appear in the Reference fields of all transactions
entered by this Person.

Email Address The employee’s email address.

Bonus You can enter a bonus percentage for each individual.
This figure will be used by the Bonus, Salesman report
in the Sales Ledger (described in the ‘Sales Ledger’
chapter in Volume 2 of these manuals).

As soon as you have entered a single
Person in the Person register, the
password dialogue will appear each
time you start FirstOffice.

!
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Operations Menu

The Operations menu for Persons is shown above. It is available for the
‘Persons: Browse’ window: highlight a Person in the list before selecting the
function.

Change Password
Once you have recorded a user or employee to the Person register, they will
be able to log in to and use your FirstOffice database. For security reasons,
therefore, it is recommended that all Persons have their own passwords and
that these are changed from time to time.

You can assign Passwords to Persons as you add them to the Person register.
If you do not do this, each Person will be asked to set a password the first
time they log in. To set a password for a Person as you add them to the
Person register (or to change a password at any other time, for example if a
Person leaves the company), highlight their name in the ‘Persons: Browse’
window and select ‘Change Password’ from the Operations menu. The
following window is opened—

Type in the new password twice to ensure that it is correct. Click [Save] to
close the window and save: use the close box if you do not want to save
changes. The password is case-sensitive.

Each Person can also change their own password, even if they do not have
access to the System module. Open the Master Control panel (or bring it to
the front) and select ‘Change Password’ from the Operations menu. Then,
follow the instructions above.
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Create Mailbox
To create a Mailbox for a Person, first click on the Person in the ‘Persons:
Browse’ window and then select ‘Create Mailbox’ from the Operations
menu. Only one Mailbox can be entered for a particular Person: if a Mailbox
already exists, the function will have no effect.

The Mailbox is opened in a new window entitled ‘Conference/Mailbox:
New’. This means that it has not yet been saved. After amendment if
necessary, save the Mailbox by clicking the [Save] button in the Button Bar.
Alternatively, if you no longer require the Mailbox, click [Cancel].

The Person’s initials and Name will be copied from the Person record to the
new Mailbox, and the Class will be set to “Mailbox”.

To close the screen and return to the ‘Persons: Browse’ window, click the
close box. You will be asked if you would like to save any changes that you
may have made.

For more details about Mailboxes, please refer to the ‘Mail’ chapter in
Volume 4 of these manuals. You must have the CRM and Mail Value Pack if
you want to use Mailboxes. If you do not have the CRM and Mail Value
Pack, you must still create a Mailbox for each Person if you want them to be
able to use the Personal Desktop. Please refer to page 137 in the ‘Work Area’
chapter elsewhere in this manual for more details about the Personal
Desktop.
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The Account Register
This is where you define the Chart of Accounts. Each Account has a number
and a name, and belongs to a class of Accounts.

FirstOffice does not have any hard-coded Accounts. You must define a Chart
of Accounts, or import an existing one. The simplest method is to use the
standard Chart of Accounts supplied with FirstOffice. Please refer to the
section entitled ‘Setting up a Basic Accounts System’ on page 54 in the first
chapter of this manual for details of how to do this.

If you use your own Chart of
Accounts, or modify the one supplied
with FirstOffice, it is important to
ensure that every Account used in the
settings and report definitions in each
module is a valid Account that exists
in your Chart of Accounts.

In FirstOffice you always have access to the Chart of Accounts through the
‘Paste Special’ feature, for example when you enter Transactions and cannot
remember an Account Number.

In the Account register you can—

• Show all Accounts on screen

• Search for a certain Account

• Inspect or change a certain Account

• Create new Accounts

• Remove Accounts you don’t need

• Print the Chart of Accounts.

 Showing all Accounts on screen

 To open the Account register, ensure you are in the System module, then
click the [Accounts] button in the Master Control panel. The ‘Accounts:
Browse’ window is opened, showing Accounts that have already been
entered.

!
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 The list contains two columns: Account Number and Account Name. The list
is sorted by the column whose heading is coloured blue. Click on the other
column heading if you want to change the sort order, and double-click on the
column heading to reverse the sort order.

 Searching for an Account

 In the ‘Accounts: Browse’ window shown above, you can scroll up and down
through the list of Accounts as usual. You can also search for a particular
Account by entering the first few characters of its Number or Name in the
Search field in the top right-hand corner of the window. Enter a Name if the
list is sorted by Name, a Number otherwise. FirstOffice will find the first
record that matches the text you have entered.
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 Inspecting or Changing an Account

 If you want to look at the details of an Account, double-click its name in the
‘Accounts: Browse’ window to open the Account record.

 

 The ‘Account: Inspect’ window contains the following information—

Account The unique number of the Account. You can use up to
ten characters, with a minimum of two.

Once you have saved the record, you cannot change the
Account Number simply by typing into the field. If you
need to change an Account Number, use the
Conversions - Master and Conversions - Accounts
settings in the System module, described above on page
317. These settings will change the Account Number
both here and in all other registers where the Account
has been used.

Name The name or description of the Account.

Auto. Trans. Paste Special Autotransactions setting,
Nominal Ledger

You can link an Autotransaction with a particular
Account by entering the code of the Autotransaction in
this field. When you enter the Account number in a
Transaction record, the Autotransaction will be entered
on the following rows automatically.
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VAT Code Paste Special VAT Codes setting, Nominal
Ledger

 You can assign a VAT Code to each Account. It will be
entered automatically every time you use the Account in
a Purchase Invoice or Nominal Ledger Transaction.

Account Type An Account can belong to one of five types: Assets,
Liabilities, Equity, Revenues or Expenses. This
information is used to control how the balance of this
Account will be stored, as a negative or a positive
figure. Assets and costs are treated as positive values,
while liabilities, equity and incomes are treated as
negative. If you need to change the sign of negative
(credit) values for reporting purposes, use the
Presentation of Balances setting in the Nominal Ledger.

Normal Amount Click one or both of the check boxes to indicate what
type of posting is the usual for the Account. If you are
using the Warn on Unusual Amount option in the
Transaction Settings setting in the Nominal Ledger, and
try to debit an Account usually used for credit or vice
versa, FirstOffice will alert you to the possible error.

Closed Check this box if you want to close the Account for
further Transactions. You will no longer be able to use
it, and it will not appear in the ‘Paste Special’ selection
window. If you want to open the Account again later,
you simply click in the box again to remove the check
mark.

 Entering an Account

 There are two ways to add new Accounts to the Chart of Accounts: creating a
new Account or copying and then editing an existing one.

 In the ‘Accounts: Browse’ window, click [New] in the Button Bar, or
highlight the Account to be copied and click [Duplicate] in the Button Bar.
The ‘Account: New’ window appears. This is as described in the previous
section.

 Enter the new information or change the copied record as appropriate. Click
[Save] to save the new record or [Cancel] to close without saving the record.
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 Deleting Accounts

 You can delete an Account from the Chart of Accounts, as long as it has not
been used in any Transactions.

 In the ‘Accounts: Browse’ window, double-click the Account you want to
delete. This opens the ‘Account: Inspect’ window.

 Select ‘Delete’ from the Record menu. The Account is deleted and the
previous Account in the list is shown.

 You cannot undo the deletion of an
Account. Used Accounts cannot be
deleted.

 Printing the Chart of Accounts

 You can print the Chart of Accounts using the ‘System Documentation’
report in the System module. This report is fully described in the ‘Reports’
section of this chapter below on page 364.

 !



HansaWorld FirstOffice Professional

346

The Form Register
FirstOffice has a built-in forms editor, which allows you to design every
document used in the program. To open the editor, ensure you are in the
System module using the [Select Module] button in the Master Control panel
and click the [Forms] button, also in the Master Control panel.

Double-click on a document to open the editing window, or click [New] or
[Duplicate] to create a new Form. When you have designed the Form, click
[Save] in the Button Bar to save it in the normal way.

The ‘Form: Inspect’ window shows the selected Form or document. At the
top of the window there are five buttons: [Text], [Line], [Frame], [Field] and
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[Picture]. In the editing area, each printing object in the Form is shown either
as a framed box, or as text. You can select an object by clicking on it with the
mouse and then drag it to another place, re-size it etc. as in most drawing
programs.

Editing Objects

To edit an object, double-click on it with the mouse. This will open a
dialogue box, where you can perform certain editing functions. These are
described for each object type below. For all object types, use the Left, Top,
Right and Bottom fields to set the location in pixels of the four sides of the
object. The Justification options allow you to justify the text as you wish.
Style refers to the Style register, where you can set font, font size and font
style.

Text Objects
To add a new text element to the Form, click the [Text] button and then draw
the object where you want the text to appear.

When you release the mouse button, the following dialogue box will
appear—

Text The text that is to be printed on the Form. This can be up
to 80 characters long, but it is limited to one line. To
create a text area with more than one line, use the
appropriate number of separate one-line text objects.

Left, Top, Right, Bottom

Use these fields to specify the size and position of the
text box that is to contain the text. When you create a
new text box, the measurements of the box that you have
just drawn will appear here.
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Style Paste Special Style register, System module

Use this field to assign a font and font style to the text.
Styles are defined using a separate register that is fully
described below on page 357. If you do not enter a Style
here, the first record in the Style register will be used.

Justification Use these options to specify where the text will appear
inside the text box.

Exclude from page

Please refer to the ‘Single- and Multi-Page Forms’
section below on page 353 for details about these
options.

Click [OK] to close. The text field is visible on the screen, and you can move
it around the Form with the mouse.

To edit a text object once it has been created, double-click it to open the
‘Text’ dialogue box.

Lines and Frames
Use these tool buttons to draw lines and frames on the Form. Click either
button and then draw the object. When you release the mouse button, a
dialogue box will appear where you can indicate the width in pixels of the
line or frame.

Fields
A field is an area on the Form where information from FirstOffice’s database
is to be printed. The following example from an Invoice Form explains
how—

Fields appear as framed boxes containing the field name, e.g. “Delivery
Date”. The box frames are for identification only: they will not be printed.
You can use the [Frame] button to add a printing frame if necessary. Above
each field is a text object (created using the [Text] button as described above
on page 347) that identifies the information shown in the field. These would
not be necessary if the Form is to be printed on pre-printed stationery.
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To add a field, click the [Field] button, and mark the position of the field. A
dialogue box opens—

Enter the Field Name (use ‘Paste Special’ to see all available Field Names
for the Document Type), and paste a style in the Style field. Some fields
consist of more than one line (e.g. Comment fields, and the fields listing the
Items in Orders and Invoices). You can modify the spacing between lines (in
pixels) using the Spacing field. Usually the number of pixels that you specify
here should be the same as the font size. If you leave this field empty, the
lines of text may be printed on top of each other.

In the case of matrix fields (for example, those printing the Items in Orders
and Invoices), you should enter “1” as the Format (as well as specifying a
vertical Spacing). If you do not do this, the printed matrix columns may not
be aligned correctly if the first row only contains text.

Click [OK] to save.

Document Types are described in the section covering the ‘Properties’
Operations menu function below on page 351.

Notes and Comments
Usually each field that you place in a Form corresponds to a field in the
original record. For example, the Customer Number field in the illustration
above will print the contents of the Customer Number field in each Invoice.
An exception is the “Note” field. If you include the “Note” field in your
Form design, this will print the first note or comment that you attach to the
original record using the Attachments feature.
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Pictures
Use the [Picture] button to include a picture in your design. As with other
tools, click the button and draw a frame for the picture on the Form. A
dialogue box then appears. In the Picture Name field, enter the file name of
the picture as it is on your hard disk. The picture must be stored in the same
directory or folder as the FirstOffice database and application. In multi-user
systems, the picture should be on both the server and the clients. You can use
‘Paste Special’ to ensure that the file name is spelt correctly, but this method
will bring in the full path name of the picture. It is recommended that you
remove the path name to leave the file name only. If you do not remove the
path name, it will become incorrect if you move your FirstOffice folder and
as a result the picture will no longer be printed.

In the Windows environment, files of BMP format are supported. For
Macintosh users, EPS and PICT formats are supported. For Linux users, files
of BMP and EPS format are supported. In mixed networks, you should have
versions of each picture on your server in each format, and you should use
the [Picture] button to include all versions in your Form design (i.e. you
should have BMP, EPS and PICT picture objects in each Form, depending on
the machines in your network). This will ensure the picture will print
correctly from clients of all types. If a picture does not print, opening it in
Adobe Photoshop and saving it may correct the problem. The name of the
picture file must have an extension, and both the name and extension must be
in uppercase characters. The file should be smaller than 200K.

Operations Menu
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Properties
This menu command opens the ‘Form Properties’ dialogue box. Here you
can record the basic specification for the Form currently being edited.

Code A unique code for the Form. If you have created a new
Form by copying a template, you must enter a new Code
here before you can save it.

Comment A description of the Form, e.g. Invoice.

Matrix Rows On Please refer to the ‘Single- and Multi-Page Forms’
section below on page 353 for details about these
options.

Document Type Using ‘Paste Special’, enter one of the available
Document Types into this field. When the time comes to
add fields to the Form, only the fields available for that
Document Type will be available in the ‘Paste Special’
list in the ‘Field’ dialogue box.

Printer Dialog Check this box to force a printer dialogue to be shown
each time the Form is printed.
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PC Printer
If you are using a dot matrix printer, use this dialogue box to define the page
size.

A dot matrix printer needs certain settings for printing on continuous
stationery. If you are printing a document to pre-printed forms, you may need
to define the number of rows in the page, the number of visible rows and the
left margin for the forms used.

Copies

Use this function to specify how many copies should be printed each time the
Form is used, the headings to be printed on each copy and the printer tray
from which each copy is to be printed. If you want the headings to be printed,
be sure to include the Copy Type field in your Form design. In the example
illustrated above, we have specified that two copies of each Invoice will be
printed: one marked “Office” and one “Customer”. Only one copy (marked
“Office”) will be printed if the Invoice is not approved, and if an approved
Invoice has already been printed.
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Send to Back
If you wish certain objects on the Form to appear behind other objects, select
them and select this function.

View All, First Only, Middle Only, Last Only, Single Page Only
These functions are described in the next section, ‘Single- and Multi-Page
Forms’.

Single- and Multi-Page Forms

When you design a Form, you should consider what is to happen when the
printing of a document requires more than one page. Two options are
available—

1. The “simple” option, where the same page design is used for each page.

2. The “multi-page” option allows the use of up to four page designs, as
follows—

First The first page of a multi-page document.

Middle In a multi-page document, the pages between the
first and last pages.

Last The last page of a multi-page document.

Single The sole page of a single-page document.

Usually, the First and Single page designs will be the same.

When you add an object of any kind (i.e. text, line, frame or field) to a Form
design, you can use the Exclude From Page check boxes to specify the pages
on which the object is to be printed. If you do not check any of these boxes,
the object will be printed on every page. This will be the case when using the
“simple” option. If you want the object to be printed on certain pages only,
check one or more of the boxes. For example, if the object is to be printed on
all pages except the first, check the First box. If it is only to be printed on the
first page, check all boxes except the First box (i.e. it will be excluded from
all pages except the first).
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The text object in the illustration below will be printed on the first page
only—

To help with the design process, you can choose to display the objects from a
particular page. To do this, select ‘First Only’, ‘Middle Only’, ‘Last Only’ or
‘Single Page Only’ as appropriate from the Operations menu. For example,
select ‘First Only’ to view the objects that are to be printed on the first page
(i.e. those whose First box has not been checked). Select ‘View All’ to see all
objects, irrespective of the page on which they are to be printed.

The number of pages printed will vary from record to record, depending on
the number of rows that the record has. An Invoice with one Item will be
printed on a single page (i.e. using those objects whose Single box is not
checked). An Invoice with 100 Items (i.e. 100 rows) will be printed over
several pages. You should specify the maximum number of rows that can be
printed on each page by selecting ‘Properties’ from the Operations menu.
This opens the ‘Form Properties’ window, which has four fields under the
overall heading of Matrix Rows On—

In the case of the “simple” option, you should enter the same number to each
of these four fields. Otherwise, enter different numbers as appropriate. For
example, in an Invoice Form, First and Single are set to 5, Middle to 6 and
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Last to 7. Invoices will be printed as follows, depending on the number of
rows—

Invoice rows Pages Type of Page

Up to 5 1 Single
5-12 2 First and Last
13-19 3 First, Middle and Last
19-25 4 First, 2 x Middle, Last

Printing Forms

Once you have designed a Form, you should inform FirstOffice when it is to
be printed. You should do this by attaching the Form to an item in the
‘Documents’ list in the appropriate module. This is only necessary if you
have given your Form a new Form Code using the ‘Properties’ Operations
menu function.

For example, when printing an Invoice, FirstOffice, by default, will use a
Form with the Form Code of “INVOICE”. A template Form with this Code
is supplied with FirstOffice. If you have used this template as a basis for
designing your own invoice form and haven’t changed the Form Code, the
new design will be used automatically. However, if you have changed the
Form Code to, for example, “INVOICE1”, you should inform FirstOffice
that this is now the Form to be used for printing Invoices.

To do this, follow these steps—

1. Select the Sales Ledger module using the [Select Module] button in the
Master Control panel.

2. Click the [Documents] button in the Master Control panel. The
‘Documents’ list window is opened showing a list of available
documents. Highlight ‘Invoices’.

3. Select ‘Define Document’ from the Operations menu.

4. In the first row, “INVOICE” will be shown in the Form field. Change
this to the Form Code of your new invoice Form (“INVOICE1” in the
example). Use the ‘Paste Special’ feature to see the available forms in
your Form register and to ensure the spelling is correct.

5. Click [Save] to save the Invoice definition. From now on, whenever
Invoices are printed, the “INVOICE1” Form will be used.
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You can also use ‘Define Document’ (steps 3 and 4 above) to specify that
more than one Form is to be printed (for example, you might require that a
Delivery Note is printed with each Invoice).

The ‘Define Document’ function is available for many of the documents
printed by FirstOffice, allowing a high level of flexibility in the production of
printed output from FirstOffice. Further details are given in the chapters of
this manual covering the individual modules.

Related Items

The Style register in the System module is used to define the various type
styles, fonts, etc available for use when designing Forms.
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The Style Register
This register allows you to define the different font Styles to be used in the
Fields and Text objects in your Forms, ensuring a consistency of appearance.

Click the [Styles] button in the Master Control panel in the System module to
open the ‘Styles: Browse’ window and see a list of the defined Styles.

Double-click on a line to open the edit window or click the [New] button to
create a new Style.
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Code The code for the Style.

Comment Any description.

Mac/Windows/Linux Font

Paste Special Fonts available on your
computer

The name of the font file, as it appears in the Windows
directory or the System folder.

Mac/Windows/Linux Size

The font size in points.

Styles Select one of the available style types.

Do not use ANSI character set

Use this option if the Style is to use a non-standard
character set (for example, that used in barcodes).

If you are using FirstOffice on a mixed network with Linux, Windows and
Macintosh clients in any combination, you should specify Fonts and Sizes for
each platform in each Style record.
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 Maintenance

Introduction

 Maintenance functions allow you to carry out certain updating tasks, usually
involving batch processing and encompassing all or many of the records in
the affected register. There are four such functions available in the System
module. To use them, select ‘Maintenance’ from the File menu. The
following window appears—

 

 Double-click the chosen option. A specification window will then appear,
where you can decide how the function is to operate. Click [Run] to operate
the function.

Convert Suppliers to Customers

Please refer to page 246 in the ‘Customers and Suppliers’ chapter elsewhere
in this manual for full details of this function.

Create N/L Transactions

The integration between FirstOffice's different modules means that Nominal
Ledger Transactions can be generated automatically from other ledgers and
modules (‘Sub Systems’). For example, approving an Invoice in the Sales
Ledger can cause the automatic generation of a Nominal Ledger Transaction
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debiting a Debtor Account and crediting a Sales Account and, if appropriate,
a VAT Account. This feature is controlled using the Sub Systems setting in
the Nominal Ledger.

If you are not using this feature (i.e. if you are not using any of the options in
the Sub Systems setting), you will have to create the Nominal Ledger
Transactions yourself, or you can use this function to create them in batches
from records in the various Sub Systems.  If you want a list of the
Transactions that will be created by this function, produce an NL Transfer,
Subsystems report (in the Nominal Ledger) before running the function.

Select a Sub System from which Nominal Ledger Transactions are to be
created by clicking one of the radio button options. You should first
temporarily turn on the equivalent option in the Sub Systems setting. If you
wish to create Transactions for a particular range of Sub System records,
specify this in the Ser No field. In the illustration, Nominal Ledger
Transactions will be created for Goods Receipts numbers 20 to 30.

If a Sub System transaction contains an error, an error message will be
shown and the routine will be stopped.

 Nominal Ledger Transactions will not be created for unapproved Sub System
transactions.
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 Delete Old Transactions

 This option allows you to remove old transactions from the database, for
example when they are no longer needed for accounting or statistical
purposes.

 

 Select one or more registers from which records are to be deleted. Only
transactions that fall within the specified time period and/or number range
will be removed. No records later than the Delete Before Date specified in
the Locking setting in the System module will be deleted.

 In some cases, a record will not be deleted even if its date is earlier than the
Delete Before Date. For example, Invoices and Purchase Invoices will not be
deleted if they have not been paid or if the payment was received or issued
after the Delete Before Date.

Use this feature with great care, and
make sure you have a backup before
you remove any data.

Prepare Conversion Suppliers Settings

Please refer to page 246 in the ‘Customers and Suppliers’ chapter elsewhere
in this manual for full details of this function.

!
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 Reports

Introduction

 As with all modules, to print a report in the System module, select ‘Reports’
from the File menu or click the [Reports] button in the Master Control panel.
You can also use the Ctrl-R or -R keyboard shortcuts. Then, double-click
the appropriate item in the list.

 The following reports are available in the System module—

 

 A specification window will then appear, where you can decide what is to be
included in the report.

 Use the Media options at the bottom of the specification window to
determine the print destination of the report. The default is to print to screen.
You can initially print to screen and subsequently send the report to a printer
by clicking the Printer icon at the top of the report window.

 Once you have entered the reporting criteria and have chosen a print
destination, click [Run].

 With a report in the active window, use the ‘Recalculate’ command on the
Operations menu to update the report after making alterations to background
data. The ‘Reopen Report Specification’ command on the same menu allows
you to produce a new report using different reporting criteria.
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 Company Info

 This report is effectively a print-out of the Company Info setting. It also
shows licensing information such as the Control String and Control Code. It
is sometimes necessary to print this report when applying to your local
FirstOffice representative for an Enabler Key.

Convert Suppliers to Customers

Please refer to page 246 in the ‘Customers and Suppliers’ chapter elsewhere
in this manual for full details of this report.

Export Format

You can use the ‘Automatic’ and ‘Automatic, manual file search’ functions
to import information to your FirstOffice database. These functions are
described in full below on page 365. The information to be imported must be
placed in a tab delimited text file with the fields in the correct order. This
report displays the correct field order for each register.

Specify the View Code of the register you are interested in (or leave the field
blank to report on all registers), and click the [Run] button. The field is case
sensitive. The View Code is the code given to each register inside the
FirstOffice application.

 Record Count

 This report shows the number of records in each register and setting. It is
used for system maintenance.
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 System Documentation

 System Documentation produces a number of lists showing the records that
have been entered to certain settings. You can therefore use it to describe the
contents and set-up of your system. It may be a good idea to check the
contents of your system from time to time. This report is also useful for
auditing purposes since it contains important system information to be
included in a professional audit, such as the Chart of Accounts.

 Double-click ‘System Documentation’ in the ‘Reports’ list in the System
module. The ‘Specify System Documentation’ window is opened.

 

 Click the check boxes for each option that you would like to be included in
the report and click the [Run] button in the Button Bar.
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 Imports
 The ‘Imports’ function allows you to import information from tab-delimited
text files exported by other FirstOffice databases or Companies, or from
other applications such as spreadsheets. It also imports the encrypted back-up
files created by the ‘Company Text Backup’ and ‘Database Text Backup’
Export functions.

 When you select the function using the ‘Imports’ item on the File menu, an
‘Imports’ list window appears. There are two import options in the System
module: double-click one to start the import process. An ‘Open File’
dialogue box will appear, asking you to locate the file to be imported. Click
[Open] and the import will begin.

 Automatic

 You can use the ‘Automatic’ import to import text and encrypted files
created by any of FirstOffice’s export functions. It determines from
information contained in the first line of such files what the file contains and
thus in which register the information is to be saved.

 You should use this function when you need to restore from a back-up. This
process is described below on page 372. You can also use it to import
information to a Company holding the consolidated accounts of several
subsidiaries.

 A further use will be to import set-up information such as a Chart of
Accounts and base register data such as Customers and Suppliers, thus
ensuring that the task of accurately entering this information need only be
undertaken once.

 Finally, you can also use this function to import data exported from other
systems, after appropriate formatting. For further details, please contact your
local FirstOffice representative.

Automatic, manual file search

This import is similar to the ‘Automatic’ import described immediately
above in that you can use it to import from files created by any of
FirstOffice’s export functions. The only differences are—

• It allows you to import files from anywhere on your hard disk or on your
network, while files imported by the ‘Automatic’ function have to be
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located in the “Backup” or “Setup” folders in the same folder as the
FirstOffice application.

• It allows you to import files with any filename. The ‘Automatic’
function is restricted to files whose names do not contain any spaces or
other non-alphabetic characters but have .txt extensions.

• Comments inserted in the back-up files are not visible when you use the
‘Automatic, manual file search’ function, so be certain that you are
selecting the correct file to be imported. You can see these comments
when you use the ‘Automatic’ import.

To use the function to restore from a back-up, follow the procedure below.
To import data exported from other systems, after appropriate formatting or
from other Companies in your FirstOffice database, follow the procedure as
described below, but omit steps 1 and 2. If you have more than one
Company, ensure you are in the correct one before importing.

1. Move the old database (named “1Office.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2. Delete the database file “1Office.HDB” from the folder or directory with
your FirstOffice application, but make sure that the “DBDef.txt” and
“Default.txt” files are present in that folder. Double-clicking the
FirstOffice application now will force it to create a new database.

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

3. In the System module, choose ‘Imports’ from the File menu.

4. Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).

FirstOffice opens a standard dialogue box with a list of the files in the
current folder of the current volume. To find the back-up file, scroll
through the list or select another folder or volume in the normal way.

!
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5. Once you have found the file you want to import (the back-up to which
you wish to revert), highlight it and click [Open] or [Select] (depending
on the operating system), or double-click on the name of the file.

6. A message window informs you about the progress of the import.

7. When the import has finished, FirstOffice will shut down for reasons of
security if the imported file contains any Person register records. Restart
the program and you will then be ready to continue working.

Copy the old database to another
folder/directory or remove it, to avoid
mixing things up.!
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 Exports

Introduction

 You can export several different types of data from FirstOffice. You can
incorporate the exported information in external programs such as
spreadsheets, word processors etc. Apart from those created by the Back-up
functions, all exports are output in simple text format, with fields separated
by tabs.

 To produce an export file, select the ‘Exports’ item on the File menu or click
the [Exports] button in the Master Control panel. The window illustrated
below appears. This lists the Exports that you can produce from the System
module. Double-click the appropriate item. A specification window will then
appear, where you can decide the contents of the export file. Click [Run] and
a ‘Save File’ dialogue box will appear, where you can name the file and
determine where it is to be saved.
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 Company Text Backup, Database Text Backup

 These functions provide you with an effective way to back up your data.
They copy all data from the program to a separate file. You can also copy or
duplicate the database file (1office.HDB) on your hard disk, but FirstOffice’s
method has two advantages—

• The back-up file takes up very little space.

• The back-up file is independent of the program version. IT CAN
ALWAYS BE USED, whereas a new version of the FirstOffice program
(for reasons of internal updates in the program) may have difficulties in
reading old database files.

Use FirstOffice’s built-in back-up
feature to guarantee a successful
restoration.

This is how you back up your data—

1. In the System module, select ‘Exports’ from the File menu or click the
[Exports] button in the Master Control panel. The ‘Exports’ list is
shown.

2. Select ‘Company Text Back-up’ (if you wish to back up the data in the
database relating to the single Company currently selected) or ‘Database
Text Back-up’ (if you wish to back up the whole database) in the
‘Exports’ window and press the Enter key. In a single-user system, you
can use the [Backup] button in the Master Control panel as a short cut to
the ‘Database Text Back-up’ option.

Usually you should use the ‘Database Text Back-up’ option, as this is
the only choice that backs up the entire database. You must use it
regularly for your safety and peace of mind. Some registers and settings
(e.g. the Configuration setting and, if you are using the CRM and Mail
Value Pack, Mailboxes and Conferences) are stored at database level,
not Company level. These will not be exported by the ‘Company Text
Back-up’ option, even if your database only contains a single Company.
The ‘Company Text Back-up’ option is intended for use in the situation
where you need to move all the information relating to a specific
Company from one database to another.

In a multi-user system, you cannot use the ‘Database Text Back-up’
option on a client machine. You can only use it on the server machine,
when no other user is logged in. On the server, select ‘Quit, Remove

!
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Autoserver’ from the File menu and restart FirstOffice. Then, choose the
System module using the [Select Module] button in the Master Control
panel. If it is not convenient to work from the server, use the Timed
Operations setting in the Technics module (described on page 67 in the
first chapter of this manual). This will be the case if your server does not
have a graphical interface, or if it is in another room or building.

3. The “Specify Text Backup” window appears where you can describe the
back-up file using up to 40 characters. This description will be shown in
the list of importable files shown by the ‘Imports’ function. Click [Run]
to proceed.

4. FirstOffice opens a standard dialogue box where you can name and place
the export file. Enter the name of the file in the filename area and locate
it in the appropriate directory in the usual way.

The name of the back-up should include the date the back-up was made
(e.g. TC0711 for Training Company and date), but remember that you
can use a maximum of eight characters if you are using Windows NT
version 3. If you are intending to restore from the back-up file using the
‘Automatic’ function, add a .txt extension but do not include any spaces
or other non-alphabetic characters in the file name (the ‘Automatic,
manual file search’ function can import files with names that include
non-alphabetic characters and without extensions). Then, click [Save].

It is recommended that you store the back-up file in a folder or directory
named “Backup” which should be in the same folder or directory as the
FirstOffice application. All back-up files in this folder will be shown in a
list of importable files if it becomes necessary to restore from a back-up.
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5. A message window informs you about the progress of the export.

6. When the export is finished, you are brought back to the ‘Exports’ list.
Close it using the close box.

Make a rule to take a safety back-up
EVERY DAY! Your database can be
damaged, through hardware failures,
power cuts and other reasons. A
back-up file is a safety guarantee
against loss of data and loss of work,
should anything go wrong.

Note that, for reasons of security and unlike the other export files produced
by FirstOffice’s Export functions, the files created by the ‘Company Text
Backup’ and ‘Database Text Backup’ functions are encrypted files, not text
files.

!
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Restoring from a Back-up
To restore from a back-up, you must first create a new database. Then import
the back-up file using the ‘Imports’ function on the File menu in the System
module.

Restoration from a safety back-up is a non-destructive process, i.e. the back-
up file is not affected by the reading process. This means that you can use the
same back-up file more than once.

Restoring from a back-up is done in the following way—

1. Move the old database (named “1Office.HDB”) to another
folder/directory, to avoid mixing things up. Rename it so that you know
what it contains.

2. Delete the database file “1Office.HDB” from the folder or directory with
your FirstOffice application, but make sure that the “DBDef.txt” and
“Default.txt” files are present in that folder. Double-clicking the
FirstOffice application now will force it to create a new database.

It is important to restore to a new,
empty database, to avoid mixing the
restored data with the old, damaged
database.

3. In the System module, choose ‘Imports’ from the File menu. The
‘Imports’ window is shown.

4. Select ‘Automatic’ and press the Enter key (or double-click on
‘Automatic’).

FirstOffice opens a list of back-up files. To be included in this list, a
back-up file must be stored in the “Backup” or “Setup” folder or
directory which should be in the same folder or directory as the
FirstOffice application.

In the list, the filename of each back-up file is shown together with the
date it was saved and any comment added when it was created (see step
3 in the previous section).

!
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5. Highlight the file you want to import (the back-up to which you wish to
revert) and press the Enter key (or double-click on the name of the file).

6. A message window informs you about the progress of the import.

7. When the import has finished, FirstOffice will shut down for reasons of
security if the imported file contains any Person register records. Restart
the program and you will then be ready to continue working.

Copy the old database to another
folder/directory or remove it, to avoid
mixing things up.!
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If the Restoration Appears to Fail
Files whose name contains a space will be shown in the list of available
back-up files, but FirstOffice will not be able to import them successfully. If
the name of your back-up file contains a space (or it is not shown in the list
of available files because it is not stored in the “Backup” or “Setup” folder or
directory, or because its name does not have a .txt extension), continue with
these steps—

1. If it is still open, close the list of available import files using the close
box.

2. In the System module, choose ‘Imports’ from the File menu. The
‘Imports’ window is shown—

3. Select ‘Automatic, manual file search’ and press the Enter key (or
double-click on ‘Automatic, manual file search’).

FirstOffice opens a standard dialogue box with a list of the files in the
current folder of the current volume. To find the back-up file, scroll
through the list or select another folder or volume in the normal way.
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4. Once you have found the file you want to import (the back-up to which
you wish to revert) and click [Open] or [Select] (depending on the
operating system), or double-click on the name of the file.

A message window informs you about the progress of the import.

5. When the import has finished, FirstOffice will then close for reasons of
security if the back-up file contains at least one record in the Person
register. Restart the program: you are now ready to continue working.

Client Text Backup

You should use this function on client machines only for backing up
information that is stored locally. This information will not be included in the
normal daily back-up file made from the server. As very little is stored
locally (e.g. Companies), the resulting back-up file will usually be very
small. For example, window settings saved by each user using the ‘Save
Normal Position’ (Windows)/‘Save’ (Macintosh) functions on the Window
menu (i.e. window positions, sizes and sort orders) are stored on the client
machines. All information in the User Settings module is also stored on the
client machines. Company information is also stored on client machines, so if
there are several Companies in a client (i.e. it is capable of logging on to
several servers), then it is advisable to create a Client Text Backup
periodically.
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If the local machine has not been backed up before, you must create a second
Company, to be used for backing up only. Follow these steps—

1. Select ‘Company’ from the File menu. The ‘Select Company’ window
appears. Select ‘Open Company Register’ from the Operations menu.

2. The ‘Companies: Inspect’ window appears. On the second row, enter a
new Company. This should be a local Company, so leave the TCP/IP
and Port fields blank.

3. Save the new Company by clicking the [Save] button in the Button Bar.
For security reasons, FirstOffice quits automatically. Restart FirstOffice,
and choose to use the new, second, Company. You might wish to enter a
single record in the Person register with a password, again for security
reasons.

If the local machine has been backed up before and the second Company
already exists, you must log off from the server and change to the second
Company before backing up. Follow these steps—

1. If you are on the logged on to the server, quit FirstOffice.

2. Restart FirstOffice and choose to use the second Company. You cannot
change Companies using the ‘Company’ function on the File menu
because the two Companies are on different machines.

In both cases, you can now back up the local machine. Change to the System
module using the [Select Module] button in the Master Control panel, select
‘Exports’ from the File menu and double-click the ‘Client Text Backup’
option. From here, this option operates in a similar fashion to the ‘Company’
and ‘Database Text Backup’ functions described in the previous section, and,
like them, creates an encrypted file, not a text file.

Restoring from a Client Text Back-up
Whenever you update to a new version of FirstOffice, the new version should
be installed on the server and all clients, as described on page 72 in the first
chapter of this manual. If there are several Companies in the client (i.e. it is
capable of logging on to several servers), it will probably be easier for you to
recreate them by importing the Client Text Backup file into the new client
database rather than by typing them in to the Company register manually.
Also, if special window settings and/or settings in the User Settings module
have been saved on a local machine, you may want to ensure these are still
used after the update. To do this, you should import the Client Text Backup
file that you created from the old version following the instructions above. If
you do not have any special window settings, have not used the User Settings
module and if the Company register is easy to recreate manually, there is no



Chapter 7: System Module - Exports - Base Registers

377

need to import a Client Text Backup file, because no other important
information is stored locally.

Importing a Client Text Backup is done on the client machine in the usual
way. Install the new version of FirstOffice on the client, ensure there is no
1Office.HDB file in the folder containing the program and start the program.
If the ‘Import files available’ window appears, import the Client Text
Backup from there. Otherwise, change to the System module using the
[Select Module] button in the Master Control panel, and select ‘Imports’
from the File menu.

When the import finishes, you will need to quit FirstOffice and restart before
you can log in to the server.

Base Registers

In a similar manner to the ‘System Data’ export described below on page
379, this function allows you to export the records from any base register.

Select one or more options and use the Backup Comment to describe the
back-up file (up to 40 characters are permitted). This description will be
shown in the list of importable files shown by the ‘Imports’ function. Click
[Run] to proceed. If you have selected a single register, you may export a
selection of records in that register by specifying a code range in the Code
field. Then, give a name and destination to the file and click [Save].

Files created by this export can be imported to other FirstOffice Companies
or databases using the ‘Automatic’ or ‘Automatic, manual file search’ import
functions in the System module.
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Item Base Registers

In a similar manner to the ‘System Data’ export described below on page
379, this function allows you to export the records from any base register
related to Items.

Some of the registers in the ‘Specify Base Registers Export’ window may not
be used in your version of FirstOffice. An attempt to export information from
registers not present will result in an empty file.

Select one or more options and use the Backup Comment to describe the
back-up file (up to 40 characters are permitted). This description will be
shown in the list of importable files shown by the ‘Imports’ function. Click
[Run] to proceed. If you have selected a single register, you may export a
selection of records in that register by specifying a code range in the Code
field. Then, give a name and destination to the file and click [Save].

Files created by this export can be imported to other FirstOffice Companies
or databases using the ‘Automatic’ or ‘Automatic, manual file search’ import
functions in the System module.

Raw Data

This export is used for system maintenance, and requires a FirstOffice
system expert to be used correctly.

If the database has somehow become damaged, you will be prompted to
create a Raw Data export. You should do so, and you should then attempt to
create a Database Text Backup as well. The Raw Data option exports data in
byte order, while the Database Text Backup exports data in record order, on a
register-by-register basis.
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You can import a Raw Data export file in the usual way, using the
‘Automatic’ or ‘Automatic, manual file search’ options. However, because of
the way the Raw Data export file is structured, no indexes will be created.
Therefore, as soon as the Raw Data file has been imported, you must
immediately create a Database Text Backup and import that file to a new
database. This will ensure the data is properly indexed.

System Data

You can use this function to export basic information from a database. This
is a practical tool when you want to create a new Company that will use the
same basic accounts structure as your existing ones.

You can save much work by simply copying repeated data such as the Chart
of Accounts and afterwards changing whatever is different between the two
Companies.

The System Data export is saved as an ordinary text file, and you can import
it to the new Company using the ‘Automatic’ or ‘Automatic, manual file
search’ Import functions in the System module (described above on page
365).

Click the [Exports] button in the Master Control panel in the System module
and double-click ‘System Data’ in the ‘Exports’ list. The ‘Specify System
Data Export’ window is opened—

Check the boxes to determine the data to be exported. Click [Run] to
proceed. FirstOffice will open a dialogue box where you can name the export
file and specify where it is to be saved.

Enter a name for the file and click [Save] or press the Enter key.
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A message window informs you about the progress of the export. The
process can be interrupted at any time by pressing Esc (Windows) or -
Period (Macintosh).

When the export has finished, you may close the ‘Exports’ window with the
close box.

Transaction Registers

In a similar manner to the ‘Base Registers’ and ‘System Data’ functions
described above on pages 377 and 379 respectively, records in FirstOffice’s
transaction registers can be exported. Just as is the case with the Base
Registers, if your installation does not use some of the registers, an attempt to
export data from a register that is not present will result in an empty file.

Transaction Registers (Period)

This export allows you to export all records within selected transaction
registers for a certain time period. FirstOffice has a multi-year database,
where all transactions are saved in full. After a few years, as the database
grows, the time required to create a back-up increases. With this feature, you
can reduce the time needed to carry out the daily back-up by only backing up
those transactions that fall within a specified period, for example the current
year only. If using this function, you should ensure you create a full back-up
at the end of the previous financial year. To restore the database, you should
import two files: the “historical” archive back-up, and the most recent back-
up file from the current year. In both cases, use the ‘Automatic’ or
‘Automatic, manual file search’ import functions in the System module.
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To use this feature, check the registers you need to back up, and set the time
period and use the Backup Comment to describe the back-up file (up to 40
characters are permitted). This description will be shown in the list of
importable files shown by the ‘Imports’ function. Click [Run] to proceed.

 
Then, give a file name and destination to the file and click [Save].
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Attachments button, 129
Attention

Customers, 232
Sales Orders, 232

Auto Actions
System Module setting, 313

Automatic
System Module Import function, 365

Automatic, manual file search
System Module Import function, 71, 365 , 374

Autotransaction
Accounts, 343

Autotransactions
Exporting, 379
Printing, 364

B
B/FW Balances. See Brought Forward Balances
Backing Up, 64, 369

Automatic, 67
Back-up

Restoring from, 69, 366, 372
Backup button, 64, 78, 369
Balance Sheet

Nominal Ledger report, 189
Bank 1, Bank 2

Company Info, 315
Bank 2

Customers, 242
Bank Account

Customers, 242
Setting Default, 158, 162

Bank Customer ID
Company Info, 43, 315

Banks
Purchase Ledger setting, 243

Bar Code
Items, 286

Base Price
Date of Last Change, 282
Items, 277, 281, 293, 294

Changing using Formulae, 288
Base Price Change Date

Items, 282
Base Registers

System Module Export function, 377
Base Window. See Master Control Panel
Bonus

Persons, 338
Bonus, Salesman

Sales Ledger report, 338
Branch Identifier

Intrastat, 315
Brought Forward Balances. See also Opening

Balances
Nominal Ledger register, 207

Browse Window, 82
Button Bar, 83
Scrolling, 83
Searching, 84
Sorting Data, 83

Budget Keys
Printing, 364

Budgets
Printing, 364

Button Bar
in Browse Windows, 83
in Record Windows, 86

Buttons
Attachments, 129
Backup, 64, 78, 369
Calendar, 78
Cancel, 89
Chat, 79
Communicate, 87
Companies, 78
Conferences, 79
Documents, 80
Duplicate, 84, 88
Exports, 80
HansaWorld.com, 72, 81
Mailbox, 79
New, 83, 88
Next Record, 86
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Preview, 87
Previous Record, 86
Reports, 80
Save, 89
Select Module, 78
Settings, 80
Tasks, 78

C
Calendar

Defining Week Numbers, 331
Calendar button, 78
Cancel

Record menu command, 118
Cancel button, 89
Cash Account

Account Usage P/L, 160, 226
Account Usage S/L, 155, 226
Setting Default, 158, 162

Cash Customers, 155
Century, 320
Change Password

Operations menu command, Master Control
Panel, 81

Operations menu command, Persons, 339
Changed Date

Customers, 232
Changing Accounting Systems, 206
Character Set

Company Info, 44, 316
In exported and importable files, 107

Chart of Accounts, 176, 178
Exporting, 379
Printing, 189, 345, 364

Chat button, 79
Client

Logging on, 61
Client machines

Backing up local database/settings, 375
Client Text Backup

System Module Export function, 375
Closed check box

Accounts, 344
Customers, 240
Items, 281
Objects, 181

Closing
Months and Periods, 323

Closing FirstOffice, 62
Code

Company, 37
Forms, 351

Comment
Customers, 239
Invoices, 239
Sales Orders, 239

Comments
Attaching to Records, 131
Attaching to the Personal Desktop, 141
Printing, 131
Reading, 131, 141
Removing, 134

Commercial Reg No
Company Info, 315

Communicate Button, 87
Companies

Adding, 46
Changing, 335
Creating, 37
Number of, 45
Opening Automatically on Start Up, 60
Port, 61
Reporting on, 363
Selecting, 39, 62
System Module register, 37, 46, 57, 61, 104,

125, 333
TCP/IP, 61
Transferring Information by Dragging and

Dropping, 93
Working with, 125

Companies button, 78
Company, 34

Code, 37
File menu command, 57, 104
Name, 37
Opening, 35
Selecting, 57, 104
Short, 37

Company Info
Bank 1, Bank 2, 315
Bank Customer ID, 43, 315
Character Set, 44, 316
Commercial Reg No, 315
Edit Font, 43, 315
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Report Font, 43, 315
Report Font Size, 315
System Module report, 363
System Module setting, 41, 314
VAT Law, 44, 316

Company Name
Changing, 41

Company Registration Number. See Registration
Number

Company Text Backup
System Module Export function, 369

Conferences button, 79
Configuration

Control String, 47
System Module setting, 44, 59, 316

Connect to get your Enabler
Operations menu command, Configuration, 51

Contact Persons
Sales Support register, 232

Contents of FirstOffice Directory/Folder, 32
Continuous Stationery, 352
Control String

Configuration, 47
Conversion 1 and 2

Items, 283
Conversions - Accounts

System Module setting, 317
Conversions - Master

System Module setting, 317
Conversions - Suppliers

System Module setting, 250
Convert Suppliers to Customers

System Module function, 257
System Module report, 247

Copies
Operations menu command, Forms, 352
Printing Several, 114

Copy
Edit menu command, 116

Cost Account. See also Purchase Account
Customers, 159, 238
Item Groups, 156, 274
Setting Default for Cost Accounting, 155
Setting Default for Purchase Invoices, 238
Updating after Invoicing, 155

Cost Accounting, 177
Cost Model

per Item Group, 276

Switching on, 155
Use Item Groups for Cost Accounts check

box, 156, 274, 275
Use Item Groups for Cost Model check box,

276
Cost Bearer, 178
Cost Centre, 178
Cost Model

Sales Ledger setting, 276
Setting Default for Items, 281
Setting for each Item Group, 276

Cost Price
Items, 276, 284, 293

Date of Last Change, 285
Updating from Goods Receipts, 175, 285

Most Recent, for Items, 285
Create Archive

Operations menu command, Attachments, 135
Operations menu command, Master Control

Panel, 143
Create Interest Invoices

Sales Ledger function, 241
Create Mail

Operations menu command, Attachments, 134
Create Mailbox

Operations menu command, Persons, 137, 340
Create Nominal Ledger Transactions

System Module function, 359
Create Note

Operations menu command, Attachments, 131
Operations menu command, Master Control

Panel, 141
Creating Records, 83, 123
Credit Account

Setting Default for Items, 281
Credit check box

Accounts, 344
Credit Limit

Customers, 236
Sales Ledger setting, 236

Creditor Account
Account Usage P/L, 160, 226, 238
Customers, 160, 238
Setting Default, 160, 162, 238
Setting Default for Suppliers, 226, 229
Supplier Categories, 160
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Creditor Control Account. See Creditor Account
Current Record, 123
Customer Categories

Debtor Account, 155, 226
Exporting, 377
Price List, 225, 294
Sales Ledger setting, 225, 229

Customer Category
Customers, 229

Customer check box
Customers, 230

Customer Labels
Designing, 260
Printing Static Text, 260
Sales Ledger document, 259

Customer List
Sales Support module report, 262

Customer Name
Customers, 231

Printing in Documents, 323
Customer Number

Customers, 229
Customer Statistics

Sales Ledger report, 265
Customer Status

Creating Activities from, 245, 266
Operations menu command, Customers, 244
Sales Ledger report, 244
Sales Ledger/Sales Support module report, 266

Customer/Item Statistics
Sales Ledger report, 301

Customers
Account, 155, 158
Account Operator, 243
Attention, 232
Bank 2, 242
Bank Account, 242
Cash, 155
Changed Date, 232
Closed check box, 240
Comment, 239
Cost Account, 159, 238
Credit Limit, 236
Creditor Account, 160, 238
Customer Category, 229
Customer check box, 230
Customer Name, 231

Printing in Documents, 323

Customer Number, 229
Deleting, 244
Delivery Address, 234
Delivery Mode, 235
Delivery Terms, 234
Department, 231
Editing, 243
Email, 233
Entering, 203, 228
Exporting, 377
Fax Number, 233
Freight Number, 242
Inability to copy from one Company to

another, 128
Interest check box, 241
Invoice Address, 232
Listing, 262
Mobile, 233
Objects, 237
On Account check box, 241
Order Comment, 239
Payment Terms, 236
Price List, 242, 294
Purchase Credit Limit, 236
Purchase Delivery Terms, 234
Purchase Objects, 237
Purchase Payment Terms, 236
Purchase VAT Code, 160, 236
Registration Number, 241
Reminders check box, 240
Sales Credit Limit, 236
Sales Delivery Mode, 235
Sales Delivery Terms, 234
Sales Objects, 237
Sales Payment Terms, 236
Sales Support/Sales Ledger register, 203, 228
Sales VAT Code, 155, 236
Salesman, 242
Short Code, 231
Skype Name, 233
Sort Code, 243
Sort Key, 232
Supplier Category, 229
Supplier check box, 230
Telephone Number, 233
Their Customer Code, 238
Type, 241
VAT Code, 236, 274
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VAT Registration Number, 241
Warning on Purchase, 239
Warning on Sales, 239
Web Site, 234
Zone, 240, 273, 282

Cut
Edit menu command, 116

D
Data

Entering, 200
Exporting, 80, 104
Importing, 105

Database, 34
Creating, 36
Creating (Multi-user), 56
Creation does not follow steps in manual, 53
Opening, 35
Structure, 151

Database Backup Path
Timed Operations, 68

Database Backup Time
Timed Operations, 68

Database Key. See Enabler Key
Database Text Backup

System Module Export function, 369
Date and Numbers

System Module setting, 320
Date Formats

Year 2000, 320
Date Last Modified. See Changed Date
Date of Last Base Price Change

Items, 282
Date of Last Cost Price Change

Items, 285
Date Order

In exported and importable files, 105
Dates

and Export Text Files, 321
DBDef.txt, 36, 70
Debit check box

Accounts, 344
Debtor Account

Account Usage S/L, 155, 226
Customer Categories, 155, 226
Setting Default, 155, 157
Setting Default for Customers, 226, 229

Decimal Character
In exported and importable files, 106

Decimal Places. See Round Off and Rounding
Rules

Decrease Available on Deliveries
Stock Settings, 291

Default Company
Program Mode, 60

Defaults
Bank Account, 158, 162
Cash Account, 158, 162
Cost Account for Cost Accounting, 155
Cost Account on Purchase Invoices, 238
Cost Model

per Item Group, 276
Cost Model for Items, 281
Credit Account for Items, 281
Creditor Account, 160, 162, 238
Creditor Account for Suppliers, 226, 229
Customs Cost Account, 165
Debtor Account, 155, 157
Debtor Account for Customers, 226, 229
Freight Cost Account, 165
Number Series, 196, 328
Objects, 180
Objects in Nominal Ledger Transactions from

Goods Receipts, 237
Objects in Nominal Ledger Transactions from

Purchase Invoices, 237
Price List, 295
Price List for Customers, 225, 229
Purchase Account, 159
Purchase Account for Items, 281
Reporting Period, 329
Sales Account, 217
Sales Account for Items, 273, 281, 282
Sales Account in Invoices, 153
Stock Account, 155, 164
VAT Account in Invoices, 154, 274
VAT Account in Purchase Invoices, 159
VAT Code for Items, 274, 281, 282
VAT Code for Purchases, 236
VAT Code for Sales, 217, 236

Deficiency List
Stock module report, 283
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Definition of Reports
Exporting, 379

Delete
Record menu command

Warning before, 119
Delete Old Transactions

System Module function, 361
Deleting Records, 124
Deliveries

Deleting, 361
Determining when Items are removed from

stock, 291
Exporting, 380
Generating Nominal Ledger Transactions

from, 359
Delivery Address

Customers, 234
Delivery Mode

Customers, 235
Delivery Modes

Sales Support module setting, 235
Delivery Notes

Printing Automatically, 313
Delivery Terms

Customers, 234
Sales Support module setting, 234

Department
Customers, 231

Department (of your company). See Company
Description

Items, 281
Price Lists, 294

Destination
Specifying when Printing Reports, 109

Discount
Invoices, 330
Sales Orders, 330

Discount Calculation Method, 330
Disk Space, 120
Document Editor, 346
Documents, 150

Address Formats, 322
Adjusting Page Setup/Magnification, 114
Attaching to the Personal Desktop, 140
Customer Labels, 259
Defining, 112
Matrix field columns not aligned correctly,

349

Printing Automatically, 313
Printing in Documents, 323
Printing more than one Copy, 114
Reminder, 240
Superimposed Text, 349

Documents button, 80
Download File

Operations menu command, Attachments, 130
Drag and Drop

Using to Copy Data between Companies, 93
Using to Insert Data into Fields, 92

Drill-down in Reports, 98
Duplicate button, 84, 88
Duplicating Records, 84, 123

E
Edit Font

Company Info, 43, 315
Edit Link Comment

Operations menu command, Attachments, 132
Operations menu command, Master Control

Panel, 141
Edit Menu, 115

Copy, 116
Cut, 116

Email
Customers, 233

Email Address
Persons, 338

Enabler Key, 47
Entering Records, 83, 123
Error Messages

Already Registered, 295
Code not registered, 155, 160
Creditor Account missing, 161
Debtor Account missing, 155
Month checked, 324
Month locked, 324
Preliminary Account not found, 161
Sales Account missing, 154
Transaction could not be generated, 156, 158,

162
User Limit on Server reached, 62

Example Database, 33
Excel. See Microsoft Excel
Exclude from page options

Forms, 353
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Export Files
Opening in Excel, 321

Export Format
System Module report, 363

Exporting Data, 80, 104
Exports

Attaching to the Personal Desktop, 140
Base Registers, 377
Client Text Backup, 375
Company Text Backup, 369
Database Text Backup, 369
Item Base Registers, 378
Raw Data, 378
System Data, 379
System module, 368
Transaction Registers, 380
Transaction Registers (Period), 380

Exports button, 80
Extra Cost

Items, 284

F
Fax Number

Customers, 233
Fields

in Forms, 348
Moving between, 85

FIFO, 163
Calculating Prices, 172
Setting Rounding Rules, 285, 330
Using to Calculate Gross Profit, 175

File Dialogue Window, 102
File Menu

Company, 57
Imports, 105
Master Control, 104
Page Setup, 114
Print, 87, 115
Reports, 108
Settings, 42, 114

Files
Attaching to Records, 130
Reading, 130
Removing, 134

Financial Years. See Fiscal Years
First Only

Operations menu command, Forms, 354

FirstOffice
Changing To, 206
Closing Down, 62
Importing process appears to fail, 71, 374
Installation, 22
Keyboard Commands, 147
Starting, 34
Structure, 151
Structure of Registers, 14
Updating from Previous Versions, 72
Version Number, 120
Website, 72, 81
Work Area, 76

FirstOffice Directory
Contents, 32

FirstOffice Folder
Contents, 32

FirstOfficeProDemoDateAugust2005.Txt
Example Database, 33

Fiscal Years
Ending, 187
System Module setting, 195, 322

Flips, 86
Fonts

Setting for Reports, 43
Using in Forms, 357

Form Editor, 346
Form Settings

System Module setting, 322
Forms. See also Documents

Address Formats, 322
Code, 351
Defining Type Styles, 357
Exclude from page options, 353
Exporting, 377
Fields, 348
Frames, 348
Lines, 348
Matrix field columns not aligned correctly,

349
Naming, 351
Pictures, 350
Printing, 355
Printing a specific number of copies

automatically, 352
Printing in Documents, 323
Printing on Continuous Stationery, 352
Single- and Multi-page, 353
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Superimposed Text, 349
System Module register, 113, 346
Text Objects, 347

FOUKStd.Txt
Accounts Template File, 33

Frames
in Forms, 348

Freight Number
Customers, 242

G
Goods Receipts

Deleting, 361
Exporting, 380
Generating Nominal Ledger Transactions

from, 359
Setting Rounding Rules for FIFO and

Weighted Average, 285, 330
Stock Module register, 220
Updating Cost Prices of Items from, 175, 285
Use of Objects, 237

GP. See Gross Profit
GP, Orders

Sales Support module report, 175
Gross Margin

Reporting, 265
Gross Profit

Calculating from FIFO Values, 175
Including Carriage, etc, 284
Reporting, 265

H
HansaWorld.com, 72
HansaWorld.com button, 81
HDB File, 34

I
Importing Files

Process Appears to Fail, 71, 374
Imports

Attaching to the Personal Desktop, 140
Automatic, 365
Automatic, manual file search, 71, 365, 374
Character Set, 107
Date Order, 105

Decimal Character, 106
File menu command, 105
Machine Mode, 106
Replacing existing data, 106
System module, 365

Info on Customer Status Report
Sales Support module setting, 244

Initials. See Signature
Input Account

VAT Codes, 159
Installation, 22

Linux Single-user, 24
Macintosh Single-user, 24
Windows Single-user, 24

Integration, 151
Workflow, 16

Interest
Charging on Late Payment, 241

Interest check box
Customers, 241

Internal Orders
Printing Automatically, 313

Internet Enablers
System Module setting, 49, 323

Intrastat
Branch Identifier, 315

Invoice Address
Customers, 232

Invoice History
Viewing for each Customer, 244
Viewing for each Supplier, 245

Invoice Rows
Not printed correctly in Documents, 349

Invoices, 152
Cannot be Created, 328
Comment, 239
Deleting, 361
Discount, 330
Entering, 211
Exporting, 380
Generating Nominal Ledger Transactions

from, 152, 359
Interest for Late Payment, 241
Printing Automatically, 313
Rounding to Nearest Monetary Unit, 156
Sales Account, 153
Sales Ledger register, 215
Setting Rounding Rules for Total, 330
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Setting Rounding Rules for VAT, 330
Unit Price

Preventing Changes to, 288
Updating Stock and Cost Accounts after, 155
VAT Account, 154

Item Base Registers
System Module Export function, 378

Item Formulae
Using to change Base Prices, 288

Item Group
Items, 281

Item Groups
Cost Account, 156, 274
Cost Model, 276
Deleting, 278
Entering, 272
Exporting, 378
Sales Account, 154, 273
Sales Ledger setting, 272, 281
Stock Account, 156, 275
VAT Code, 155, 274

Item History
Stock report, 172

Item List
Sales Ledger report, 298
Sales Support module report, 298

Item Number
Items, 281

Item Rows
Not printed correctly in Documents, 349

Item Statistics
Sales Ledger report, 299

Item Status
Operations menu command, Items, 291

Item Status Report
Operations menu command, Items, 290

Item Status Window, 291
Item Type

Items, 283
Item Types

Plain, 283
Stocked, 283

Item/Customer Statistics
Sales Ledger report, 301

Items
Bar Code, 286
Base Price, 277, 281 , 293, 294

Changing using Formulae, 288

Base Price Change Date, 282
Closed check box, 281
Conversion 1 and 2, 283
Cost Price, 276, 284 , 293

Date of Last Change, 285
Updating from Goods Receipts, 175, 285

Deleting, 287
Description, 281
Entering, 205, 279
Exporting, 378
Extra Cost, 284
Item Group, 281
Item Number, 281
Item Type, 283
Last Purchase Price, 285
Minimum Stock Level, 283
Plain option, 283
Price Change Date, 285
Price Factor, 282
Sales Account, 154, 282
Sales Ledger register, 205
Sales Orders/Sales Ledger register, 279
Sales Support register, 205
Shelf Code, 283
Stock module register, 205
Stocked option, 283
Unit, 281
VAT Code, 155, 282
Viewing Stock Status, 291
Volume, 283
Weight, 283
Weighted Average, 277, 284

J
Job Description

Persons, 338

K
Key, 47
Key Financial Ratios

Printing Definitions, 364



HansaWorld FirstOffice Professional

394

Keyboard Shortcuts, 147

L
Labels

Designing, 260
Printing for Customers, 259
Printing Static Text, 260

Last Only
Operations menu command, Forms, 354

Last Purchase Price
Items, 285

Late Payment
Charging Interest, 241

Launching FirstOffice, 34
Importing process appears to fail, 71, 374

Lines
in Forms, 348

Linux
Multi-user Installation, 29
Single-user Installation, 24
System Requirements, 24

List Window, 100
Loading FirstOffice, 34

Importing process appears to fail, 71, 374
Locking

Months and Periods, 323
System Module setting, 323

Logging in
Active Module on Start Up, 312

Logging on to a Server, 61
Lookup Table

Using to Insert Data into Fields, 89
Loss

Posting, 194

M
Macintosh

Multi-user Installation, 29
Single-user Installation, 24
System Requirements, 23

Mailbox button, 79
Mailboxes

Creating from Person register, 137, 340
Maintenance

System module, 359

Maintenance Functions
Attaching to the Personal Desktop, 140
Convert Suppliers to Customers, 257
Create Interest Invoices, 241
Create Nominal Ledger Transactions, 359
Delete Old Transactions, 361
Prepare Conversion Suppliers Settings, 251
Update Item Base Prices, 288
Update Item Cost Price, 175

Maintenance Window, 107
Master Control

File menu command, 104
Master Control Panel, 77

Backup button, 64, 78, 369
Calendar button, 78
Chat button, 79
Companies button, 78
Conferences button, 79
Documents button, 80
Exports button, 80
HansaWorld.com button, 72, 81
Mailbox button, 79
Opening, 104
Personal Desktop, 137 , 340
Reports button, 80
Select Module button, 78
Settings button, 80
Tasks button, 78

Matrix Columns
Not printed correctly in Documents, 349

Menus
Edit, 115
Record, 117
Window, 119

Microsoft Excel
Opening Reports in, 110

Middle Only
Operations menu command, Forms, 354

Min Level. See Minimum Stock Level
Minimum Stock Level

Items, 283
Mobile

Customers, 233
Modified Date. See Changed Date
Modifying Records, 84
Modules

Active Module on Start Up, 312
Changing, 121
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Server, 58
Stock, 162
System, 41, 306

Months
Locking/Closing, 323

Multi-company Capability, 34
Multi-page Forms, 353

N
Name

Company, 37
Name of Company

Changing, 41
Names of Attachments

Changing, 132
Network

Logging on, 61
New button, 83, 88
Next Record button, 86
Nominal Ledger

Entering Opening Balances, 207
Nominal Ledger report, 188

Nominal Ledger Transactions. See Transactions
Notes

Attaching to Records, 131
Attaching to the Personal Desktop, 141
Printing, 131
Reading, 131, 141
Removing, 134

Number Format
System Module setting, 320

Number of Users, 45
Number Series

Setting Overall Default, 328
Setting Overall Defaults, 196

Number Series Defaults
System Module setting, 196, 328

O
Object Types

Printing, 364
Objects, 177

Closed check box, 181
Closing, 181
Customers, 237
Defaults, 180

in Goods Receipts, 237
in Purchase Invoices, 237

End of Year Implications, 181
Nominal Ledger register, 237
Printing, 364
Separating, 180
Transactions, 180
Transferring from Suppliers to Goods

Receipts, 237
Transferring from Suppliers to Purchase

Invoices, 237
Using in Profit & Loss Report, 181

Objects on Creditor Account check box
Account Usage P/L, 237

On Account A/C
Account Usage P/L, 160, 162, 241
Account Usage S/L, 155, 158, 226, 241

On Account check box
Customers, 241

On Account Payments, 160, 162, 241
On Account Receipts, 158, 241
Open Record

Operations menu command, Attachments, 133
Operations menu command, Master Control

Panel, 139, 140
Opening Balances

Entering, 206
Importing, 220
Nominal Ledger, 207
Purchase Ledger, 220
Sales Ledger, 211
Stock, 220

Operations Menu (Attachments)
Attach File, 130
Create Archive, 135
Create Mail, 134
Create Note, 131
Download File, 130
Edit Link Comment, 132
Open Record, 133
Show To Links, 132

Operations Menu (Configuration)
Connect to get your Enabler, 51

Operations Menu (Customers), 244
Customer Status, 244
Supplier Status, 245

Operations Menu (Forms), 350
Copies, 352
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First Only, 354
Last Only, 354
Middle Only, 354
PC Printer, 352
Properties, 351
Send to Back, 353
Single Page Only, 354
View All, 354

Operations Menu (Items), 290
Item Status, 291
Item Status Report, 290

Operations Menu (Master Control Panel)
Change Password, 81
Create Archive, 143
Create Note, 141
Edit Link Comment, 141
Open Record, 139, 140

Operations Menu (Persons), 339
Change Password, 339
Create Mailbox, 137, 340

Operations Menu (Program Mode)
Admin Client, 59, 336

Operations Menu (Reports)
Reopen Report Specification, 97

Options List
Using to Insert Data into Fields, 89

Order Acknowledgements
Printing Automatically, 313

Order Comment
Customers, 239

Order Rows
Not printed correctly in Documents, 349

Orders
Setting Rounding Rules for VAT, 330

Our Ref
Persons, 338

Output Account
VAT Codes, 154

Overview Window. See Browse Window

P
Page Setup

for Reports, 109, 110
Paper Clip. See Attachments
Password

Persons, 81, 339

Paste Special, 89
and Access Rights, 311

Payment Methods. See Payment Modes
Payment Modes

Exporting, 379
Sales/Purchase Ledger setting, 158, 162, 214

Payment Terms
Customers, 236
Exporting, 379
Sales/Purchase Ledger setting, 236

Payments, 161
Deleting, 361
Exporting, 380
Generating Nominal Ledger Transactions

from, 161
On Account, 160, 162, 241
Prepayments, 241
Purchase Ledger register, 220

PC Printer
Operations menu command, Forms, 352

Period Locking. See Locking
Periods. See Reporting Periods
Personal Desktop, 137 , 340

Archives, 143
Creating, 143
Removing, 146
Renaming, 145

Attaching Notes and Comments, 141
Changing Names of Items, 141
Organising, 143
Reading Notes and Comments, 141
Removing Items from, 143
Working with Records, 139
Working with Registers, 140
Working with Reports, 142
Working with Settings, Reports, Documents

and Maintenance functions, 140
Persons

Access Group, 338
Bonus, 338
Creating Mailboxes from, 137, 340
Email Address, 338
Entering, 200
Exporting, 377
Job Description, 338
Our Ref, 338
Password, 81, 339
Signature, 338
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System Module register, 62, 242, 337
Pictures

in Forms, 350
Plain option

Items, 283
Port

Companies, 61
Preferences. See Settings
Prel Book. See Preliminary Booking
Preliminary Booking check box

Purchase Invoices, 160
Preliminary Creditor Account

Account Usage P/L, 160
Prepare Conversion Suppliers Settings

System Module function, 251
Prepayment Payments, 241
Prepayment Receipts, 241
Preview Icon, 87
Previous Record button, 86
Price Change Date

Items, 285
Price Factor

Items, 282
Price List

Customer Categories, 225, 294
Customers, 242, 294
Exporting as a Text File, 302
Printing, 302
Sales Ledger report, 295, 302
Sales Support module report, 302
Setting Default, 295
Setting Default for Customers, 225, 229

Price List Code
Price Lists, 294

Price Lists, 293
Description, 294
Exporting, 378
Inclusive or Exclusive of VAT, 294
Price List Code, 294
Printing, 295
Sales Ledger setting, 225, 293, 294
Setting Up, 294
Structure, 293

Prices
Exporting, 378
Sales Account, 154, 296
Sales Support/Sales Ledger register, 293 , 295
Setting up Multiple Price Lists, 293

Pricing of Invoices
Selecting Discount, 330

Pricing of Orders
Selecting Discount, 330

Print
File menu command, 87

Print Destination
Specifying for Reports, 109

Printer Dialogue
Appearing before Printing Reports, 109

Printer Icon, 87
Printing

Forms, 355
Products. See Items
Profit

Posting, 194
Profit & Loss

Nominal Ledger report, 189
Profit & Loss Report

Producing for Different Cost Centres, 181
Program Mode

Default Company, 60
Program Name, 60
Server at Startup check box, 60
Server Port, 60, 62
Technics Module register, 60

Program Name
Program Mode, 60

Properties
Operations menu command, Forms, 351

Purchase Account. See also Cost Account
Setting Default, 159
Setting Default for Items, 281

Purchase Credit Limit
Customers, 236

Purchase Delivery Terms
Customers, 234

Purchase Invoice History
Viewing for each Supplier, 245

Purchase Invoices, 158
Deleting, 361
Determining Default Cost Account, 238
Entering, 220
Exporting, 380
Generating Nominal Ledger Transactions

from, 158, 359
Preliminary Booking check box, 160
Purchase Account, 159
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Purchase Ledger register, 220
Setting Rounding Rules for VAT, 330
Use of Objects, 237
VAT Account, 159

Purchase Ledger
Entering Opening Balances, 220

Purchase Objects
Customers, 237

Purchase Payment Terms
Customers, 236

Purchase VAT Code
Customers, 236
Suppliers, 160

Q
Quitting FirstOffice, 62

R
Raw Data

System Module Export function, 378
Receipts, 157

Deleting, 361
Entering, 218
Exporting, 380
Generating Nominal Ledger Transactions

from, 157, 359
On Account, 158, 241
Prepayments, 241
Sales Ledger register, 218

Record Count
System Module report, 363

Record Menu, 117
Cancel, 118
Delete

Warning before, 119
Record Window, 84

Button Bar, 86
Moving from field to field, 85

Records
Attaching Files, 130
Attaching Notes and Comments, 131
Attaching other Records, 132
Attaching Reports, 133
Attaching to the Personal Desktop, 139
Copying, 119
Creating, 83, 118, 123

Current, 123
Deleting, 119, 124, 361

Warning before, 119
Duplicating, 84, 123
Modifying, 84
Opening Attached Records, 133
Printing Notes and Comments, 131
Reading Attached Files, 130
Reading Attached Reports, 134
Reading Notes and Comments, 131
Removing Attachments, 134

Registers
Accounts, 341
Attaching to the Personal Desktop, 140
Brought Forward Balances, 207
Companies, 37, 46, 57, 61, 104, 125, 333
Contact Persons, 232
Customers, 203, 228
Forms, 113, 346
Goods Receipts, 220
Invoices, 215
Items, 205, 279
Objects, 237
Payments, 220
Persons, 62, 242, 337
Prices, 293, 295
Program Mode, 60
Purchase Invoices, 220
Receipts, 218
Structure of, 14
Styles, 357
Suppliers. See Customer register
System module, 333
Transactions, 209

Registration Number
Customers, 241

Reminder
Sales Ledger document, 240

Reminders check box
Customers, 240

Removing Attachments, 134
Reopen Report Specification

Operations menu command, Reports, 97
Report Font

Company Info, 43, 315
Report Font Size

Company Info, 315
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Report Window, 94
Reporting Period

Setting Default, 329
Reporting Periods

System Module setting, 329
Reports, 150

Adjusting Page Setup/Magnification, 114
as Attachments, 133

Reading, 134
Attaching to the Personal Desktop, 140, 142
Balance Sheet, 189
Bonus, Salesman, 338
Changing Report Criteria, 110
Company Info, 363
Convert Suppliers to Customers, 247
Customer List, 262
Customer Statistics, 265
Customer Status, 244, 266
Customer/Item Statistics, 301
Deficiency List, 283
Defining, 110
Drill-down, 98
Export Format, 363
GP, Orders, 175
Item History, 172
Item List, 298
Item Statistics, 299
Nominal Ledger, 188
Opening in Excel, 110
Page Setup, 109, 110
Price List, 295, 302
Printing, 221
Printing more than one Copy, 114
Profit & Loss Report, 189
Recalculating, 97, 110
Record Count, 363
Saving to Disk, 110
Selecting Print Destination, 109
Setting Fonts, 43
Specifying Printer Dialogue, 109
Stocktaking List, 283
Supplier List, 268
Supplier Statistics, 269
System Documentation, 189, 364
System module, 362
Transaction Journal, 189
Trial Balance, 207, 221
Underlined Text, 99

Reports button, 80
Restoring from a Back-up, 69, 366, 372

Appears to Fail, 71
Process Appears to Fail, 374

Revised Budgets
Printing, 364

Round Off
System Module setting, 157, 285, 329

Round Off Account
Account Usage S/L, 157, 329

Rounding Rules
Setting for FIFO and Weighted Average, 285,

330
Setting for Invoice/Order Total, 330
Setting for VAT, 330

Rows
Not printed correctly in Documents, 349

S
Safety Back-up, 64, 369

Automatic, 67
Restoring from, 69, 372

Sales Account
Account Usage S/L, 154, 240, 273
Item Groups, 154, 273
Items, 154, 282
Prices, 154, 296
Setting Default, 217
Setting Default for Invoices, 153
Setting Default for Items, 273, 281, 282

Sales Credit Limit
Customers, 236

Sales Delivery Mode
Customers, 235

Sales Delivery Terms
Customers, 234

Sales Invoices. See Invoices
Sales Ledger

Entering Opening Balances, 211
Sales Objects

Customers, 237
Sales Orders

Attention, 232
Comment, 239
Deleting, 361
Discount, 330
Exporting, 380
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Salesman, 242
Setting Rounding Rules for Total, 330
Unit Price

Preventing Changes to, 288
Sales Payment Terms

Customers, 236
Sales VAT Code

Customers, 155, 236
Salesman

Customers, 242
Sales Orders, 242

Save button, 89
Scrolling

in a Browse Window, 83
Searching

in a Browse Window, 84
using a Wildcard, 84

Select Company Window
Bypassing, 60

Select Module button, 78
Selection List

Using to Insert Data into Fields, 89
Send to Back

Operations menu command, Forms, 353
Serial Number Defaults. See Number Series

Defaults
Server

Logging on to, 61
Starting up, 335

Server at Startup check box
Program Mode, 60

Server module
Granting Access to, 58
Selecting by default, 60
Setting up, 58

Server Port
Program Mode, 60, 62

Settings, 41, 80, 114
Access Groups, 307
Attaching to the Personal Desktop, 140
Auto Actions, 313
Banks, 243
Company Info, 41, 314
Configuration, 44, 59, 316
Conversion - Accounts, 317
Conversion - Suppliers, 250
Conversions - Master, 317
Cost Model, 276

Credit Limit, 236
Customer Categories, 225, 229
Date and Numbers, 320
Delivery Modes, 235
Delivery Terms, 234
Exporting Contents, 379
File menu command, 42, 114
Fiscal Years, 195, 322
Form Settings, 322
Info on Customer Status Report, 244
Internet Enablers, 49, 323
Item Groups, 272 , 281
Locking, 323
Number Series Defaults, 196, 328
Payment Modes, 158, 162, 214
Payment Terms, 236
Price Lists, 225, 293, 294
Reporting Periods, 329
Round Off, 157, 285, 329
Sub Systems, 212
Supplier Categories, 226
Suppliers Categories, 229
System module, 41, 306
Timed Operations, 68
Units, 281
VAT Codes, 154, 160, 236, 274
Viewing Contents, 364
Weeks, 331

Settings button, 80
Settlement Discounts

On Purchases, 236
On Sales, 236

Shelf Code
Items, 283

Short
Company, 37

Short Code
Customers, 231

Show To Links
Operations menu command, Attachments, 132

Shutting FirstOffice Down, 62
Signature

Persons, 338
Single Page Only

Operations menu command, Forms, 354
Single-page Forms, 353
Skype Name

Customers, 233
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Sort Code
Customers, 243

Sort Key
Customers, 232

Sort Order, 316
Sorting

in a Browse Window, 83
Specification Window, 101
Starting FirstOffice, 34

Active Module on Start Up, 312
Static Text

Showing on Labels, 260
Stock

Calculating FIFO Price, 172
Entering Opening Balances, 220
FIFO Principle, 163
Shipping Goods, 166
Value Compared with Stock Account, 169

Stock Account. See also Credit Account
Account Usage Stock, 156, 164, 275
Compared with Stock Value, 169
Item Groups, 156, 275
Setting Default, 155, 164
Updating after Invoicing, 155

Stock Cost Account
Account Usage Stock, 156, 274

Stock Depreciations
Deleting, 361
Exporting, 380

Stock History
Specifying for each Item that one is to be

maintained, 283
Stock Levels

Viewing for each Item, 291
Stock module, 162
Stock Settings

Decrease Available on Deliveries, 291
Stock Transactions, 162
Stocked option

Items, 283
Stocktaking List

Stock module report, 283
Structure of FirstOffice, 151
Styles

Exporting, 377
System Module register, 357

Sub Systems
Nominal Ledger setting, 212

Subsidiary Companies. See Company
Superimposed Text

Printed in Documents, 349
Supplier Categories

Creditor Account, 160
Purchase Ledger setting, 226, 229

Supplier Category
Customers, 229

Supplier check box
Customers, 230

Supplier List
Purchase Ledger report, 268

Supplier Statistics
Purchase Ledger report, 269

Supplier Status
Operations menu command, Customers, 245

Suppliers. See also Customers
Account, 160, 162
Copying into Customer register, 246
Entering, 203
Exporting, 377
Listing, 268

System Administrator
Granting Access to Technics Module, 313

System Data
System Module Export function, 379

System Documentation
System Module report, 189, 364

System module, 41, 306
Exports, 368
Imports, 365
Maintenance, 359
Registers, 333
Reports, 362
Settings, 41, 306

System Requirements
Linux, 24
Macintosh, 23
Windows, 23

System Usage
Number of Companies, 45
Number of Users, 45
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T
Tabs, 86
Tasks button, 78
TCP/IP

Companies, 61
Technics Module

and System Administrator, 313
Telephone Button. See Communicate Button
Telephone Number

Customers, 233
Text Back-up

Creating, 64, 369
Creating Automatically, 67
Restoring from, 69, 366, 372

Text Files
Opening in Excel, 321

Text Objects
in Forms, 347

The Printer, 87
Their Customer Code

Customers, 238
Timed Operations

Database Backup Path, 68
Database Backup Time, 68
Technics Module setting, 68

Total
Setting Rounding Rules, 330

Trader’s Branch Identifier
Intrastat, 315

Transaction Journal
Nominal Ledger report, 189

Transaction Records. See Transactions
Transaction Registers

System Module Export function, 380
Transaction Registers (Period)

System Module Export function, 380
Transaction Settings

Warn on Unusual Amount, 344
Transactions, 151

Deleting, 361
Entering, 207
Exporting, 380
Generating from Sub Systems, 359

Invoices, 152
Payments, 161
Purchase Invoices, 158
Receipts, 157

Nominal Ledger register, 209
Objects, 180
Sales Invoices, 152
Stock, 162

Trial Balance
Nominal Ledger report, 207, 221

Turnover
Reporting, 265

Type
Customers, 241

Type Styles. See Styles

U
UKAccs1.Txt

Accounts Template File, 33, 55
UKForms.Txt

Accounts Template File, 33
Underlined Text in Reports, 99
Unicode, 107
Unit

Items, 281
Unit Price

Use in Pricing Invoices
Preventing Changes to, 288

Use in Pricing Sales Orders
Preventing Changes to, 288

Units
Sales Ledger setting, 281

Update Cost Price at Goods Receipt
Items, 285

Update Item Base Prices
Sales Ledger function, 288

Update Item Cost Price
Stock Module function, 175

Updating from Previous Versions, 72
Use Item Groups for Cost Accounts check box

Cost Accounting, 156, 274, 275
Use Item Groups for Cost Model check box

Cost Accounting, 276
User Company. See Company Info
Users. See also Persons

Number of, 45

V
Value Packs

Granting Access to, 44



Index - W

403

VAT
Setting Rounding Rules, 330
Using with Price Lists, 294

VAT Account
Setting Default for Invoices, 154, 274
Setting Default for Purchase Invoices, 159

VAT Code
Account Usage P/L, 160, 236, 240
Account Usage S/L, 155, 236, 240, 274
Accounts, 160, 344
Customers, 236, 274
Item Groups, 155, 274
Items, 155, 282
Setting Default for Invoices, 217
Setting Default for Items, 274, 281, 282
Setting Default for Purchases, 236
Setting Default for Sales, 236

VAT Codes
Exporting, 379
Input Account, 159
Nominal Ledger setting, 154, 160, 236, 274
Output Account, 154

VAT Law
Company Info, 44, 316

VAT Registration Number
Customers, 241

VAT Zone. See Zone
V-Cd. See VAT Code
Version Number, 120
View All

Operations menu command, Forms, 354
Virus

Removing, 64
Volume

Items, 283

W
Warn on Unusual Amount

Transaction Settings, 344

Warning on Purchase
Customers, 239

Warning on Sales
Customers, 239

Web Site
Customers, 234

Website (HansaWorld.com), 81
Website (www.hansaworld.com), 72
Week Numbers

Defining for the Calendar, 331
Weeks

System Module setting, 331
Weight

Items, 283
Weighted Average

Items, 277, 284
Setting Rounding Rules, 285, 330

Wildcard. See also Paste Special
Used in Searches, 84

Window Menu, 119
Window Title, 37
Windows

Closing and Saving Changes, 118
Closing without Saving Changes, 118
Management of, 82

Windows (Microsoft)
Multi-user Installation, 29
Single-user Installation, 24
System Requirements, 23

Work Area, 76
Workflow, 16
Working with FirstOffice, 200

Y
Y2K, 320
Year 2000, 320

Z
Zone

Customers, 240, 273, 282

http://www.HansaWorld.com),
http://www.hansaworld.com),
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